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			Welcome	to	GPComplete	
	

	

Using	Help	Files
	

Hyperlinks.	Clicking	a	Hyperlink	will	jump	you	to	other	help
files.	e.g	System	Preferences.	They	are	underlined	in	blue

After	you	jump	forward	with	a	Hyperlink,	you	can	get	back	to
where	you	were	by	clicking	"Back"

																						

																																											

Click	 	and	 to	enlarge	and	reduce	images	inside	the	help
files.
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Before	you	start



All	Users
Set	up	your	User	Preferences

Check	your	messages

Check	your	tasks

Exit	at	the	end	of	the	day

	



The	Administrator
	

Set	up	Backup

Set	permissions	for	all	users

Set	Bank	Codes	for	all	doctors

Administer	the	Recall	Manager

	



The	Doctors
	

Set	up	Auto	Templates

Set	up	Pathology	Favourites

Set	up	Diagnostic	Imaging	Favourites

Set	up	Drug	Favourites

Set	up	Pathology	Laboratory	providers

Set	up	Diagnostic	Imaging	providers

Read	your	messages

Clear	your	Document	Intray

Clear	your	Pathology	Intray

Review	the	Recall	Manager
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R	click	submenu	options



R	click	submenu	options
	

The	system	provides	many	situations	to	open	a	submenu.
By	R	clicking	on	a	row,	field,	grid	or	patient	a	drop	down	submenu	will
be	provided.	

	

A	list	of	examples	is	displayed	underneath.

	

e.g	R	click	on	a	row	in	a	grid	in	the	bill	update	form

	

Click	to	enlarge

	

e.g.	R	click	on	a	patient	on	the	appointment	screen.

	

Click	to	enlarge
	
e.g	R	click	on	the	encounter	screen
	

Click	to	enlarge
	
e.g	R	click	on	the	Current	Rx	screen
	

Click	to	enlarge
	
e.g	R	click	in	the	Correspondence	screen
	



Click	to	enlarge
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Switch	the	active	form
	

GPComplete	enables	multiple	forms	to	be	open	at	the	same	time
(Multiple	Document	Interface).		

This	allows	swift	movement	between	different	open	forms	by
selecting	the	relevant	Icon	from	the	ICON	BAR	at	the	bottom.	
	

e.g	Select	the	 	Icon	to	bring	the	Bills	Outstanding	form	into	focus.

	

Click	to	enlarge

	

The	ICON	BAR	underneath	lists	all	the	open	forms.
	

The	Icon	for	the	Form	in	focus	is	Gold.																		e.g	

	

The	Icons	for	the	Forms	out	of	focus	are	in	white.			e.g	
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Administrator	Details:

	

The	Admin	user	is	the	administrator	of	the	system	and	
has	the	following	characteristics:

has	access	and	control	of	all	aspects	of	the	system

authorizes	&	de-authorizes	all	other	user's	privileges	in	what
they	can	Read,	Use,	Add,	Update	or	Delete.

is	generally	responsible	for	adjusting	all	settings	within	the
system.

can	re-set	all	other	users	Passwords	and	Staff	keys	at	any
time.		

can	give	or	take	away	another	users	set	of	privileges.		

THINK	CAREFULLY	BEFORE	ASSIGNING	ADMIN
PRIVILIGES!!!!!

	

Doctor	Details:

	

To	view	the	appointment	screen	there	needs	to	be	at	least
one	doctor	present	(undeleted)	in	the	database.	
	
A	doctor	is	a	staff	member	with	a	valid	provider	number-	The
provider	number	must	match	an	algorithm	to	be	valid.
	

Default	System



	

Service	Item	Details:

	

All	Medicare	Services	Item	numbers	have	been	included	in
the	system.
	
Other	service	numbers	can	be	added	but	the	system	will	add	the	Prefix
P	to	any	added	services	within	the	system.	
	
P=Private
	

Practice	Details:

	

A	default	practice	profile	is	loaded	in	the	system.
A	practice	profile	is	required	for	various	purposes	like	Billing,
Payments	etc.
To	re-set	the	practice	profile	click	Administration>	Practice	Profile>
Search	Profile.
Enter	*	in	the	text	box	and	click	search.
When	setting	up	a	new	practice	edit	the	details	of	the	practice	profile.
You	can	also	create	a	new	practice	profile	and	set	it	to	default.
	

There	can	be	only	one	default	practice	in	the	system.

	

Privileges:

	



Only	administrators	of	the	system	can	assign	privileges	to	other	users.
Administrators	cannot	assign	privileges	to	other	administrators	of	the
system.
Click	Administration>	Authorizations>	Privileges.

	

Administrators	can	also	create	Authorization	templates	and	assign
them	to	staff	members	when	they	are	being	registered.
	
e.g.	Create	a	list	of	templates	for	a	Principle	Doctor,	Locum	Doctor,
Senior	Receptionist,	Junior	receptionist,	Nurse,	Accountant	etc.
	
Creating	a	template	for	various	staff	members	is	a	good	practice.	
This	saves	time	when	entering	new	staff	into	the	system.	
The	administrator	can	easily	modify	a	users	permissions	later	if
adjustments	are	required	at	a	later	date.	
	
	
	
	
	
Pathology	and	Radiology	Requests:

	

Doctors	can	issue	pathology	and	radiology	requests	for	patients.
Before	requests	are	issued	a	pathology	lab	or	a	radiology	lab	must	be
saved	in	the	system.
	

First	Login:

	

The	default	password	for	all	new	users	is	abc.



When	new	users	log	in	for	the	first	time	they	will	be	prompted	to
change	their	password	and	staffkey.

The	staff	key	is	required	for	creating	a	bill	or	making	a	payment.	
There	are	other	times	when	a	staffkey	is	required	as	well.	
If	the	user	is	prompted	for	a	staff	key	then	this	must	be	entered	for	the
process	to	be	completed.	
A	user	can	re-set	their	password	and	staffkey	at	any	time.	
Administrators	can	change	the	password	and	staff	key	of	all	users.
	

The	staff	key	prompt	can	be	switched	off	by	an	administrator	in	the
system	preferences.
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Always	Exit	the	system	at	the	end	of	the	day	so	that	the	internal
clocks	that	communicate	with	Medicare	Australia	remain	properly
synchronized.
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Click	the	links	to	these	common	topics.	

User	Preferences

System	Preferences

Bulk	Billing

DVA

Private	Billing

Recalls	and	the	Recall	Manager

Scanning

Document	Intray

Hotkeys

Messaging

Tasks	and	the	Task	Manager

GPC	Library

Grids

Wildcards

Backing	up

Advanced	Searching
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Hardware	Requirements:

	

Before	you	can	start	running	the	application,	please	make	sure	the
following	prerequisites	are	met:

	

1.	 Processor	–	At	least	a	Pentium	III

2.	Minimum	RAM	required	is	512	MB.
	

Please	ensure	you	have	the	latest	Service	Pack	and	critical
updates	for	your	version	of	Windows.

	
Software	Requirements
Server

Recommended	operating	systems	are	Windows	Server
2003	,	Windows	XP	Professional

Firebird	/	Interbase	should	not	be	pre-installed	from	any
other	Software	vendors	product.

Microsoft	Internet	Explorer	5.01	or	more	recent
	
	
PMSC	recommends	not	running	the	client	on	the	server
machine.
	
Client
	

Installation



Recommended	operating	systems	are	Windows	XP,	Vista,
Windows	7

Firebird	/	Interbase	should	not	be	pre-installed	from	any
other	Software	vendors	product.

Microsoft	Internet	Explorer	5.01	and	above

No	other	3rd	party	software	is	required	to	run
GPComplete.	(e.g.	Microsoft	Word/Office)

	
Terminal	Services	-	go	to	Terminal	Services
	

Firewall	Settings

	

Server:	
The	firebird	database	server	listens	on	port	3050	of	the	server	by
default.
Keep	this	Database	Port	open	if	you	are	using	a	firewall	to	allow
the	clients	to	connect	to	the	server.	
Keep	Port	6667	open	as	this	is	required	by	the	GP	Service.

	

Clients:	
Keep	Port	6666	open	as	all	clients	need	to	listen	on	this	port.		
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The	Wizard	provides	two	different	options	for	installation.

1/	Server	and	client	

Click	the	Server	and	Client	button	to	install	the
server	and	client	on	this	machine.		(	Only	install	the
server	on	one	machine	in	the	network.)		
2/	Client	only

Click	on	the	Client	only	button	to	install	only	the
client	on	a	machine-	you	will	need	to	have	already
installed	the	Server	on	one	other	machine	in	the
network.
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Option	1.
	

Select	this	option	to	install	the	Server	and	Client	on	the	Server
computer	for	the	LAN.
	

Only	install	one	instance	of	the	Server	on	the	network.

	

	

	

This	will	install	:
	

1.	 Firebird	Database	Super	Server	v1.5.2
2.	 GP	Service

3.	 Firebird	Data	File	(.FDB)		(gpc.fdb)
4.	 Firebird	ODBC	2.0.0

5.	 GPComplete	Application
	
	

Firebird	Database	Server	v1.5.2	[1]
	
	

	

	

	

Server	Installation
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Option	2
	
Select	this	Option	to	install	the	Clients	on	workstations	belonging	to	a
network	where	a	Server	installation	has	already	been	performed.	(i.e
Option	1	)
	
The	GPComplete	Client	machines	will	be	accessing	the	GP	Server
machine	via	LAN.
	

	
	

	

	

	This	will	install	the	following:

Firebird	ODBC	2.0.0

GPComplete	Application
	

The	installation	of	GP	Client	takes	some	time	as	it	copies	the	large
240	MB	file	for	MIMs	prescriptions.
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Terminal	Services



Terminal	Services
All	users	require	read	and	write	access	to	the	folder	on	the	Terminal
Server	in	which	GPComplete	has	been	installed

Default	pathway	is			C:\GPComplete
	

Registry	Edit	instructions
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To	stop	or	start	the	GP	Service
	
Go	to	Start	>	Settings	>	Control	Panel	>	Administrative	Tools	>
Services.
	
or
	
Go	to	Start	>		Run.
	
	
Type	in	"services.msc"	in	the	box	and	hit	enter.
	

	
The	list	of	Windows	Services	will	be	displayed.
	
Scroll	down	to	the	GP	Service	and	then	right	click	on	the	row.
From	the	menu	select	to	either	stop	or	start	the	Service.
	
The	Service	form	can	then	be	closed.	
	
	

Click	to	enlarge
	
If	the	GP	Service	is	not	started	then

Results	will	not	be	download	to	the	Intray.

Letters	and	scan	documents	can't	be	read	or	stored.

	

	
	
	

[1]	www.firebirdsql.org

GP	Service
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The	Demonstration	version	of	GPComplete	is	limited	to	the
addition	of	100	new	patients.	
	

Please	contact	us	if	you	require	the	full	version
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Server	Migration
	
1.	Download	the	full	installation	from
http://www.pmsc.com.au/updates/
2.	Old	server:	From	services	turn	off:	Firebird	Guardian	Service
3.	Copy	Database	gpc.fdb	(default	location:	c:\gpcdata\	may	be
different	on	your	server)
4.	Install	the	GPComplete	servce	on	new	Server
5.	Copy	C:\Program	Files\GPComplete\Service\SW\setup.exe	from
old	server	and	run	it	on	the	new	server	(this	is	the	latest	update)
6.	Stop	Firebird	Guardian	service	on	the	new	server	and	copy	the
database	backed	up	in	step	3
7.	Copy	C:\GPComplete\Service\RecFiles	from	old	server	to	new
8.	Copy	C:\GPComplete\Service\HWS_FILES	from	old	server	to	new
9.	Copy	C:\GPComplete\Service\MIMS	from	old	server	to	new
10.	Start	Firebird	Guardian	service	on	the	new	server	
11.	If	there	is	any	pathology	download	taking	place	on	the	server
these	software	has	to	be	installed	and	configured	on	the	new	one.	
12.	On	the	old	server	open	GPComplete.	Goto	Administration-
>settings->medicare	australia	and	check	the	path	to	the	cryptostore
path
13.	Copy	this	file	from	old	server	to	new	server
14.	Configure	medicare	on	the	new	server
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Client	Migraton:
	
1.	Run	the	full	installation	(install	only	client)	and	the	update	copied	in
step	5	above
2.	For	setting	medicare	australia:On	old	machine	check	the	path	of
the	psi	file	on	the	client	by	going	into	GPComplete	and	then	from	top
menu	Financial	>	Medicare	Australia	>	Tools	>	Manage	Medicare
Connection	>	Crytostore	fle	path
3.	Copy	the	file	from	that	location	into	the	new	machine
4.	Copy	C:\GPComplete\Client\Files\CONFIG\TransConfig.xml	from
the	old	machine	to	the	new	machine
5.	Open	C:\GPComplete\Client\Files\CONFIG\TransConfig.xml	file	in
notepad	in	new	machine	and	if	required	change	the	line	so	the	file
points	to	the	right	path
			
<CryptoStoreFilePath>PATHTOPSIFILE\abc.psi</CryptoStoreFilePath>
6.	Run	the	client	on	the	new	machine
7.	Configure	the	client	to	point	to	the	:	put	the	Ip	address	of	the	server
and	the	path	of	the	database	file	as	on	the	server	(eg:
c:\gpcdata\gpc.fdb)
	
	
You	will	also	need	to	setup	the	pathology	download	programs	to
download	the	results	to			C:\GPComplete\Service\RecFiles	on	the
new	server
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Username	=	not	case	sensitive
Password	=	case	sensitive
	
Users	are	prompted	to	change	their	password	and	staff
key	after	their	FIRST	login
	
The	initial	password	is	'abc'
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Add	Login



Add	Login	
Whenever	a	new	staff	registration	takes	place,	a	login	is	created	for
the	staff	member	being	registered.	You	can	create	new	logins	for
existing	staff	members	as	well.	You	can	create	a	new	login	only	if	you
are	the	administrator	of	the	system	or	you	have	the	privilege	to	do
so.	

To	add	a	new	login	select	administration	from	the	main	menu	and
then	add	login	from	the	login	manager	submenu.

	

The	create	login	form	will	now	be	displayed	to	you.

	

Type	in	the	login	name	and	login	password	which	are	limited	to	10
alphanumerics.	If	you	want	this	login	to	be	an	administrator	of	the
system	then	please	tick	the	"Is	Admin"	checkbox.	Before	clicking	on
the	create	login	button	please	select	the	staff	code	of	the	staff
member	you	want	to	create	the	new	login	for.	To	select	the	staff	code,
click	on	the	'?'.

	

The	staff	list	will	be	displayed	to	you.	Select	the	staff	you	want	to
create	the	login	for	by	double	clicking	on	the	staff	record	or	hit	enter
on	the	grid	after	selecting	the	staff	member.	The	staff	list	form	will
automatically	close	after	you	have	made	your	selection	and	the	staff
code	of	the	staff	member	selected	will	be	filled	on	the	login	form.

	

When	you	click	the	create	login	button	now,	the	software	will	first
check	if	any	matching	username	or	login	name	already	exists	in	the
system.	If	so,	the	software	will	prompt	you	that	the	username	already
exists	and	you	will	have	to	input	a	different	username.	Otherwise	the
login	will	be	saved	and	ready	for	use.

	



The	password	typed	here	will	have	to	be	changed	the	first	time
any	user	logs	on	with	the	newly	created	login.
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Delete	Login



Delete	Login
Only	Admin	users	can	delete	a	Login	

Administration	>	Login	Manager	>	Edit	Login		

The	form	contains	a	list	of	existing	logins

The	login	list	will	only	show	you	the	logins	which	are	active.
Deleted	logins	will	not	be	shown.

	

To	delete	a	login,	first	select	the	login	you	want	to	delete	or	click
the	delete	button	of	the	form.	The	software	will	prompt	you	for
confirmation.	The	login	will	immediately	be	deleted	from	the	system.

	

If	the	login	being	deleted	is	currently	logged	on	to	the	system,	then
the	deletion	will	take	effect	only	after	the	user	has	logged	off	from
the	system.

	



Password	and	Staff	Key
All	users	of	the	system	can	change	their	password	and	staff	key.	To
change	your	password	or	staff	key	select	administration	from	the	main
menu	and	then	password	and	staff	key	from	the	login	manager
submenu.	

	

A	new	form	will	be	displayed	where	you	can	change	your	login	password
or	you	staff	key.

	



			Password
Your	password	is	the	key	to	your	software.	It	is	used	to	authenticate	you
as	the	user.	You	cannot	login	to	the	system	without	a	valid	username	and
password.



	
You	can	change	both	your	password	and	staff	key	simultaneously	or
either	of	them.	Please	tick	the	appropriate	checkbox.	To	change	your
password	or	staff	key,	you	will	need	to	input	your	old	password	or	staff
key.	Otherwise,	the	system	will	not	allow	you	to	change	your	password	or
staff	key.

	

When	you	log	in	for	the	first	time	you	are	required	to	change	your
password	and	set	your	staff	key.	At	first	login	you	are	not	required	to
enter	any	old	staff	key,	but	you	need	to	enter	the	initial	password.
Please	ask	the	administrator	of	the	system	or	the	user	who	created
your	staff	registration	for	your	initial	password.
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Edit	Login



Edit	Login	
An	administrator	can	modify	the	login	settings	of	all	other	users.

To	modify	a	login	select	Administration>Login	Manager>Edit
Login	submenu.	

The	form	containing	a	list	of	all	existing	logins	in	the	system	will	be
displayed	to	you.

	

The	login	list	will	only	show	you	the	logins	which	are	active.
Deleted	logins	will	not	be	shown.

	

To	edit	a	login	you	can	double	click	any	record	or	hit	enter	on	the	grid
after	selecting	the	login	you	want	to	edit	or	click	the	edit	button	of	the
form.

	

The	login	update	form	will	now	be	displayed	to	you	with	the	details	of	the
login.

	

The	login	name	or	username	cannot	be	changed.

The	password	and	staff	key	of	any	user	can	be	changed	by	the
Administrator.

To	make	the	login	an	administrator	login	you	need	to	tick	the	"Is	Admin"
checkbox.

After	you	have	made	the	changes	click	the	update	button.

		

If	the	login	being	modified	is	currently	logged	on	to	the	system,	then
the	password	change	will	take	effect	only	after	the	user	has	logged	off



from	the	system.	The	staff	key	change	will	take	effect	immediately.
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	Staff	Key
The	system	will	prompt	for	a	staff	key	for	important	actions	or
changes	in	the	system

For	example	creating	a	bill	or	making	a	payment

The	Staff	Key	can	be	disabled	by	the	Admin	user

Administration	>	Settings	>	System	Preferences	>	Administration	Tab

Uncheck	the	box	Ask	for	Staff	key	for	important	operations

	

Click	to	enlarge
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On	the	main	menu	click	Session	>	Log	Off

Log	off	when	you	are	not	using	the	system	or	if	another	user	wants	to
Log	themselves	into	the	system

The	software	will	prompt	you	for	your	unsaved	changes	and	log	you
off.

	

	

	

Always	Exit	the	system	at	the	end	of	the	day	so	that	the	internal
clocks	that	communicate	with	Medicare	Australia	remain	properly
synchronized.
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GPcomplete	will	lock	the	system	automatically	after	a	specified
period	of	inactivity.

The	user	will	then	need	to	Login	again	to	unlock	the	system.

Automatic	Locking	can	be	disabled	or	the	Locking	interval	adjusted
through	user	preferences.	

To	Lock	the	system	at	any	time,	go	to	the	main	menu.	Click
Session>Lock.

The	time	interval	to	automatically	lock	can	be	adjusted	

Go	to	Administration	>	User	Preferences.

On	the	General	tab,	enter	the	"Lock	time	interval".	The	units	are	in
minutes

	

	

	

	

	

When	the	application	is	in	a	locked	state	and	you	click	exit,	all
unsaved	data	of	the	previous	user	will	be	lost.	The	software	will
ask	for	the	confirmation	if	exit	is	clicked	accidentally.

	

See	Also	

Administration	-	Settings:	User	Preferences
	

	

Lock
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On	the	main	menu	Click	Session>Exit.	This	shut	down	the
application.	

The	application	with	prompt	you	to	save	any	unsaved	data	before	it
shuts	down.

	

	

The	system	will	prompt	with	a	warning	to	shutdown	if	it	has	been
running	past	midnight.

	

	

	

	

	

	

		

Always	Exit	the	system	at	the	end	of	the	day	so	that	the	internal
clocks	that	communicate	with	Medicare	Australia	remain	properly
synchronized.
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Administration



Click	Administration	on	the	main	menu
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The	Practice	Profile	stores	details	about	the	practice.

There	can	be	more	than	one	practice	profile,	but	at	any	given	point	of
time	there	is	only	one	default	practice	profile.

This	default	practice	profile	is	required	for	printing	and	other	purposes
such	as	storing	the	details	of	the	state	and	country	of	any	new	patient
or	staff	registration.

The	software	comes	with	a	default	practice	profile	which	can	be
modified	by	you.

You	can	also	create	a	new	profile	and	set	it	to	be	the	default.

Adding	a	Practice	Profile



Steps	to	add	a	Practice	Profile
	

1.	 On	main	menu	select	

Administration>	Practice	Profile	>	Create	profile	

2.		Fill	in	the	required	fields	and	click	create	new	button	

Click	to	enlarge

	

You	can	also	open	the	practice	profile	screen	from	practice
profile	search	by	selecting	the	"Add	New"	button.

	



Mandatory	Fields	in	Practice	Profile
Show	All

ABN

The	ABN	number	of	the	practice.	

Name

The	name	of	the	practice.	
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Other	fields	in	Practice	Profile
	

Post	code,	Suburb	and	State

Post	Code,	Suburb	and	State	autofill	is	provided	in	the	software.
Before	you	can	do	a	search	on	post	code,	you	need	to	enter	at	least	3
digits	of	the	post	code	you	are	searching	for.	To	start	the	search,	click
on	the	'?'	button	next	to	post	code	text	box.	If	a	match	is	found,	a
separate	form	opens	up	where	you	can	select	the	desired	post	code
by	double	clicking.	Suburb	and	State	gets	automatically	filled	in.
Otherwise	you	can	also	type	in	the	suburb	and	hit	the	tab	key.	If	a
perfect	match	is	found	with	the	suburb,	the	post	code	and	state	gets
filled	in	automatically.

Unless	you	have	specified	any	country	other	than	Australia,	your
choice	of	states	will	be	restricted	to	states	in	Australia.	

Set	Practice	as	Default

If	you	want	to	save	this	profile	as	the	default	one	then	please	tick	this
checkbox	on.

	

It	is	recommended	to	fill	up	all	the	default	practice	values.

See	Also	

Practice:	Modifying	a	Practice	Profile	|	Deleting	a	Practice
Profile	|	Practice	Profile	Search
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You	can	modify	a	practice	profile	after	searching	for	the	profile.		

Modifying	a	Practice	Profile



Restrictions
If	the	practice	you	are	modifying	is	the	default	one,	then	the	"Set
Practice	as	Default"	checkbox	will	be	disabled.	At	any	given	point	of
time	at	least	one	practice	profile	has	to	be	the	default	one.	If	you	want
to	make	a	different	practice	profile	the	default	one,	then	the	only	way
to	do	so	is	to	tick	the	"Set	Practice	as	Default"	checkbox	of	the
different	profile	and	save	it.	This	will	uncheck	the	earlier	default
practice.

See	Also	

Practice:	Adding	a	Practice	Profile	|	Deleting	a	Practice
Profile	|	Practice	Profile	Search
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Currently	there	is	no	way	to	delete	a	practice	profile.	The	only	record
you	should	be	concerned	about	is	the	default	practice	profile.	The
others	are	not	used	by	the	application	unless	and	until	any	one	of
them	is	made	the	default	profile.

See	Also	

Practice:	Adding	a	Practice	Profile	|	Modifying	a	Practice
Profile	|	Practice	Profile	Search
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A	search	functionality	is	provided	for	practice	profiles.	On	the	main
menu	click	on	administration	and	then	search	profile	from	the	practice
profile	sub	menu.

	

	

A	search	form	will	be	displayed	to	you.	You	can	search	for	practice
profiles	from	this	screen	by	typing	either	the	name	or	ABN.	You	can
make	the	use	of	wildcard	characters	when	searching.	If	your	search
matched	any	records,	then	the	practice	profiles	will	be	displayed	in
the	grid	below.

	

Click	to	enlarge

	

You	can	hit	enter	on	any	searched	record.	This	action	will	take	you	to
the	practice	profile	details	screen	where	you	can	modify	the	details.

The	default	practice	profile	if	found	in	the	searched	records	will	be
displayed	in	a	different	color.

See	Also	

Practice:	Adding	a	Practice	Profile	|	Modifying	a	Practice
Profile	|	Deleting	a	Practice	Profile
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Click	Administration>Practice	Profile>Search	Profile

tick	the	box	for	RRMA	3-7
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To	add	a	new	contact	from	the	main	menu

click	on	Administration	>	Address	Book	>	Add	New	

	

	

	

A	form	will	be	displayed	to	you	where	you	can	add	your	contact
details.

Click	to	enlarge

	

Adding	a	Contact



Mandatory	Fields	in	Address	Book	
Show	All

Any	one	of	the	following	fields	in	address	book	is	mandatory.

	

Name

Organization
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Other	Fields	in	Address	Book	
	

Post	code,	Suburb	and	State

Category

Private

	

Administrators	of	the	system	will	be	able	to	view	and	update	all
contacts	present	in	the	system.

	

A	contact	can	also	be	added	automatically	while	saving	a
pathology	lab,	radiology	lab	or	an	agency.	After	saving	the
pathology	lab,	radiology	lab	or	an	agency,	the	system	will	prompt
you	whether	you	want	to	save	the	added	lab	or	agency	as	a
contact	in	your	address	book.

See	Also	

AddressBook:	Modifying	a	Contact	|	Search	Contact
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You	can	modify	a	contact	after	searching	for	it.

Modifying	a	Contact



Restrictions
1.	 You	cannot	edit	a	contact	which	is	created	and	marked	as

private	by	another	user.

2.	 You	cannot	delete	a	contact	which	is	not	created	by	you.

	

Administrators	can	search	and	modify	all	contacts.

See	Also	

AddressBook:	Adding	a	Contact	|	Search	Contact
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Search	Contact



To	Search
	

Click	Administration	>	Address	Book	>	Search

	

	

A	search	form	will	be	displayed	to	you.

You	can	search	for	contacts	from	this	screen	by	typing	in	a
combination	of	name,	organization,	suburb,	state	and	post	code.

You	can	use	wildcard	characters	when	searching.

If	your	search	matched	any	records,	then	the	contacts	will	be
displayed	in	the	grid	below.

						
Click	to	enlarge																												 Click	to	enlarge																			

	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
will	display	the	contact	where	you	can	modify	the	details.



Options
1.	 Category	-	You	can	filter	the	search	records	by	your

preferred	category.	Set	category	to	'None'	if	you	do	not	want
any	filter.

2.	 Include	Deleted	Contacts	-	Setting	this	option	will	include
in	the	search	results	contacts	which	are	deleted	but	matches
the	search	criteria.

3.	 Show	Card	View	-	Setting	this	option	will	display	the	search
results	in	a	card	view	format.	If	this	option	is	switched	off,	the
search	results	will	be	displayed	as	records.

See	Also	

AddressBook:	Adding	a	Contact	|	Modifying	a	Contact
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Agency



On	the	main	menu	click
Administration>Agency
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Agency	details	can	be	stored	in	the	software.

These	details	are	needed	when	billing	an	agency.	

To	add	click

Agency	>	Add	Agency	

	

	

The	form	to	add	a	new	agency	will	be	displayed	to	you.

	

Adding	an	Agency



Mandatory	Fields	in	Agency
Show	All

Code

The	code	by	which	the	software	will	recognize	the	agency	

Name

The	name	of	the	agency	

Address	1

The	address	of	the	agency	

Post	code,	Suburb	and	State

Post	Code,	Suburb	and	State	autofill	is	provided	in	the	software.
Before	you	can	do	a	search	on	post	code,	you	need	to	enter	at	least	3
digits	of	the	post	code	you	are	searching	for.	To	start	the	search,	click
on	the	'?'	button	next	to	post	code	text	box.	If	a	match	is	found,	a
separate	form	opens	up	where	you	can	select	the	desired	post	code
by	double	clicking.	Suburb	and	State	gets	automatically	filled	in.
Otherwise	you	can	also	type	in	the	suburb	and	hit	the	tab	key.	If	a
perfect	match	is	found	with	the	suburb,	the	post	code	and	state	gets
filled	in	automatically.

Unless	you	have	specified	any	country	other	than	Australia,	your
choice	of	states	will	be	restricted	to	states	in	Australia.	
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Other	Fields	in	Agency
ABN

ABN	of	the	agency	

Contact	Name

Contact	name	should	be	inserted	in	the	format	lastname,	firstname,
middlename

See	Also	

Agency:	Modifying	an	Agency	|	Deleting	an	Agency	|	Search	Agency
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You	can	modify	agency	details	if	you	have	permission.

	

Click	Agency	>	Search	Agency.	You	can	use	a	wildcard	in	your
search.

	

Restrictions
1.	 You	cannot	modify	the	agency	code.

2.	 You	will	not	be	able	to	delete	the	agency	if	you	are	not
authorized.

See	Also	

Agency:	Adding	an	Agency	|	Deleting	an	Agency	|	Search	Agency
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You	can	delete	an	agency	if	you	are	authorized	to	do	so.	Tick	the
deleted	checkbox	when	you	are	modifying	the	agency	to	mark
the	agency	as	deleted.

See	Also	

Agency:	Adding	an	Agency	|	Modifying	an	Agency	|	Search	Agency
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A	search	functionality	is	provided	for	the	agencies.	On	the	main	menu
click	on	agency	and	then	select	search	agency.

A	search	form	will	be	displayed	to	you.	You	can	search	for	agencies
from	this	screen	by	typing	in	a	combination	of	name	or	code	or	ABN.
You	can	make	the	use	of	wildcard	characters	when	searching.	If	your
search	matched	any	records,	then	the	agency	records	will	be
displayed	in	the	grid	below.

Click	to	enlarge

	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
will	display	the	agency	screen	where	you	can	modify
the	agency	details.

Search	Agency



Options
1.	 Include	Deleted	Agencies	-	Setting	this	option	will	include

in	the	search	results	agencies	which	are	deleted.

See	Also	

Agency:	Adding	an	Agency	|	Modifying	an	Agency	|	Deleting	an	Agency
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Pathology



See	also	Pathology	Results	and	Pathology	Requests
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At	least	one	pathology	laboratory	provider	must	be	registered	in
the	system	before	a	request	can	be	issued.

A	list	of	pathology	labs	can	be	stored	in	the	system.

To	add	a	pathology	lab	click

Administration	>	Add	Path	Lab.

	

		

A	new	form	will	be	displayed	to	you	where	you	can	save	a	pathology
lab.

Click	to	enlarge

	

Add-Search-Modify	a	Pathology	Lab



		Mandatory	Fields	in	Pathology	Lab
Show	All

Code

Name
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Other	fields	in	Pathology	Lab	
Post	code,	Suburb	and	State

Default

	

When	you	save	a	pathology	lab,	the	software	will	prompt	you	whether
you	want	to	include	it	as	a	contact	in	the	address	book.

See	Also	

Pathology:	Modifying	Pathology	Lab	|	Search	Pathology	Labs
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You	can	modify	a	pathology	lab	record	after	searching	for	it	if	your
login	has	this	permission.

Modifying	Pathology	Lab



			Restrictions
1.	 You	cannot	modify	the	pathology	code.

2.	 You	will	not	be	able	to	delete	the	Pathology	Lab	if	you	are
not	authorized.

See	Also	

Pathology:	Add-Search-Modify	a	Pathology	Lab	|	Search	Pathology
Labs
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A	list	of	all	Pathology	Labs	can	be	displayed	by
clicking	Administration	>	Search	Path	Lab	from	the	sub	menu.

	

	

	

A	search	form	will	be	displayed	to	you.	You	can	search	for	pathology
labs	from	this	screen	by	typing	in	name	or	code.	You	can	make	the
use	of	wildcard	characters	when	searching.	If	your	search	matched
any	records,	then	the	pathology	labs	will	be	displayed	in	the	grid
below.

	

Click	to	enlarge

	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
action	will	take	you	to	the	pathology	screen	where	you	can	modify
the	pathology	lab	details.

Search	Pathology	Labs



			Options
1.	 Include	Deleted	Pathology	-	Setting	this	option	will	include

in	the	search	results	pathology	labs	which	are	deleted.	If	this
option	is	switched	off,	the	search	results	will	output	only
those	pathology	labs	which	are	currently	present.

See	Also	

Pathology:	Add-Search-Modify	a	Pathology	Lab	|	Modifying	Pathology
Lab
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A	large	number	of	pathology	tests	are	already	stored	in	the	table.	
If	the	doctor	wants	to	add	a	user	defined	test	to	this	table	then	this	is
how	it's	done.

	

Click	on	

Administration	>	Pathology	>	Requests	>	Add	Request																								

	

The	new	Pathology	Request	form	is	be	displayed.

Here	you	can	use	any	code	that	might	help	you	remember
a	particular	test.

																																													

	
	
	

	

Both	the	code	and	description	are	mandatory.

When	the	request	code	is	selected	on	the	request	form	the	particular
request	associated	with	the	code	will	be	generated.

	

See	Also	

Pathology:	Search	or	Modify	Pathology	Request	|	Search	Pathology
Request

	

	

Add	Pathology	test	to	request	table
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You	can	modify	a	pathology	request	test	after	having	searched	for	it.		

	

To	search	for	a	Pathology	Requests	saved	by	users	click	on

	

Administration	>	Pathology	>	Requests	>	Search.

	

	

The	search	form	is	displayed.

	

	

after	searching	for	the	pathology	code,	it	can	then	be	edited

	

	

Click	to	enlarge

	

	

See	Also	

Pathology:	Add	Pathology	test	to	request	table	|	Search	Pathology
Request

	

	

Search	or	Modify	Pathology	Request
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Doctors	or	administrators	of	the	system	can	group	pathology	requests
together	as	a	favourite.

For	example	a	favourite	named	"Pregnancy"	could	contain	all	routine
antenatal	screening	tests.	

Using	favourites	can	reduce	the	time	required	for	issuing	pathology
requests	to	patients.	

To	create	a	pathology	favorite	from	the	main	menu

click	on	Administration	>	Pathology	>	Favourites	>	Add	New.

	

The	pathology	favourites	form	will	be	displayed	to	you.

Type	in	a	favourite	name.

Type	in	notes	which	are	added	to	the	request	form.

The	grid	on	the	left	shows	the	list	of	all	requests	in	the	system.

Reduce	this	by	filtering	down	the	number	of	records	in	the	left	grid	by
searching	for	the	requests.

Only	the	requests	matched	by	your	search	criteria	will	then	be
displayed	on	the	left	grid.

then:

Drag	and	drop	the	request	from	the	left	grid	to	the	right	grid

or

highlight	a	test	in	the	left	grid	and	hit	the	enter	key	to	add	the	test	to
the	right	grid

or

use	the	arrow	keys	between	the	two	grids.	The	arrow	keys	can	also
be	used	to	move	requests	between	the	left	&	right	grids.

Make	use	of	the	Ctrl	and	Shift	keys	of	the	keyboard	to	help	you	with

Add	Pathology	Favourites



multiple	selection	of	requests.

	

Click	to	enlarge
	

For	instance	if	"pregnancy"	is	selected	from	the	drop	down	arrow	in
the	favourites	field	then	a	group	of	tests	can	be	selected.

	

	

	

	

Click	to	enlarge

After	you	have	selected	your	requests	click	save.

If	you	want	to	share	this	favorite	with	other	doctors,	then	please
tick	the	"Share	with	other	doctors"	checkbox.	All	doctors	of	the
system	will	then	be	able	to	use	your	favorite	for	issuing	pathology
requests	to	patients.

See	Also	

Pathology:	Modify	Pathology	Favourites
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You	can	modify	the	pathology	favorites	which	have	been	created	by
you.	To	view	the	list	of	pathology	favorites	please	select
administration	from	the	main	menu,	select	pathology	and	then	select
list	from	the	favorites	sub	menu.

	

The	list	of	pathology	favorites	which	have	been	created	by	you	will	be
displayed.	
	

If	you	want	to	share	or	delete	any	pathology	favorite,	you	can	do	so
from	the	grid.	Just	tick	on	the	appropriate	checkbox	if	you	want	to
share	or	delete	any	pathology	favorite.	Sharing	a	pathology	favorite
will	allow	other	doctors	to	use	the	favorite	while	issuing	pathology
requests.	If	the	favorite	is	not	shared	then	only	the	person	who
creates	the	favorite	will	be	able	to	use	it.

If	you	need	to	change	the	requests	present	in	the	pathology	favorite
or	change	the	notes	associated	with	the	favorite,	then	double	click	the
pathology	favorite	record	you	want	to	edit	or	select	the	pathology
record	and	click	the	edit	button.

The	pathology	favorite	form	will	be	displayed	to	you	where	you	can
modify	the	favorite	and	save	it.

See	Also	

Pathology:	Add	Pathology	Favourites
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Radiology



See	also	Radiology	Requests	and	Radiology	History
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To	add	a	Radiology	Clinic	from	the	main	menu	select	Administration	>
Add	a	Radiology	clinic.	

	

A	new	form	will	be	displayed	to	you	where	you	can	save	a	radiology
Clinic.

Click	to	enlarge

	

Add	a	Radiology	Clinic



Mandatory	Fields	in	Radiology	Clinic
Show	All

Code

Name
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Other	fields	in	Radiology	Clinic	
Post	code,	Suburb	and	State

Default

	

When	you	save	a	radiology	Clinic,	the	software	will	prompt	you
whether	you	want	to	include	it	as	a	contact	in	the	address	book.	

	

See	Also	

Radiology:	Modifying	a	Radiology	Clinic	|	Search	Radiology	Clinic
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Modify	a	Radiology	Clinic
First	Search	for	it	then	modify	the	details	on	the	form	

	

Restrictions
1.	 You	cannot	modify	the	radiology	code.

2.	 You	must	be	authorized.

See	Also	

Radiology:	Add	a	Radiology	Clinic	|	Search	Radiology	Clinic
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All	Radiology	Clinics	in	the	system	can	be	searched.		

	

From	the	main	menu	click	on

	

Administration	>	Search	Radiology	Clinics.

	

	 	

A	search	form	will	be	displayed	to	you.	You	can	search	for	Radiology
Clinic	from	this	screen	by	typing	in	name	or	code.	You	can	make	the
use	of	wildcard	characters	when	searching.	If	your	search	matched
any	records,	then	the	radiology	Clinic	will	be	displayed	in	the	grid
below.

Click	to	enlarge

	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
action	will	take	you	to	the	radiology	screen	where	you	can	modify
the	Radiology	Clinic	details.

Search	Radiology	Clinic



Options
1.	 Include	Deleted	Radiology	-	Setting	this	option	will	include

in	the	search	results	Radiology	Clinic	which	are	deleted.	If
this	option	is	switched	off,	the	search	results	will	output	only
those	Radiology	Clinics	which	are	currently	present.

See	Also	

Radiology:	Add	a	Radiology	Clinic	|	Modifying	a	Radiology	Clinic
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Doctors	or	administrators	of	the	system	can	group	a	few	radiology
requests	together	as	a	favourite.

Using	favourites	can	reduce	the	time	required	for	issuing	radiology
requests	to	patients.

To	create	a	radiology	favourite	select	administration	from	the	main
menu,	select	radiology	and	then	add	new	from	the	favourites	sub
menu.

	

The	radiology	favourites	form	will	be	displayed	to	you.

	

Type	in	a	favourite	name	and	the	notes.

These	notes	will	be	added	to	the	request	form.

The	grid	on	the	left	shows	the	list	of	requests.

Drag	and	drop	the	request	from	the	left	grid	to	the	right	grid

or

double	click	a	request	to	move	it	the	right	grid

or

make	use	of	the	arrow	buttons	after	selecting	the	required
requests.	Use	the	Ctrl	and	Shift	keys	of	the	keyboard	to	help	you	with
multiple	selection	of	requests.

You	can	also	filter	down	the	number	of	records	in	the	left	grid	by
entering	a	code	in	the	Search	Description	field.

After	you	have	selected	your	requests	click	save.

Add	Radiology	Favourites



If	you	want	to	share	this	favourite	with	other	doctors,	then	tick	the
"Share	with	other	doctors"	checkbox.

All	doctors	can	then	use	your	favourite	requests.	

See	Also	

Radiology:	Modify	Radiology	Favourites
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You	can	modify	the	radiology	favorites	which	have	been	created	by
you.	To	view	the	list	of	radiology	favorites	please	select	administration
from	the	main	menu,	select	radiology	and	then	select	list	from	the
favorites	sub	menu.

	

	

The	list	of	radiology	favorites	that	you	have	created	be	displayed.

	

	

To	share	or	delete	any	radiology	favourite,	you	can	do	so	from	the
grid.

Just	tick	on	the	appropriate	checkboxes	if	you	want	to	share	or	delete
any	radiology	favourite.	

Sharing	a	radiology	favourite	will	allow	other	doctors	to	use	the
favourite	while	issuing	radiology	requests.	If	the	favourite	is	not
shared	then	only	the	person	who	creates	the	favourite	will	be	able	to
use	it.

If	you	need	to	change	the	requests	present	in	the	radiology	favourite
or	change	the	notes	associated	with	the	favourite,	then	double	click
the	radiology	favorite	record	you	want	to	edit	or	select	the	radiology
record	and	click	the	edit	button.

The	radiology	favourite	form	will	be	displayed	to	you	where	you	can
modify	the	favourite	and	save	it.

See	Also	

Radiology:	Add	Radiology	Favourites
	

Modify	Radiology	Favourites
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A	number	of	radiology	requests	are	already	present	in	the	system.	If
the	doctor	or	the	administrator	of	the	system	want	to	add	user
requests	they	can	do	so.	To	add	a	radiology	request	click	on
administration	on	the	main	menu,	select	radiology	and	then	select
add	new	from	the	requests	sub	menu.

Click	to	enlarge

The	form	to	add	a	new	radiology	request	will	be	displayed.

	

All	the	three	fields	on	the	form	are	mandatory.	You	can	either	select	a
predefined	category	from	the	drop	down	or	type	in	a	new	category
name.	After	you	have	input	the	request	details	click	on	save.	The
request	will	be	available	for	you	to	select	in	the	radiology	issue
request	section	of	the	clinical	profile	of	any	patient.

See	Also	

Radiology:	Modify	Diagnostic	Imaging	Request	|	Search	Diagnostic
Imaging	Request
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You	can	modify	any	radiology	request	after	searching	for	it.

See	Also	

Radiology:	Add	Diagnostic	Imaging	Request	|	Search	Diagnostic
Imaging	Request
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A	search	functionality	is	provided	for	pathology	requests	saved	by
users.

click	on	administration	>select	Imaging	>	requests	>	search.

	

Click	to	enlarge

	

The	search	form	for	radiology	requests	will	be	displayed.

You	can	search	for	radiology	requests	from	this	screen	by	typing
in	name	or	code	or	both.

You	can	make	the	use	of	wildcard	characters	when	searching.

If	your	search	matched	any	records,	then	the	radiology	requests	will
be	displayed	in	the	grid	below.

Click	to	enlarge

	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
action	will	take	you	to	the	radiology	request	screen	where	you	can
modify	the	request	details.

See	Also	

Radiology:	Add	Diagnostic	Imaging	Request	|	Modify	Diagnostic
Imaging	Request
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The	software	comes	loaded	with	most	of	the	service	items	required	to
run	a	practice.	You	can	still	add	your	own	service	items	which	are
required	to	generate	a	bill.

To	add	a	new	service	item	please	select	items	from	the	main	menu
and	then	select	add	service	from	the	service	sub	menu.

	

The	form	to	add	a	new	service	will	now	be	displayed	to	you.

	

	

	

All	new	service	codes	added	to	the	system	will	have	the	letter	P	as	a
prefix	to	their	code	number.

This	prevents	overwriting	of	MedicareAustralia	item	numbers	which
are	automatically	stored	within	the	system.

Therefore	in	searching	for	these	added	services	the	letter	P	must	be
placed	at	the	beginning	of	the	search.

Adding	a	Service



Mandatory	Fields	in	Service
Code

Name

Description
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Other	Fields	in	Service
MBS	Description

GST	Applicable

Fees

See	Also	

Service:	Modifying	a	Service	|	Deleting	a	Service	|	Search	Service
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You	can	modify	a	service	item	after	searching	for	it	if	your	login	has
proper	privilege.

Modifying	a	Service



Restrictions
1.	 You	cannot	modify	the	service	code.

2.	 You	cannot	modify	the	MBS	description.

See	Also	

Service:	Adding	a	Service	|	Deleting	a	Service	|	Search	Service
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You	can	delete	a	service	item	if	you	are	authorized	to	do	so.	Tick	the
service	deleted	checkbox	when	you	are	modifying	the	service	to	mark
the	item	as	deleted.

See	Also	

Service:	Adding	a	Service	|	Modifying	a	Service	|	Search	Service
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A	search	functionality	is	provided	for	service	items.	To	search	for	a
service,	select	items	from	the	main	menu	and	then	select
search	service	from	the	service	sub	menu.

	

The	service	search	form	will	now	be	displayed	to	you.	You	can	search
for	service	items	from	this	screen	by	typing	in	a	combination	of	name
or	code	or	description.	You	can	make	use	of	wildcard	characters	(*)
when	searching.		If	your	search	matched	any	records,	then
the	service	search	results	will	be	displayed	in	the	grid	below.

	

For	example	search	23

	
	
or	search	for	all	services	beginning	with	P
	

	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
action	will	take	you	to	the	service	item	screen	where	you	can	modify
the	details.

	

Search	Service



Options
1.	 Include	Deleted	Service	-	Setting	this	option	will	include	in

the	search	results,	service	items	which	are	currently	deleted.

See	Also	

Service:	Adding	a	Service	|	Modifying	a	Service	|	Deleting	a	Service
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Load	agency	rates



Loading	the	agency	rates	for	a	particular	agency
	

e.g.	Load	the	"Workcover"	rates

	

										

	

open	and	select	the	file	relevant	to	the	agency	and	then	click	Load	
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The	software	has	the	ability	to	store	inventory	items	for	a	practice.
You	can	add	your	own	inventory	items.	To	add	an	inventory	item
select	items	from	the	main	menu	and	then	add	inventory	from	the
inventory	sub	menu.

	

The	form	to	add	a	new	inventory	will	be	displayed	to	you.

	

	

Adding	an	Inventory



Mandatory	Fields	in	Inventory
Show	All

Code

Name

Cost	per	Unit

Retail	Price

Reorder	Level

Increase	Quantity	By

Reorder	Quantity
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Other	Fields	in	Inventory
Quantity	on	Hand	(QOH)

See	Also	

Inventory:	Modifying	an	Inventory	|	Deleting	an	Inventory	|	Search
Inventory
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You	can	modify	an	inventory	after	searching	for	it	if	your	login	has
proper	privilege.

Modifying	an	Inventory



Restrictions
1.	 You	cannot	modify	the	inventory	code.

2.	 You	will	not	be	able	to	delete	the	inventory	if	you	are	not
authorized.

See	Also	

Inventory:	Adding	an	Inventory	|	Deleting	an	Inventory	|	Search
Inventory
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You	can	delete	an	inventory	if	you	are	authorized.	Tick	the	deleted
checkbox	when	you	are	modifying	an	inventory	to	mark	the	inventory
as	deleted.

See	Also	

Inventory:	Adding	an	Inventory	|	Modifying	an	Inventory	|	Search
Inventory
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The	software	provides	a	search	functionality	for	the	inventory.	To
search	for	inventory,	select	items	from	the	main	menu	and	then	select
search	inventory	from	the	inventory	sub	menu.

	

The	inventory	search	form	will	now	be	displayed	to	you.	You	can
search	for	inventory	from	this	screen	by	typing	in	name	or	code.	You
can	make	the	use	of	wildcard	characters	when	searching.	While
searching	by	code	please	make	sure	you	start	the	search	by	'INV'.	If
your	search	matched	any	records,	then	the	inventory	search	results
will	be	displayed	in	the	grid	below.

Click	to	enlarge

	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
action	will	take	you	to	the	inventory	screen	where	you	can	modify
the	inventory	details.

Search	Inventory



Options
1.	 Below	Reorder	Level	only	-	Setting	this	option	will	include

in	the	search	results	only	those	inventory	records	which	are
currently	below	the	reorder	level.	If	this	option	is	switched
off,	the	search	results	will	output	all	the	results	matched	by
the	search	criteria.

2.	 Show	Deleted	-	Setting	this	option	will	include	in	the	search
results,	inventory	records	which	are	currently	deleted.

See	Also	

Inventory:	Adding	an	Inventory	|	Modifying	an	Inventory	|	Deleting	an
Inventory
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To	view	the	list	of	previously	saved	inventory	favorites	please
select	items	from	the	main	menu,	select	inventory	and	then	list	from
the	favorites	sub	menu.

The	list	of	inventory	favorites	will	now	be	displayed	in	a	grid.

You	can	hit	enter	on	any	record,	or	select	the	record	and	click	edit
button	or	double	click	the	record.	This	will	display	the	inventory
favorite	where	you	can	make	changes.	To	delete	the	favorite,	please
tick	the	deleted	check	box	on	the	appropriate	record.	You	can	also
mark	the	inventory	favorite	as	deleted	from	the	main	inventory
favorite	screen.

See	Also	

Inventory	Favorite:	Adding	an	Inventory	Favorite	|	Modifying	an
Inventory	Favorite
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You	can	modify	a	previously	saved	inventory	favorite	from	the	List	of
Inventory	Favorites.

See	Also	

Inventory	Favorite:	Adding	an	Inventory	Favorite	|	List	of	Inventory
Favorites
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You	can	group	a	few	inventory	items	together	and	store	them	as	a
favorite.	For	example	an	inventory	favorite	like	surgical	tray	might
contain	a	syringe	and	a	pair	of	gloves.	To	add	a	new	inventory
favorite	select	items	from	the	main	menu,	select	inventory,	and	then
select	add	new	from	the	favorites	sub	menu.

	

A	form	where	you	can	save	an	inventory	favorite	will	now	be
displayed	to	you.

	

The	grid	on	the	left	of	the	form	will	contain	the	list	of	all	inventory
items.	You	can	filter	the	items	by	typing	in	the	first	few	letters	of	the
name	of	the	inventory	you	are	looking	for.	To	view	all	the	inventory
items	again,	you	can	clear	the	search	name	text	box.

	

Adding	an	Inventory	Favorite



Mandatory	Fields	in	Inventory	Favorite
Name

Inventory	Selected

	

More	information	on	how	to	use	the	inventory	favorite	can	be
found	in	the	appointments	section	of	the	patient	clinical	profile.

See	Also	

Inventory	Favorite:	Modifying	an	Inventory	Favorite	|	List	of
Inventory	Favorites
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Inventory	Context	Menu
	

The	inventory	checkbox	of	the	records	will	be	ticked	on	if	any
inventory	was	assigned	to	the	appointment.

Inventory	assigned	to	an	appointment	cannot	be	directly	billed.

For	billing	purposes	a	special	service	item	with	service	code	'INV'	is
provided	whose	description	and	price	you	can	adjust	while	billing.	

Inventory	can	only	be	added	to	appointments	which	are	for	the
current	date	and	which	have	not	been	billed.

You	can	only	view	the	inventory	used	in	past	appointments	and	will
not	be	able	to	modify	them.	To	add	or	view	the	inventory	used,	right
click	on	any	record	and	click	on	inventory.	

	

The	inventory	form	for	appointments	will	be	displayed.

	

You	can	type	in	the	inventory	code	on	the	first	row	and	first	column	of
the	grid	and	hit	enter.	The	inventory	will	be	added	to	the	grid.	You	can
change	the	quantity	of	the	inventory	used.	If	the	inventory	quantity
entered,	is	currently	not	available	in	the	system,	you	will	not	be	able
to	insert	the	inventory.

	

If	you	do	not	remember	the	inventory	code,	click	the	first	row	and	first
column	of	the	grid	and	use	the	combination	of	'Ctrl	-	L'	keys	of	your
keyboard	to	open	inventory	search.	You	can	select	the	record	from
inventory	search	by	double	clicking	it,	and	the	inventory	will	be	added
here.	If	you	wish	to	add	a	new	inventory	at	this	stage,	please	use	the

Inventory	context	menu



combination	of	'Ctrl	-	N'	keys	of	your	keyboard	when	the	focus	is	on
the	first	row	and	first	column	of	the	grid.	The	newly	added	inventory
will	be	included	in	the	grid.

	

While	doing	inventory	search	from	this	form,	you	can	make	use	of
your	inventory	favorites.

	

Select	the	inventory	favorite	from	the	drop	down	list	and	click	on	the
select	button.	The	inventory	items	stored	in	your	favorite	will	be
added	to	the	grid.

If	the	inventory	favorite	you	selected	contains	any	deleted	inventory
or	if	any	of	the	items	do	not	have	the	required	quantity	of	inventory	as
specified	in	the	favorite,	then	those	inventory	items	will	not	be	added
to	the	grid.	The	remaining	inventory	items	in	the	favorite	will	be
added.	The	software	will	output	appropriate	messages	if
such	situations	arrive.

Please	click	on	the	save	button	after	you	have	finished	adding	the
inventory.	The	appointment	record	will	now	display	a	ticked	checkbox
where	you	have	added	the	inventory.

	

When	you	add	or	update	the	inventory	used	of	an	appointment,
the	quantity	of	original	inventory	is	automatically	adjusted.

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Staff


Staff



How	to	Add	a	new	Staff	member:
	

Click	on	the	main	menu	Staff>Add	Staff.	The	Staff	Register	form	will
become	active.

	

	

Complete	the	required	fields	on	the	Staff	Register	from.	

Note	the	Privileges	entry	in	the	bottom	right	corner	of	this	form.
A	drop-down	list	of	different	templates	can	be	selected.
Templates	provide	a	shortcut	in	assigning	permissions	to	a	new	staff
member.	

	

Click	to	enlarge
	
	

You	can	also	open	the	staff	register	screen	from	staff	search	by
selecting	the	"Add	New"	button.

	 Show	All

	 Hide	All
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Mandatory	Fields	in	Staff	Registration
	

Code

The	staff	code	is	the	code	by	which	the	staff	is	recognized	application
wide.	Once	a	staff	member	is	registered,	the	staff	code	cannot	be
modified.	No	two	staff	members	can	have	the	same	staff	code.	Staff
code	is	restricted	to	10	alphanumerics.	A	good	convention	of	keeping
staff	codes	is	to	use	the	first	initial	along	with	the	last	name	of	the	staff
member.

You	cannot	have	a	space	in	the	staff	code	field

Name

Staff	name	should	be	entered	in	the	format	"lastname,	firstname,
middlename".	

	

Phone

At	least	any	one	of	either	home	phone,	work	phone	or	mobile	phone
number	is	mandatory.	You	cannot	register	a	staff	in	the	application
without	entering	the	staff	contact	number.	

	

Date	of	Birth

Date	of	birth	field	is	mandatory	for	staff	members.		

	

Username

The	staff	username	is	automatically	filled	with	the	staff	code	entered
by	you.	The	username	for	logging	in	to	the	application	can	be	set	to	a
different	name	from	the	staff	code	only	at	this	time	of	registration	but
once	registration	has	occurred	then	you	cannot	change	the	username
or	login	name	again.		If	this	were	necessary	then	the	administrator
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would	need	to	delete	your	account	(	login	code)	and	create	a	new
login	once	again.		

	

Password

By	default	the	password	is	set	to	"abc"	once	a	staff	code	is	entered.
You	can	then	change	the	initial	password	after	logging	into	the	system
for	the	first	time	with	the	new	username.		The	system	will	prompt	you
for	your	password	and	staff	key	changes.	At	this	time	a	new
password	(&	staff	key)	can	be	set.	For	more	information	see
"Password	and	Staff	Key".	

	

Privilege

If	you	have	already	setup	authorization	templates	for	your	application,
then	you	can	choose	the	privilege	you	want	to	give	to	the	new	staff
member.	If	you	wish	to	allocate	the	minimum	privileges	to	the	staff
member,	you	can	select	"None"	in	the	drop	down	box.	Privileges	can
always	be	added	to	or	removed	from	a	login	at	a	later	time.	An	almost
infinite	variety	of	privileges	can	be	assigned	to	an	individual	user,	but
templates	in	general	allow	a	simpler	means	of	assigning	privileges	to
various	staff	categories.		For	instance	templates	could	be	set	for
permanent	doctors,	locum	doctors,	nurses,	junior	receptionists,	senior
receptionists,	practice	administrators,	accountants	etc	etc...
If	the	staff	member	you	are	registering	is	an	administrator	of	the
system,	then	please	tick	the	"Is	Admin"	checkbox	provided.	An
administrator	login	allows	all	the	privileges	present	in	the	system.		

		

GIVE	CAREFUL	THOUGHT	BEFORE	ASSIGNING	"ADMIN"
PRIVILEGES	TO	A	NEW	USER	OF	THE	SYSTEM.	
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Other	Fields	in	Staff	Registration	
	

Provider	No.

If	the	staff	member	you	are	registering	is	a	doctor,	then	you	should
enter	the	doctor's	provider	number	in	this	field.

The	application	differentiates	a	doctor	from	other	staff	members	with
the	help	of	this	field.

Provider	types	include	Allied	Health,	Radiologists	and	Pathology
Providers

For	Allied	Health	enter	the	Provider	No.	1111
The	provided	number	entered	by	you	is	validated	against	a	certain
algorithm.	Without	a	valid	provider	number,	the	application	will	not
allow	you	to	register	the	staff.

If	you	do	not	enter	any	provider	number	the	doctor	code	will	not
appear	in	the	appointment	screen.

	

Please	include	any	leading	zeros	in	the	provider	number

Prescriber	No.

Prescriber	number	is	needed	by	the	application	to	allow	a	staff	to	issue
medication	or	generate	prescription	scripts.	Without	a	valid	prescriber
number	you	will	not	be	able	to	save	or	print	scripts.	

	

Billing	Preference

By	default,	the	billing	preference	for	a	staff	member	is	set	to	the	practice
ABN.	If	at	all	a	staff	member	wishes	to	use	his/her	ABN	for	billing
purposes,	then	you	can	include	the	ABN	number	in	the	ABN	field	and
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select	"SELF"	from	the	billing	preference	drop	down.	

	

Post	code,	Suburb	and	State

Post	Code,	Suburb	and	State	autofill	is	provided	in	the	software.	Before
you	can	do	a	search	on	post	code,	you	need	to	enter	at	least	3	digits	of
the	post	code	you	are	searching	for.	To	start	the	search,	click	on	the	'?'
button	next	to	post	code	text	box.	If	a	match	is	found,	a	separate	form
opens	up	where	you	can	select	the	desired	post	code	by	double	clicking.
Suburb	and	State	gets	automatically	filled	in.	Otherwise	you	can	also
type	in	the	suburb	and	hit	the	tab	key.	If	a	perfect	match	is	found	with	the
suburb,	the	post	code	and	state	gets	filled	in	automatically.

Unless	you	have	specified	any	country	other	than	Australia,	your	choice
of	states	will	be	restricted	to	states	in	Australia.	

	

Locum

If	staff	member	being	registered	is	a	locum,	then	you	need	to	choose	the
staff	for	whom	he/she	is	being	assigned.	This	can	be	done	from	the	drop
down	list	containing	the	staff	codes.	

	

Duplicate	Staff	Prompt

The	software	will	prompt	you	for	duplicate	staff	if	it	finds	a	close	match
with	already	registered	staff	in	the	system.	For	more	details	please	see
"Duplicate	Staff"	

	

See	Also	

Staff:	Modifying	a	Staff	|	Deleting	a	Staff	|	Staff	Search
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A	staff	member's	record	can	be	modified	after	it	has	been	entered.			

Modifying	a	Staff



Restrictions
1.	 You	cannot	modify	the	staff	code	once	the	staff	is	registered

2.	 Login	details	will	not	be	present	in	this	screen	anymore

See	Also	

Staff:	Staff	|	Deleting	a	Staff	|	Staff	Search
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A	staff	member	cab	be	deleted	through	the	"Deleted"	checkbox	in	the
bottom	left	corner	of	the	form.

Just	tick	the	checkbox	and	then	click	save	to	delete	the	staff
member.		

	

Click	to	enlarge
	

Once	you	delete	a	staff	member,	all	the	logins	associated	with	the
staff	member	will	be	automatically	disabled.

	

See	Also	

Staff:	Staff	|	Modifying	a	Staff	|	Staff	Search
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If	you	are	an	administrator	of	the	system	you	can	set	away
records	for	all	staff	members,	otherwise	you	can	set	away	dates
only	for	yourself.

	

If	you	are	taking	leave	for	a	few	days,	you	can	set	yourself	as	away
specifying	the	dates.	To	create	an	away	record	go	to	the	main	menu
and	select	staff	and	then	away	dates.

	

Steps	to	create	staff	away:

1.	 Choose	the	staff	code	that	you	wish	to	set	the	away	dates
for.	If	you	are	not	an	administrator,	then	only	your	own	staff
code	will	be	present	in	the	list.

2.	 Add	a	new	record	to	the	grid	by	selecting	the	dates	in	the
first	row	of	the	grid	and	hit	enter.	Please	take	a	look	at
"Working	with	Grids"

	

If	you	are	setting	the	away	date	for	a	doctor,	the	software	will
check	for	any	appointments	already	present	for	the	doctor	on
those	dates	and	will	prompt	the	user

		

When	you	hit	enter	after	selecting	the	dates	the	row	will	be	added	to
the	grid.

		

You	can	also	edit	a	staff	away	record	or	delete	it.	Whatever	changes
you	make	to	the	form	will	have	to	be	saved	for	changes	to	take	effect.

Staff	Away



Allow	Results	Checkbox
The	"allow	results"	checkbox	has	significance	only	to	doctors	in	the
system.	When	a	doctor's	away	record	is	being	set,	the	
"allow	results"	checkbox	determines	whether	other	doctors	in	the
system	will	be	able	to	view	his	or	her	pathology	results	downloaded
on	those	dates.



Restrictions	for	Staff	Away
1.	 Once	a	record	is	added	to	the	grid	you	will	not	be	allowed	to

change	the	away	date.	You	can	delete	the	record	and	add	a
new	one.

2.	 If	the	return	date	of	a	record	is	in	the	future,	then	you	will	be
able	to	change	the	return	date	or	delete	the	record.	If	the
return	date	is	past	the	current	date	then	no	changes	or
deletion	of	the	record	is	allowed.

	

Once	you	have	saved	the	records,	the	login	of	the	staff
member	will	be	disabled	on	the	dates	that	he	or	she	will
be	away.	The	login	will	automatically	be	enabled	on	the
date	specified	as	the	return	date.

If	you	have	set	an	away	for	yourself	starting	from	the
current	date,	you	will	not	be	able	log	back	in	to	the
system	after	you	have	logged	out.	An	administrator	of
the	system	will	have	to	delete	your	away	record	in	this
situation	if	you	need	to	log	in	again.

If	a	staff	member	returns	before	the	specified	return	date,
then	the	administrator	of	the	system	will	have	to	log	in
and	modify	the	staff	member's	away	dates	and	set	the
return	date	to	the	current	date	before	the	staff	member
can	log	on	to	the	system.
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If	the	new	staff	member	you	are	registering	has	the	same	last	name
and	first	name	as	an	existing	staff	member,	then	the	system	will
prompt	you	about	the	duplicate	staff.

	

	

You	have	two	options:

1.	 Keep	New	Staff:	This	option	will	let	you	continue	with
registering	the	new	staff	member

2.	 Merge	New	Staff:	Select	this	option	to	merge	the	new	staff
with	an	existing	staff	member	you	have	selected	from	the
grid.

	

If	merging	two	staff	then	all	new	values	will	overwrite	the	old
values	except	the	staff	code.	The	staff	code	will	remain	the	same.

	

See	Also	

Staff:	Staff
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On	the	main	menu	click	on	Staff>Search	staff.

	

A	search	form	will	be	displayed	to	you.	You	can	search	for	staff
members	from	this	screen	by	typing	in	name	or	code	or	both.	You	can
make	use	of	wildcard	characters	when	searching.

Click	to	enlarge

	

If	your	search	matched	any	records,	then	the	staff	members	will	be
displayed	in	the	grid	below.

Click	to	enlarge	

You	can	hit	enter	on	any	searched	record	or	double	click	it.	This
action	will	take	you	to	the	staff	details	screen	where	you	can	modify
the	staff	details.	

Staff	Search



Options
1.	 Include	Deleted	Staff	-	Setting	this	option	will	include	in	the

search	results	all	Staff	members	including	those	who	have
been	deleted.	If	this	option	is	switched	off,	the	search	results
will	output	only	those	Staff	who	are	currently	present.

2.	 Include	Away	Staff	-	Setting	this	option	will	include	in	the
search	results	Staff	who	are	inactive	or	away.	If	this	option	is
switched	off,	the	search	results	will	output	only	those	Staff
who	are	currently	active.

	

	

	Click	to	enlarge

See	Also	

Staff:	Staff	|	Modifying	a	Staff	|	Deleting	a	Staff
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Users	of	the	system	can	assign	any	patient	to	a	practice	room.	

The	additional	icon	will	appear	after	the	patient's	name	on
the	appointment	screen.	

You	can	create	any	number	of	practice	rooms	you	want	and	the
rooms	will	be	available	to	choose	from	the	appointment	context
menu.

To	manage	the	practice	rooms	click	on

Administration	>	Settings	>	Practice	Rooms	

	

The	screen	to	add	or	edit	practice	rooms	will	be	displayed	to	you.

	

	

														

	

	

Once	you	have	saved	a	practice	room	you	will	not	be	able	to	edit	the
code,	but	you	can	change	the	name.	You	can	also	delete	a	practice
room	by	ticking	the	checkbox	on	the	required	record.	The	deleted
practice	rooms	will	not	be	appearing	in	the	appointment	context
menu.

	

To	add	a	new	practice	room,	type	in	a	code	and	description	on	the
first	row	of	the	grid	and	hit	enter.	Remember	to	save	your	changes
before	exiting.	To	learn	more	about	grids	please	see	the	section
working	with	grids.

	

Practice	Rooms
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Legend



	On	the	Main	Menu	go	to
Administration>Settings>Appointment	Preferences
	
The	legend	screen	has	tabs	for	Preferences	and	Type.
	
Preferences	displays	the	various	icons	and	colors	in	the	system.
These	icons	and	colors	are	associated	with	the	appointment	screen
and	can	be	reset	from	this	form.
	
Practice	work	hours	can	be	set.
	
The	Appointment	status	grid	enables	users	to	create	and	edit	an
appointment	status.
	
	

Click	to	enlarge

		
	

Only	administrators	are	allowed	to	make	any	changes	to	the
values.

	

The	administrators	can	change	the	icons	settings.

You	can	change	the	appearance	of	temporary	appointments.	Please
click	on	the	back	color	and	fore	color	button	to	change	the	color	of	the
temporary	appointments	on	the	appointment	screen.

The	staff	roster	color	can	be	changed	with	the	help	of	the	change
button	located	next	to	the	staff	roster	color.

You	can	set	the	practice	working	hours.	The	appointment	screen	will
be	grayed	out	accordingly.

The	grid	contains	the	list	of	appointment	statuses.	



The	records	marked	in	blue	are	the	system	statuses	and	cannot	be
deleted.	
You	cannot	change	the	description	of	the	system	statuses	but	you
can	change	their	name	and	color.	
You	can	also	add	your	own	statuses	which	will	then	be	available	from
the	appointment	context	menu	for	you	to	select.	
Billed,	receipted	and	partially	receipted	statuses	cannot	be	selected
from	the	appointment	context	menu	as	these	status	are	updated
automatically.

Any	statuses	that	you	create	can	be	deleted.	
To	delete	a	status	which	is	not	system	defined,	tick	the	deleted	check
box	of	that	record	and	save	your	changes.	
The	deleted	status	will	be	then	be	removed	from	the	appointment
context	menu.	

	

Any	changes	are	system	wide.

See	Also	

Appointment:	Appointment	Right	click	Menu	Options
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Staff	Roster



	Go	to	Administration>Settings>Staff	Roster
A	staff	roster	can	only	be	created	only	for	doctors	or	users	that	have
an	appointment	column.	eg	Nurse,	Allied	Health	etc

A	user	can	make	changes	only	to	their	own	roster	settings.

Administrators	of	the	system	can	make	changes	to	any	staff's	roster
settings.

	

To	view	the	staff	roster	select	administration	from	the	main	menu	and
then	select	staff	roster	from	the	settings	sub	menu.

	

The	staff	roster	screen	will	be	displayed	to	you.	By	default	the	logged
in	user's	roster	will	be	shown.

	

Click	to	enlarge

	

If	you	want	to	view	a	different	staff	member's	roster,	then	please
select	that	staff	member	from	the	drop	down	on	the	top	left	corner	of
the	screen.	The	working	of	the	roster	is	quite	similar	to	the
appointment	screen.

Please	mark	only	the	times	you	are	available.

To	mark	a	slot	please	type	in	relevant	data	and	hit	enter.

A	roster	record	will	be	created.

The	roster	record	can	not	be	dragged	across	the	days	of	the	week.

A	roster	can	be	stretched	from	the	top	or	bottom	border.

To	delete	a	roster,	R	click	>	delete.	

Rosters	cannot	overlap.



To	delete	a	record,	select	it	and	hit	delete.	The	system	will	prompt	you
for	confirmation.
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Drop	Downs



	Go	to	Administration>Settings>Drop	Downs
The	system	stores	a	list	of	drop	downs	where	you	can	edit	the	values.
Drop	downs	will	be	available	to	you	if	you	are	the	administrator	of	the
system	or	have	the	privilege	to	change	drop	downs.	

To	view	the	drop	downs,	select	administration	from	the	main	menu
and	then	select	drop	downs	from	the	settings	sub	menu.

The	drop	downs	form	will	be	displayed.

	

Select	the	type	of	drop	down	you	want.	The	list	of	values	currently
associated	with	that	drop	down	will	be	displayed	in	the	grid.	You	can
edit	the	values	and	close	the	form.	Your	changes	are	automatically
saved.	New	values	in	the	drop	downs	will	be	automatically	appended
when	users	select	"Add	New"	from	the	drop	downs	present	in	the
actual	form.

	

For	example	if	you	want	to	add	a	new	title	for	patients,	please	select
"Add	New"	from	the	patient	title	drop	down	in	the	patient	register
screen.
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The	software	has	a	built	in	swipe	card	reader	which	can	be	used	to
read	a	patient's	medicare	number	and	the	medicare	valid	to	date.

To	modify	the	card	reader	settings	please	select	administration	from
the	main	menu	and	then	select	card	reader	from	the	settings	sub
menu.

	

	

The	settings	for	the	card	reader	will	be	displayed	to	you.

	

The	default	settings	will	be	present	from	before.

Users	do	not	need	to	change	any	other	settings	for	reading	the
medicare	number	of	a	patient	from	a	medicare	card	except	for	the
port	if	needed.

Please	select	the	correct	port	where	your	card	reader	is	plugged	to.

You	can	test	the	port	with	the	test	button.

If	the	software	does	not	find	a	port,	an	appropriate	message	will	be
displayed.

	

How	to	use	the	card	reader
The	card	reader	will	help	you	to	automatically	populate	the	patient's
medicare	number	and	the	medicare	valid	to	date	on	an	appropriate
form.	Currently	the	forms	where	you	will	be	able	to	use	the	card
reader	are	-

1.	 Patient	Registration	form

Card	Reader



2.	 Details	node	of	the	patient	clinical	profile	form

3.	 Patient	Search	form

If	you	do	not	want	to	use	the	card	reader,	you	can	deactivate	it	using
the	checkbox	at	the	top	of	the	settings	form.

	

A	compatible	card	reader	has	to	be	plugged	in	to	your	computer
before	you	can	use	this	feature	of	the	software.	
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User	Preferences



Administration>Settings>	User	Preferences

	

	



Lock	Time	Interval

The	application	will	lock	itself	up	automatically	after	a	specified
amount	of	time	if	the	machine	is	left	idle	for	that	time.	You	can	change
the	number	of	minutes	of	the	lock	time	interval	or	disable	the	lock	of
the	application	when	you	are	logged	into	the	system.	To	disable	the
lock	up	of	the	application	please	check	the	"Never	lock	my
application"	checkbox.	For	more	information	on	how	to	lock	the
application	see	"Lock"	under	the	session	menu.	

Practice	Room	Icon
As	described	in	appointment	section,	a	practice	room	can	be
associated	with	any	appointment.	When	an	appointment	is	set	in	a
practice	room,	an	icon	is	shown	in	the	appointment	to	distinguish	it
from	other	appointments.	If	you	do	not	want	an	additional	icon	to	be
present	in	appointments	for	the	practice	room,	then	you	can	uncheck
the	"Show	Practice	Room	Icons	in	Appointment	Screen"	checkbox.

Startup	Node	on	Clinical	Profile
The	clinical	profile	screen	of	a	patient	is	made	up	of	various	nodes
like	appointments,	current	Rx,	pathology	request	etc.	You	can	select
the	startup	node	you	want	from	here.	Whenever	you	open	a	patient's
clinical	profile,	by	default,	the	startup	node	you	select	here	will	be
displayed	first.

Start	Mode	for	records	in	Clinical	Profile
When	a	patient's	clinical	profile	is	loaded,	several	records	might	be
active	or	inactive.	You	might	want	to	see	only	the	active	records	of	the
patient	once	the	screen	is	loaded.	Please	select	the	start	mode	for
displaying	the	records	here.	The	mode	can	be	changed	from	the
clinical	profile	as	well.

Preview	Bill	/	Receipt	before	print
You	have	3	options	to	choose	from	whether	you	want	to	preview	the
bills	or	receipts	before	printing.	If	you	select	yes,	the	preview	will
automatically	be	displayed.	Selecting	no	will	directly	print	the	bill	or
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receipt.	If	you	select	prompt,	then	the	software	will	ask	whether	you
want	to	preview	the	bill	or	receipt	before	printing.

Do	not	show	Pathology	Results	to	other	doctors
This	setting	is	relevant	only	for	doctors	of	the	system.	If	you	check
this	checkbox,	then	the	results	which	have	been	downloaded	having
your	provider	number	will	not	be	shown	to	the	other	doctors	of	the
system.	However,	an	administrator	of	the	system	can	view	all
results.	If	you	uncheck	this	setting,	then	the	other	doctors	of	the
system	will	be	able	to	view	the	results	from	the	intray.

Prescription	PBS	/	RPBS	/	Authority	Color
This	setting	is	relevant	only	for	doctors	of	the	system.	When	you	are
doing	a	drug	search,	the	color	of	the	results	found	will	be	set
according	to	the	colors	specified	here.

Append	Current	Rx	changes	/	Pathology	Requests	issued	to
encounter	notes
This	setting	is	relevant	only	for	doctors	of	the	system.	If	you	tick	the
checkboxes	then	any	current	rx	changes	and	pathology	requests
issued	will	be	flagged	in	the	encounter	notes	of	the	patient.

	Allow	Brand	Substitution	in	Prescriptions
By	default	brand	substitution	is	allowed	in	prescriptions.	You	can
uncheck	that	setting	here.

	

	
	

Printing

Printing
The	checkboxes	present	in	this	tab	are	for	printing	purposes.
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Click	to	enlarge

	

The	fields	selected	here	refer	to	the	default	practice	profile.
Please	check	the	fields	you	want	displayed	on	the	first	page
printed.	Printing	functions	include	the	clinical	profile,	bill	search,
payment	search,	pathology	results	and	the	various	reports.

	

Some	settings	in	the	general	and	printing	tab	require	a	restart
of	the	application	before	changes	may	take	effect.

	

Prompts

Prompts
Check	or	uncheck	the	prompts	you	want	displayed	by
the	system

Decide	if	you	wanted	to	be	warned	by	a		prompt	when
prescribing	for	Elite	athletes

Set	the	warning	level	for	drug	interactions

	

	

Click	to	enlarge

	

	

	

Clinical	Profile
Clinical	Profile

Show	All
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See	Also	

Session:	Lock
Appointment:	Adding	Appointment
Preferences:	System	Preferences
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On	the	main	menu	go	to

Administration>Settings>Preferences>System	Preferences.

System	preferences	are	the	settings	which	apply	to	all	users	of	the
system.

System	preferences	changes	can	only	be	made	by	Users
with	administrator	privileges.

Appointment	
	

	

		

Disallow	Appointment	DeleteEnter	the	number	of	minutes
in	the	provided	text	box.	
Users	can't	delete	appointments	after	the	specified	number
of	minutes	after	the	appointment	is	created.

Allow	Temporary	Appointment	Delete	
Temporary	appointments	can	be	deleted	irrespective	of	the
minutes	setting	above.

Appointment	Refresh	Time
The	appointment	screen,	when	displayed	on	the	screen,
refreshes	itself	automatically	after	a	specified	number	of
seconds.	Therefore	schedule	updates,	appointment
rescheduling,	changes	in	status	of	an	appointment	can	all	be
seen	by	you,	when	updated	by	any	other	user	of	the	system
from	a	different	machine.	You	can	set	the	refresh	interval	in
the	text	box	provided.	The	minimum	number	of	seconds	is
set	at	15.

Ask	for	Staff	Key
The	application	asks	for	staff	key	from	users	before	making
various	changes.	For	example	the	application	will	ask	you

System	Preferences



for	your	staff	key	whenever	you	register	a	new	patient,
create	a	bill,	make	a	payment,	make	changes	in	the	intray	if
you	are	a	doctor.	A	form	will	be	displayed	when	the	system
requires	you	to	input	your	staff	key	for	authentication.	If	this
setting	is	unchecked,	then	the	system	will	never	ask	for	the
staff	key.	It	is	recommended	to	keep	this	setting	on	in
medium	to	large	practices	for	audit	purposes.

Administration

Bill	Footer
If	you	want	the	software	to	print	any	text	at	the	bottom	of
printed	invoices	then	please	enter	the	text	required	in	the	bill
footer	text	box.	You	can	leave	it	blank	if	you	do	not	want	any
custom	text	to	be	displayed	on	your	invoices.

Payment	Footer
If	you	want	the	software	to	print	any	text	at	the	bottom	of
printed	receipts	then	please	enter	the	text	required	in	the
payment	footer	text	box.	You	can	leave	it	blank	if	you	do	not
want	any	custom	text	to	be	displayed	on	your	receipts.

Networking

	

SMS

See	Also	

Preferences:	User	Preferences
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Appointment	status



On	the	main	menu	Go	To	Administration	>	Settings
	

Click	to	enlarge
	
In	the	System	Preferences	a	grid	lays	out	the	various	statuses	that
are	within	the	system.	A	user	can	create	further	status	names	by
completing	the	grid.
	

	

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Appointment Type


Appointment	Type
To	set	a	patient's	type	of	appointment	right	click	their	name	on	the
appointment	screen	and	select	type

	

To	create	new	Appointment	types

Administration	>	Settings	>	Appointment	Preferences	and	then	click
the	Type	tab

	

The	features	of	an	Appointment	Type	are

Display	name

Font	type

Font	colour

Font	size

Background	shape

Background	colour

Associated	appointment	duration

	

Click	to	enlarge
	
When	an	appointment	type	is	created	then	a	person's
appointment	can	be	associated	with	the	relevant	Type.
	
	
	

	

	

Appointment	Type
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Administrator	only.	
Privileges	can	only	be	updated	by	Administrators	of	the	system.

The	Authorizations	menu	is	only	visible	to	Administrators	of	the
system.

From	the	main	menu	click	on	Administration	>	Authorizations	>
Privileges.

	

	

The	authorization	form	will	be	displayed	to	you.

	

First	you	need	to	select	the	login	name	from	the	drop	down	box.	

	

Authorizations	are	login	dependant.	If	one	staff	member	has	two
different	logins,	then	changes	will	take	effect	only	when	the	staff
member	logs	on	with	the	login	whose	privilege	has	been	changed.
The	other	login	will	continue	to	have	the	earlier	privileges	unless
they	are	changed.

The	logins	of	the	administrators	of	the	system	will	not	be	present
in	the	drop	down.	Administrators	of	the	system	have	all	the
privileges	and	you	cannot	remove	them	individually.

	

Once	you	select	the	login	name,	the	categories	tree	will	be	filled	up.
There	are	three	ways	you	can	organize	the	privileges.

	

1.	 You	can	either	select	the	parent	node	(General,

Privileges



Administration,	Practice	report,	Medical	Records	etc...),
select	the	options	you	want	to	set	and	then	click	on	apply
child.	When	you	click	on	apply	child,	then	the	selected
options	will	be	copied	down	through	all	the	"children"	under
that	particular	node.

2.	 You	can	also	select	individual	child	nodes	by	clicking	on	the
+	sign	next	to	the	parent	node	and	then	set	the	options.	
When	you	select	the	child	node,	the	apply	child	button	will
be	disabled.

3.	 You	can	apply	a	previously	saved	template	to	the	login	by
checking	the	'Link'	check	box	and	selecting	the	template
name	from	the	drop	down.	Click	on	apply	template	button
and	then	save	your	changes.

	

Please	click	on	save	when	you	finish	setting	the	privileges.

	

Be	careful	not	to	give	the	privilege	of	Add/Update	a	Login	(Under
Administration	node)	as	this	will	can	allow	a	user	to	upgrade	their
privileges	by	changing	Login	to	an	Administrator!

	

Click	to	enlarge

	

	

See	Also	

Authorization:	Adding	an	Authorization	Template	|	Modifying	an
Authorization	Template	|	List	of	Authorization	Templates
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As	an	administrator	of	the	system	you	can	keep	a	set	of	predefined
authorization	templates.

These	templates	can	then	be	applied	to	new	staff	members	when
they	are	being	registered	in	the	system.

From	the	main	menu	click	

	

Administration	>	authorizations	>	templates	>	Add	New

	

	

		

The	form	to	add	a	new	authorization	template	will	be	displayed	to
you.

	

	

The	structure	of	this	form	is	similar	to	the	privilege	form.	Please	type
in	the	template	name	on	top	and	then	set	the	privileges	for	the
template.	After	you	have	made	your	changes	click	on	save.

See	Also	

Authorization:	Privileges	|	Modifying	an	Authorization	Template	|	List
of	Authorization	Templates
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As	an	administrator	of	the	system,	you	can	modify	a	previously	saved
template	from	the	list	of	authorization	templates.

	

See	Also	

Authorization:	Privileges	|	Adding	an	Authorization	Template	|	List	of
Authorization	Templates
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To	view	the	list	of	previously	saved	templates:

	

From	the	main	menu	right	click	Administration	>	authorizations	>
Templates	>	List.

	

	

	

All	the	previously	saved	authorization	templates	will	be	displayed	to
you	in	a	grid.

	

	

You	can	hit	enter	on	any	record,	or	select	the	record	and	click	edit
button	or	double	click	the	record.	
This	will	display	the	saved	template	privileges	on	the	authorization
form.

	

Click	to	enlarge

	

Make	your	changes	and	click	on	save.	The	software	will	ask	you
whether	you	want	to	update	the	privilege	for	all	logins.	This	means,
that	the	logins	which	had	been	assigned	the	currently	edited
authorization	template	before,	will	get	updated	with	the	new	template
values	currently	being	saved.	Click	on	'yes'	on	the	dialog	box	if	you
want	to	update	the	logins	or	select	'no'	if	you	want	to	leave	the
previous	logins	as	they	are.

List	of	Authorization	Templates



See	Also	

Authorization:	Privileges	|	Adding	an	Authorization
Template	|	Modifying	an	Authorization	Template
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Recent	Patients



View	a	list	of	the	last	5	patients	files	that	have	been
opened.
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Patient	Registration	screen



Patient	Registration	Screen
	

										
Click	to	enlarge																																												 Click	to	enlarge

	

The	patient	registration	screen	is	divided	into	two	sections.

1/	Details.		This	form	contains	the	primary	details	of	the	patient	like
name,	date	of	birth,	contact	and	address	details.

2/	other	Details.	This	form	stores	data	about	the	patient's	other	details
like	religion,	ethnicity	etc

	

Click	on	Health	Funds	to	read	information	about	storing	private	health
insurance	information.

	



Mandatory	Fields	in	Patient	Registration
Name

Date	of	Birth
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Other	fields	in	Patient	Registration
	

Medicare	Number

Title

Family	Name

Post	code,	Suburb	and	State

Blood	Group

Pension	Status

Is	Adopted
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Add	New	Patient



Steps	to	Add	a	new	Patient:
1/On	the	main	menu	Click	Patient>Add	Patient.
	

	

OR
	

2/	Register	a	new	patient	directly	from	the	appointment	screen.	
Click	on	a	time	on	the	appointment	screen	then	type	in	some	of	the
details	of	the	new	patient.	

then	hit	enter.

The	system	will	respond	in	one	of	two	ways.

The	system	gives	a	prompt	to	say	that	"this	patient	does	not
exist	in	the	system".		

Select	the	register	button	if	you	wish	to	enter	all	the	patient's
details	and	register	the	patient.	

Select	the	temporary	button	to	place	just	a	temporary	name
into	the	appointment	time.	If	a	temporary	appointment	is
created	then	the	patient's	details	can	be	entered	later.		To	do
this	Right	click	on	the	temporary	appointment	and	select
register	from	the	drop-down	menu.

	
	
	

Click	to	enlarge
	

A	match	might	occur	for	a	new	patient	with	a	patient	already



in	the	database	if	there	is	a	large	number	of	patients.	
(e.g	John	Smith)
The	match	might	not	be	correct	so	instead	click	"Add	New"
from	the	patient	search	form.

	

Click	to	enlarge
	

3.		Clicking	the	"Add	New"	button	will	open	the	patient	registration
screen.

	

Click	to	enlarge

	
	

See	Also	

Patient:	Modifying	a	Patient	|	Patient	Search	|	Family	Search
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To	modify	a	patient's	details,	click	on	Details	(F2)	under	the
Administration	section	of	the	Navigator	in	the	Clinical	Profile	form.

Click	on	the		"Clinical	Profile"	link	to	find	out	more	about	using	this
functionality	in	GPComplete.

	

	

See	Also	

Patient:	Add	New	Patient	|	Patient	Search	|	Family	Search
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To	search	for	a	patient,	on	the	main	menu	click	on	patient	and	then
search	patient.

	

A	search	form	will	be	displayed	to	you.	You	can	search	for	patients
from	this	screen	by	typing	any	combination	of	

name

medicare	number	

date	of	birth

patient	number

Patient	number	is	an	automatically	generated	number	during	patient
registration	which	is	displayed	on	the	top	in	a	patient's	clinical	profile.
You	can	make	also	make	use	of	wildcard	characters	when	searching.

	

The	"Temp"	button	is	disabled	when	you	have	opened	the	search
from	the	menu.	If	the	patient	search	screen	is	opened	from
Appointment	screen,	then	the	"Temp"	button	is	available	for	creating	a
temporary	patient	appointment.

Click	to	enlarge

	

If	your	search	matched	any	records,	then	the	patients	will	be
displayed	in	the	grid	below.

Click	to	enlarge

	

You	can	hit	enter	on	any	searched	record.	This	action	will	take	you	to

Patient	Search



the	clinical	profile	of	the	patient	if	you	have	opened	the	search	form
from	the	menu.	Otherwise,	if	the	form	was	opened	from	appointment
screen,	then	the	selected	patient's	appointment	will	be	created.



Options
1.	 Include	Deceased	Patient	-	Setting	this	option	will

include	patients	who	are	marked	as	deceased.

2.	 Include	Inactive	Patient	-	Setting	this	option	will	include	in
the	search	results	patients	who	have	been	marked	as
inactive.	If	this	option	is	switched	off,	the	search	results	will
output	only	those	patients	who	are	currently	active.

	



Context	Menu	Options
If	you	right	click	on	any	searched	patient	(the	search	form	being
opened	from	the	main	menu),	a	context	menu	will	popup.

	

Future	Appointments

Bills	Outstanding

Write	Letter

See	Also	

Patient:	Add	New	Patient	|	Modifying	a	Patient	|	Family	Search
Appointment:	Adding	Appointment
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To	search	for	families	in	the	system,	on	the	main	menu	click
on	patient	and	then	search	family.	Family	search	can	also	be	opened
from	the	patient	registration	screen	when	you	want	to	include	the
patient	in	an	existing	family.

	

A	search	form	will	be	displayed	to	you.	
You	can	search	for	families	from	this	screen	by	typing	any
combination	of	

family	name

patient	name

medicare	number

	

	You	can	also	use	the	wildcard	characters	when	searching.

Click	to	enlarge

	

If	your	search	matched	any	records,	then	the	families	will	be
displayed	in	the	grid	below.

Click	to	enlarge

	
Click	the	"+"	sign	to	expand	and	view	the	family	members	in	the
family.	The	head	of	the	family	is	shown	in	blue	color.	You	can	hit	enter
on	any	searched	record	if	the	family	search	is	opened	from	the
patient	registration	screen.	This	will	include	the	patient	being
registered	to	the	selected	family.
	

Family	Search



Context	Menu	Options
If	you	right	click	on	any	searched	family	a	context	menu	will	popup.

Make	Head

Cut	/	Paste

You	can	also	drag	and	drop	the	family	members	from	one	family	to
other	with	the	help	of	the	mouse.	

See	Also	

Patient:	Add	New	Patient
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To	open	a	patient's	Clinical	Profile	
	

1.	 Double	click	the	name	on	the	Appointment	screen
	

2.	 Right	click	and	select	Clinical	Profile

3.	 Search	thru	the	
Main	Menu

Patient>	Search	Patient

Select	the	patient	from	the	grid	by	scrolling	down	with	the
arrow	key	and	hitting	enter	or	double	click	on	the	name	

		
	Click	on	Clinical	Profile	to	view	the	help	files.
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Clinical	Profile	Screen



The	Clinical	Profile
	

The	Patient's	Medical	Records	are	grouped	in	three	categories

Information	-

Demographic	information

Family	Members

Recalls	Reminders	and	Warnings

Bills	and	Appointments

Medical	Records

New	Notes

Old	Notes

Measurements

Current	Rx

Past	Rx

Obstetric	(IF	female)

Immunizations

Allergies

Medical	History

Family	History

Tobacco/Alcohol

Occupation/Social

Referral/Request

Summary

Tests	/	Reports

RESULTS



Pap	smear

Pathology	Request

Imaging	Request

Correspondence

Devices

	

The	Clinical	Profile	Screen	is	resizable	and	can	fill	the
entire	screen.

	The	system	remembers	the	size	of	the	last	window
closed.	



The	Navigator
The	Navigation	pane	to	the	left	has	a	drop	down	tree	which	contains
all	the	different	nodes.

Which	nodes	are	seen	by	which	users	depends	on	what	privileges
have	been	assigned	to	that	user	by	the	administrator	of	the	system.
For	example	a	doctor	will	see	more	nodes	than	a	receptionist.

When	you	click	on	any	one	of	the	nodes,	the	respective	screen	is
displayed	on	the	right	hand	side.	

Go	to	user	preferences	to	select	which	node	you	prefer	the	screen	to
display	when	the	Clinical	Profile	Screen	is	opened.	

	



The	Header
Show	All

The	header	of	the	clinical	profile	displays	basic	patient
information	including	the	patient	name,	the	patient	number,	date	of
birth	and	the	head	of	the	family	if	the	patient	belongs	to	a	family.

Patient	Due	and	Family	Due

It	displays	the	amount	due	to	the	practice	together	with	the	total
family	balance.	If	you	click	on	the	patient	due	or	the	family	due,	the
system	will	display	the	outstanding	report.

	

Timer	and	DNA	(Did	Not	Arrive)	count

The	top	right	corner	of	the	clinical	profile	has	a	timer	which	is
automatically	started	when	you	open	the	clinical	profile.	You	can
pause	and	restart	the	timer	with	the	help	of	the	blue	button	below	the
timer.	The	DNA	counter	shows	the	ratio	of	the	number	of
appointments	where	the	patient	did	not	show	up	to	the	total	number
of	appointments	for	the	patient	to	date.

	

Allergy	Text

Allergies	if	any	are	displayed	in	red	on	the	top	bar.	Point	the	mouse
on	the	text	and	it	will	scroll	to	the	end.

	 	

Show	Active	/	Inactive	Drop	Down

This	drop	down	is	used	to	filter	the	records	on	the	basis	of	their	active
and	inactive	status.	For	example	if	you	click	on	recall,	the	records
have	a	property	called	active.	Depending	on	the	value	of	the	drop
down,	the	records	will	be	filtered.
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Not	all	the	nodes	of	the	clinical	profile	are	associated	with	this	drop
down.	Only	records	which	can	be	made	active	or	inactive	is	affected
by	the	status	of	this	drop	down.	

Blood	Group

The	blood	group	can	only	be	displayed	if	a	the	value	has
been	imported	into	the	system	from	a	recognized	pathology	provider.	

If	the	blood	group	is	RH	negative,	then	the	value	is	displayed
in	green	to	emphasize	it's	importance	during	antenatal	care.

	

javascript:HSToggleSection('{5FAAD88B-E91D-487A-8965-22EA83B83694}')


	
The	following	list	provides	various	nodes	available	for	you	depending
on	your	login	privileges.
	

Details	-	The	basic	details	of	the	patient

1.	 Other	Details	-	Other	information	relating	to	the	patient

Family	Members	-	List	of	family	members	of	the	patient

Appointments	-	List	of	all	appointments	of	the	patient

Recalls	-	List	of	all	recalls	of	the	patient

Bills	-	List	of	all	bills	of	the	patient

New	Notes-	The	main	gateway	to	entering	notes	in	the	EHR

1.	 System	notes

2.	 Problem	oriented	notes

Old	Notes-List	of	all	old	notes	of	the	patient

Summary	-	Medical	Summary	of	the	patient

Current	Rx	-	Displays	the	current	medication	of	the	patient

Past	Rx	-	Displays	the	previous	medications	of	the	patient

Obstetric	-	Obstetric	details	of	the	patient	(	Only	for	female	patients	)

Immunisations	-	List	of	immunisations	given	to	the	patient

Allergies	-	List	of	allergies	of	the	patient

Medical	History	-	Medical	history	records	of	the	patient

Family	History	-	Family	history	records	of	the	patient

Tobacco	/	Alcohol	-	Tobacco	and	alcohol	consumption	of	the	patient

Occupation	/	Social	-	Occupation	and	social	history	of	the	patient

Path.	Request	-	Displays	the	screen	where	you	can	issue	pathology
requests	for	the	patient



Path.	Results	-	Displays	all	the	pathology	results	linked	with	the
patient

Path.	History	-	List	of	previous	pathology	requests	issued	to	the
patient

Rad.	Request	-	Displays	the	screen	where	you	can	issue	radiology
requests	for	the	patient

Rad.	History	-	List	of	previous	radiology	requests	issued	to	the	patient

Correspondence	-	List	of	all	correspondence	with	the	patient

Pap	smear		-	Lists	a	record	of	pap	smears	for	female	patients	12yrs
or	older.

	

Changes	within	a	node	will	set	the	node's	colour	to	red.

The	currently	selected	node	is	always	highlighted	in	the	node
selector.
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Bills



Bills	
This	screen	displays	all	the	bills	for	the	patient.

Click	to	enlarge

		

By	R	clicking	on	a	bill	in	the	grid	a	context	menu	will	pop	up	to	give
the	option	of	either	viewing	the	bill	or	printing	the	bill.	

or		

Double	click	the	bill	

or		

hit	enter	on	any	one	bill	in	the	grid	to	view	the	bill	details.

	

Click	to	enlarge

	



Appointments
The	list	of	all	the	patient's	appointments	are	displayed	in	this	screen.

	

Click	to	enlarge

	

The	appointments	are	displayed	in	quarterly	groups	on	the	grid.

Appointments	for	the	current	date	are	displayed	in	blue.

Future	appointments	of	the	patient	are	not	displayed	on	this	grid.	To
view	future	appointments	please	take	a	look	at	Appointment	Search.

If	you	double	click	or	hit	enter	on	any	one	of	the	appointments	then
the	details	will	be	displayed.		
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The	recalls	screen	will	display	the	list	of	all	recalls	for	the	patient.
	
Right	Click	on	a	recall	to	view	a	sub-menu
	

Add

Add	action

Edit/view

Delete	recalls

	
	
	

Click	to	enlarge

		

Recalls



Add
Select	add	then	click	an	option	from	the	favourites	list.

To	add	a	new	favourite	click	on	Add	Favourites.

Click	to	enlarge

	

The	mandatory	fields	while	saving	a	new	recall	are	the	recall	reason
and	the	due	date.	Due	date	cannot	be	earlier	than	current	date.	You
can	select	the	date	with	the	help	of	the	date	drop	down	or	type	in	a
number	in	the	'after'	text	box	and	select	days,	weeks,	months	or	years
from	the	drop	down	to	populate	the	due	date.	Click	on	save	after	you
have	made	your	changes.	The	recall	will	not	be	ticked	as	visited
unless	you	manually	do	so.

Marking	a	recall	as	visited	can	be	achieved	in	two	ways.	You	can	click
on	the	visited	column	in	the	grid	to	mark	the	recall	as	visited.	Once
you	mark	a	recall	as	visited,	you	will	not	be	able	to	edit	the	recall.
Secondly,	if	a	patient	has	a	recall	which	is	not	visited,	and	you	try	to
open	the	patient's	clinical	profile,	the	software	will	message	you
whether	you	want	to	mark	the	recall	as	visited.	If	the	patient	has	more
than	one	recall	which	has	not	visited,	then	the	list	of	recalls	which	are
not	visited	will	be	shown	to	you	in	a	grid.	Please	check	the	recalls	you
want	to	mark	as	visited	and	click	on	save.



Add	Action
To	add	an	action	to	a	recall,	right	click	and	select	Add	Action.		
This	will	attachs	an	action	to	the	recall	and	also	insert	a	log	in	the
medical	records	with	the	staff	member's	name,	date	and	time	stamp.	

Click	to	enlarge



Edit/View	
To	edit	a	recall,	right	click	on	the	grid	and	select	edit/view.	You	cannot
edit	a	visited	recall	but	you	can	view	the	details.	If	the	recall	is	not
visited	then	you	can	make	changes	to	the	recall	and	update	the	data.

Click	to	enlarge



Delete
If	you	have	the	privileges,	then	you	will	be	able	to	delete	recalls.	Right
click	on	the	recall	record	and	select	delete.
The	software	will	prompt	for	confirmation	before	deleting	the	recall.

Click	to	enlarge
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The	Family	Members	-	all	the	family	members	are	listed

	

open	their	Clinical	Profile	by

	

double	clicking	on	their	name

scroll	down	with	the	down	arrow	and	hit	enter

	

The	head	of	a	family	appears	in	blue.
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Details



	Details
The	details	screen	displays	the	basic	details	of	a	patient.	You	can
modify	the	details	in	this	screen	and	click	save.

	

Tab	to

Details

Other	Details

Health	Funds

	

This	screen	is	used	to	view	or	modify	a	patient	details.	

	

Click	to	enlarge

	



Other	Details
	

Click	to	enlarge

	

The	remaining	details	of	the	patient	are	displayed	in	this	screen.

The	patient's	blood	group	cannot	be	directly	entered	into	the	patient's
details.		This	is	a	restricted	system	function	that	imports	the	result
directly	from	a	valid	pathology	result.

The	pension	status	cannot	be	set	to	Full	DVA	or	Partial	DVA	unless	a
valid	DVA	number	is	provided.

	



Health	Funds
	

Click	to	enlarge

	

R	Click	on	the	relevant	fund	in	the	list

	

Complete	the	details	for	the	Health	Fund	Record

	

Go	to	IMC	to	learn	how	to	submit	claims	to	Medicare	Australia	.
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Medical	Records



Tracking	actions
	
The	software	will	track	actions	in	the	encounter	notes	by	creating	a
written	flag.
	

Obstetric	notes	additions

Creation	of	a	recall

Creation	of	a	pathology	request

Creation	of	a	radiology	request

Prescriptions	that	are	added,	deleted	or	repeated.	

	

This	feature	can	be	turned	off	by	unchecking	the	boxes	in	User
Preferences

	

Problem	Oriented	Notes
	

The	software	will	attach	these	actions	and	relate	them	to
different	Problems	in	the	one	consultation

if

the	User	Preference	setting	option	Use	Multiple	Problem	Related
Notes	is	checked	on.
	

	
Click	to	enlarge
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New	Notes



Writing	new	notes
	

Use	Rich	Text	Formating	to	enhance	the	appearance	of	your
notes

View	your	Old	Notes	in	the	same	window	while	entering	your
current	notes.

Save	time	using	the	System	Notes	which	more	closely
mimics	the	way	doctors	write	their	records.	

Use	shortcut	keys	to	insert	AutoTemplates.

Create	Problem	Oriented	Notes	very	quickly	and	simply	in	a
highly	organized	way	with	all	actions	related	to	each	problem
grouped	together	and	made	available	for	re-editing	in	the
one	consultation.	

Access	system	images	and	your	own	images	in	a	flexible
way	that	also	allows	you	to	mark	and	annotate	each	image.

	

Click	to	enlarge
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Spell	check	etc.



Hold	down	the	ALT	key	+	O
	

This	will	provide	a	list	of	formatting	options

	

	

Click	to	enlarge
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Systems	provides	fields	for	recording	notes	in	an	organized	way	for
each	system.
To	open	systems	click	on	the	down	arrow	and	the	tree	will	expand
then	click	on	the	relevant	system	for	which	you	wish	to	enter	data.
	
e.g.	
	

Measurements

Click	to	enlarge

Nervous	system		

Click	to	enlarge

							

Cardiovascular				

History	

Click	to	enlarge

Examination

Click	to	enlarge

							

Respiratory

Systems



History

Click	to	enlarge

Examination

Click	to	enlarge
	

Gastrointestinal					

History

Click	to	enlarge
		
Examination

Click	to	enlarge

				

Genitourinary	

					History			
				
					
					 Click	to	enlarge
					Examination					
				
					
					 Click	to	enlarge
	



Locomotor

History

Click	to	enlarge

Examination

	

Click	to	enlarge

ROM	(Range	of	Movement)-	a	matrix	of	descriptions	for	all	joints
provides	the	relevant	ROM	values

	

Click	to	enlarge
							
						

Lymphatic

Click	to	enlarge

							

Breast	

History

Click	to	enlarge

Examination.	Breast	lumps	can	also	be	added	by	selecting	Add.



Click	to	enlarge
				

							
										

Skin

							
							 Click	to	enlarge

ENT

History

Click	to	enlarge

Examination

Click	to	enlarge

							
			
									

Eyes

History

Click	to	enlarge

Examination



Click	to	enlarge
Mental	Health

History

Click	to	enlarge

Mental	Health	Examination

Click	to	enlarge
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Problem	Oriented	Notes



Add	a	problem	to	the	notes
	

Click	to	enlarge
	
	
To	add	a	second	problem	after	adding	notes	about	the	first	problem
just	click	Problem	once	again
	
You'll	be	prompted	whether	or	not	to	add	New	Notes
Answering	Yes	will	create	a	fresh	entry
Answering	No	will	append	the	second	problem	to	the	first	problem
	

Click	to	enlarge
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Old	Notes



Viewing	Old	Notes
Old	notes	he	clinical	profile	screen	has	three	panes.

The	left	pane	contains	the	three	headings	of	Administration,	Medical
Records	&	Test/Reports.

The	middle	pane	lists	in	sequence	the	date/doctor/activity
status/diagnosis	of	all	the	consultations.

The	right	pane	records	in	verbose	form	all	the	actual	encounter	notes,
examination	findings,	diagnoses	and	plans	for	each	individual
consultation	recorded	by	all	doctors	that	have	seen	the	patient.	

Encounter	notes	can	be	selectively	viewed	by	clicking	on	a
particular	date	in	the	central	pane.	Click	on	the	'Show	All'	button	at
the	bottom	of	the	clinical	profile	to	show	all	the	encounter	notes.	



	

Filtering	Problems	in	Old	Notes
	



Annotation	of	Old	Notes
Notes	taken	prior	to	today	cannot	be	edited	but	the	can	be
annotated.	

	

Right	click	on	the	date	relevant	to	the	notes	you	wish	to	annotate	and
select	edit.

An	Annotation	box	will	come	into	view	and	this	will	make	an	entry	in
the	notes	stamping	the	name	of	the	user	and	date	and	time	of	the
annotation.

	

Click	to	enlarge
	

Click	to	enlarge

	

	

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Summary


	

The	summary	screen	displays	the	patient's	medical	summary.	Click
on	Summary	in	the	Medical	Records	tree	or	use	a	Hotkey.	(Ctrl	+	S)

	

The	summary	contains	the	patient's	medical	history,	family	history,
current	medication,	allergies	and	tobacco	/	alcohol	data.	If	you	click
on	the	links	on	the	top	of	the	summary	sheet,	then	the	appropriate
summary	will	be	scrolled	into	view.	The	summary	sheet	can	be
printed	of	with	the	print	button	located	on	the	bottom	of	the	clinical
profile.	It	is	the	snapshot	of	the	patient's	medical	data	which	is	useful
for	doctors.
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The	obstetric	node	in	the	clinical	profile	will	only	be	visible	if	you
have	authorization	for	it	and	the	patient	is	a	female	over	11	years
of	age.
	

Click	to	enlarge

	

This	screen	consists	of	a	grid	at	the	top	which	shows	the	obstetric
history	of	the	patient.
	
An	active	pregnancy	is	in	a	RED	colour	at	the	top	of	the	grid.
Past	pregnancies	are	in	BLACK	and	they	follow	underneath.
	
Brief	pathology	results	and	ultrasound	reports	can	be	entered	into
this	form.	
	
The	progressive	antenatal	notes	of	the	patient	will	fill	the	grid
underneath	if	an	active	pregnancy	is	selected	on	the	grid	at	the
top.	

Obstetric



Context	Menu	in	Obstetric
	
	
Add	new	pregnancy
	
Entering	the	LNMP	will	add	a	new	pregnancy	for	the	patient.
This	data	can	be	edited	again	at	a	later	date	if	the	information
needs	to	be	revised.	Once	this	information	is	saved,	you	can	then
begin	adding	pregnancy	notes.
	
Scan	date	–	You	can	input	a	scan	date	in	a	situation	whereby	the
LNMP	is	unknown	and	the	system	will	calculate	an	EDC	by	scan.
If	you	check	the	‘Use	scan	date	for	EDC’	then	the	gestation	in	the
pregnancy	notes	will	be	calculated	based	on	the	scan	EDC.
	

	
Add	pregnancy	notes
	
After	the	system	creates	a	new	pregnancy	then	sequential	antenatal
notes	can	be	recorded	by	opening	a	new	form.	To	do	this	R	click
the	active	pregnancy	record	which	is	now	in	RED.
	

	
click	on	add	notes	and	this	next	form	will	appear.
	
	

Click	to	enlarge
	
Enter	your	antenatal	notes	in	this	form	and	then	click	save.	This	is



done	for	each	visit.	The	middle	grid	will	be	sequentially	filled	with
the	records	of	each	attendence.
	

	
	
Complete	a	pregnancy
	
Once	the	lady	has	her	baby,	the	pregnancy	can	be	marked
"completed"	by	R	clicking	the	grid	and	marking	complete.		
	

	
When	the	completed	option	is	selected	another	form	comes	into	view
and	this	provides	a	place	where	details	of	the	confinement	can	be
entered,	including	basic	details	for	the	baby	(babies).
	

Click	to	enlarge
	

Marking	a	pregnancy	complete	cannot	be	undone	and	no	more
records	will	be	allowed	to	be	added	to	that	pregnancy	after	it	is
completed.
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You	can	store	the	patient's	occupational	and	social	history	in	this
screen.
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Data	can	be	stored	regarding:-	

tobacco

alcohol	consumption

substance	abuse

	

Click	to	enlarge

	
The	patient's	summary	will	carry	information	stored	here	concerning
tobacco	and	alcohol	useage.
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Adding	/	Updating	Medical	History
The	medical	history	screen	lists	the	medical	history	records	of	the
patient.

Click	to	enlarge

Right	click	to	add,	edit	or	delete	medical	history	records.

A	new	form	will	be	displayed	when	you	select	Add.	
In	this	situation,	CABG	x	3	has	been	recorded	at	age	91	years.

	

If	you	select	an	exact	date	the	year	and	age	of	the	patient	will
automatically	populate	the	rest	of	the	fields	when	you	hit	the	tab	key.	
If	you	do	not	know	the	date,	then	you	can	enter	the	year	or	the	age	of
the	patient	instead.	

Any	existing	medical	conditions	already	recorded	in	the	medical
history	will	be	listed	over	on	the	right	hand	side	of	the	form.

Previous	medical	conditions	can	be	modified	from	this	screen.	
If	you	double	click	on	any	record	from	the	clinical	profile	screen	of	the
medical	history	or	select	edit/view	from	the	context	menu,	then	you
will	be	able	to	update	that	particular	medical	history	record.

	

Click	to	enlarge

Medical	History



Deleting	Medical	History
You	can	delete	medical	records	only	if	you	have	permission.	

Right	click	on	the	record	and	select	delete.	The	software	will	ask	for
confirmation	before	deleting	the	record.
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The	family	history	screen	lists	the	family	history	records	of	the	patient.

Click	to	enlarge
	

Family	history	works	in	a	similar	way	to	medical	history.

If	the	patient	is	adopted,	then	this	information	will	be	displayed	on	top.

Family	History



Adding	/	Updating	Family	History
Right	click	on	the	grid	and	from	the	context	menu	click	on	add.

	

	

A	new	form	will	be	displayed	to	you	where	you	can	add	a	new	record.

Click	to	enlarge

	

The	existing	family	history	conditions	will	be	displayed	to	you	on	the
right	hand	side.	You	can	modify	previous	conditions	from	this	screen.
When	you	click	on	any	previous	condition,	the	details	will	get
populated.	If	you	want	to	add	a	new	record	instead,	click	on	the	clear
button	first.

If	you	double	click	on	any	record	from	the	clinical	profile	screen	of	the
family	history	or	select	edit/view	from	the	context	menu,	then	you	will
be	able	to	update	only	that	particular	family	history	record.	Previous
conditions	will	not	be	shown	on	the	right	hand	side.

Click	to	enlarge



Deleting	Family	History
You	can	delete	a	family	history	record	if	you	are	authorized	to	do	so.
Right	click	on	the	record	and	select	delete.	The	software	will	ask	for
confirmation	before	deleting	the	record.
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The	allergy	node	displays	the	allergy	information	of	the	patient.
	

	
To	add	an	allergy	right	click	on	the	grid	and	select	add.	This	will
open	a	window	where	you	can	search	for	the	drug.	
	

	

You	can	either	search	allergy	by	drug	name	or	by	class.	Searching
by	drug	name	will	give	a	list	of	drugs	while	searching	by	class	will
give	a	list	of	substance	class.	Search	for	a	drug	by	typing	in	a	part
of	the	name	or	class.	Double	click	the	drug.
You	can	assign	allergy	in	three	ways.

	trade	name

	generic

	class
	

	

Assigning	Allergy	

	

Allergies



1.	 Trade	name	-	Assigning	allergy	to	a	particular	trade	name
will	give	a	warning	about	the	allergy	during	prescribing
only	for	that	particular	brand.	

2.	 Generic	-	Assigning	an	allergy	to	a	particular	generic	drug
will	give	a	warning	only	while	prescribing	that	particular
generic	drug.		Other	salts	of	that	drug	will	not	be	flagged
in	the	warning.	

3.	 Class	-	Assigning	allergy	to	a	class	will	give	the	widest
interaction	warning	as	it	will	interact	with	the	particular
generic	drug	and	all	generics	in	the	same	substance	class.
Where	ever	possible	PMSC	recommends	selecting	Class
for	an	allergy.
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The	immunisations	screen	displays	the	list	of	vaccines	allocated	for	a
patient.	This	screen	might	also	contain	an	immunisation	plan.

	

The	diagram	below	shows	a	patient	immunisation	screen	without	a
plan.

Immunisations



Adding	a	Vaccine
To	add	a	vaccine	for	the	patient,	right	click	on	the	grid	and	select	add
other	from	the	context	menu.	The	vaccination	form	will	now	be
displayed	on	the	screen.

	

Select	a	vaccine	from	the	drop	down,	make	changes	as	necessary
and	click	on	save.	The	vaccine	will	be	added	to	the	list	of	patient
immunisations.



Adding	a	Plan
To	add	a	care	plan	for	a	patient,	right	click	on	the	field	and	select	add
plan.	Care	plans	are	available	only	for	infants	depending	on	their	age.
A	form	is	displayed	to	you	from	where	you	can	select	the	vaccination
plan.

	

The	immunisation	screen	with	a	care	plan	included	will	look	like	the
screen	below.

Click	to	enlarge

	
The	vaccines	which	are	overdue	will	be	displayed	in	red.



Editing	a	Vaccine
You	can	edit	any	vaccine	as	long	as	its	status	is	not	completed.	As
soon	as	the	vaccine	status	is	updated	to	be	completed,	then	only	the
user	who	has	added	the	vaccine	or	a	system	administrator	can	edit	its
details.



Deleting	a	Vaccine
Only	the	system	administrators	can	delete	a	vaccine.	If	a	vaccine	is
part	of	a	care	plan	and	the	administrator	deletes	that	vaccine,	then
the	whole	care	plan	will	be	deleted.	The	system	will	ask	for
confirmation	before	deleting	any	vaccine.	To	delete	a	vaccine,	right
click	on	the	record	and	select	delete.
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Click	to	enlarge
	
Past	Rx	screen	lists	all	previous	medications.	
	
R	clicking	on	a	drug	in	the	list	will	allow	a	user	to	delete	a	past
Rx,	or	re-prescribe	a	past	Rx	if	it	is	not	already	in	the	current	Rx
screen.
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The	current	Rx	node	of	the	clinical	profile	allows	a	doctor	to	create
prescriptions	for	the	patient.	Only	doctors	are	authorized	to	prescribe
medications.	The	doctor	must	have	a	prescriber	number	saved	in
the	staff	details	before	the	system	will	allow	prescriptions.

	

Click	to	enlarge

	

Current	Rx



Context	Menu	Options	for	Current	Rx	(R	click	on
any	drug	in	the	list)
	

	

Add	Item
Prescribe	a	drug	to	the	patient.	For	details	see	Adding	Current	Rx

	
Delete
Delete	a	drug	from	patient’s	current	Rx.
	
Alternative
Show	alternative	for	the	selected	drug.
	
Select/deselect
Mark	the	selected	drug	for	prescribing	in	the	current	visit.
	
Change	Dose
Change	the	dosage	information	of	the	drug.
	
Change	PBS	Category
Change	the	PBS	category	for	the	prescription.
	
Change	Qty
Change	the	quantity	prescribed.
	
Reg	24
Mark	the	drug	for	regulation	24.
	
Detail



This	will	show	the	details	about	the	drug,	like	PBS	info,	price	info,
indications,	contra-indications,	authority	indication	etc.
	
CMI
CMI	is	the	consumer	medicine	information.	This	might	not	be
available	for	some	of	the	drugs
	
PI
PI	is	the	product	information	about	the	drug.	This	might	not	be
available	for	some	of	the	drugs.
	



Adding	Current	Rx
	
To	prescribe	a	new	medicine	to	the	patient	right	click	on	current
Rx	screen	and	select	add	item	from	the	context	menu.	This	will
open	a	drug	search	window.	Type	the	first	few	letters	of	the	drug
you	want	to	prescribe	and	hit	search.	This	will	give	you	a	list	of
drugs	and	their	details.	For	more	details	about	drug	search	click
here.
	

	
	
Double-click	the	drug	you	want	to	prescribe	from	the	list.		This
will	open	another	window	where	you	can	specify	the	dosage	etc.
for	the	drug.
	

Click	to	enlarge
	
	
Here	you	need	to	specify	dosage,	frequency	and	instruction.	None
of	this	is	mandatory.	This	window	also	has	a	check	box	"Save	as
default	dose".	If	this	is	checked	it	will	save	the	dosage,	frequency
and	instruction	for	that	drug	so	that	if	the	same	medicine	is
prescribed	again	by	the	same	user	these	will	be	pre-filled	with	the
values.
	
The	“Other”	button	lets	you	specify	custom	instruction	for	the
drug.	Clicking	the	other	button	will	open	another	form.	For	more
detail	about	custom	instructions	click	here.
	
At	the	bottom	there	are	three	buttons	“Regular”	“Once	Only”	and



“Cancel”.	If	"Regular"	is	selected	then	the	drug	will	be	added	to
the	list	of	regular	medications	and	will	stay	in	the	current	Rx
screen.	
"Once	only"	will	prescribe	the	drug	for	the	patient	only	for	this
visit	and	therefore	the	drug	will	not	stay	in	the	Current	Rx	list	of
regular	medications.	Selecting	cancel	will	cancel	prescribing	this
medicine.
	
While	prescribing	the	medicine	the	software	may	give	warnings
for	allergy,	interactions	with	other	drugs,	pregnancy,	sports.
The	doctor	can	decide	not	to	prescribe	the	drug	when	any	such
warnings	might	occur.	
	



Drug	Search

Click	to	enlarge
	
To	search	a	drug,	enter	the	first	few	letters	of	the	drug	and	hit
enter.	Alternatively	you	can	search	a	drug	by	class.	When	you
click	search	by	class	it	will	open	a	box	on	the	left	side	with	a	list	of
classes	of	drugs.	Besides	the	name	of	the	class	there	are	+	signs
which	when	clicked	will	open	the	sub	classes	within	that	class.	If
you	click	on	a	subclass	you	will	see	the	list	of	drugs	in	that
subclass	on	the	right	side.
	

Click	to	enlarge
	
The	drugs	list	come	in	different	colors	depending	upon	the	PBS
type	of	the	drug.	The	legend	of	colors	is	shown	at	the	bottom	of
the	drug	search	screen.
	
Drug	search	context	menu
	

																																															
						

Click	to	enlarge
	
In	this	example,	the	search	for	Elocon	reveals,	blue	=PBS,	green
=DVA

	
Prescribe
Prescribe	is	same	as	double	clicking	an	item.	For	details	go	to



Adding	Current	Rx.	
	
Add	to	fav
This	will	add	a	drug	to	your	favorites	list.	You	can	retrieve	your
favorites	list	by	using	the	“Favorites”	button	in	the	drug	search.
	
Details
This	will	show	the	details	about	the	drug,	like	PBS	info,	price	info,
indications,	contra-indications,	authority	indication	etc.
	
CMI
CMI	is	the	consumer	medicine	information.	This	might	not	be
available	for	some	of	the	drugs
	
PI
PI	is	the	product	information	about	the	drug.	This	might	not	be
available	for	some	of	the	drugs.
	



Customized	Instructions
	
Clicking	the	"other"	button	on	the	dosage	screen	will	open	the
custom	instruction	screen.
	

Click	to	enlarge
	
Here	you	can	type	a	custom	instruction.	Optionally	you	can	also
check	the	“Save	New”.	If	you	check	“Save	New”	you	must	give	a
name	to	the	instruction	in	the	box	below.
	
Once	you	save	it	with	save	new	checked,	the	next	time	you	open
the	custom	instruction	again	it	will	have	the	previous	saved	items
on	the	left	side.	You	can	click	on	them	and	it	will	fill	the
instructions	associated	with	the	selection.	You	can	then	change	the
instructions	if	you	wish	and	if	you	want	to	see	the	changed
instructions	next	time	for	the	selected	item	then	check	“Update”.
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Click	Resources>Own	Rx

A	doctor	can	create	their	own	user	defined	drug	recipes.

This	might	be	useful	for	topical	preparations	or	herbal	and	alternative
medicines.

	When	using	this	tool	the	system	has	the	ability	to	assign	the	new
recipe	to	a	substance	class	to	cross	check	for	drug	interactions.

	

Click	to	enlarge
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Devices



Devices
ECG	AND	SPIROMETRY
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Correspondence



The	correspondence	node
	
This	screen	displays	the	correspondence	list	with	the	patient.
	
The	options	for	the	display	of	correspondence	can	be	selected.

Sent

Received

All

	



New	data	entry
	

R	click	on	the	grid	to	view	and	select	an	option	from	the	context	menu
to	enter	new	correspondence	record.
	
A	new	entry	can	be	entered	by	selecting
	

Add

Scan

Store	file

Write	letter

	
	

Click	to	enlarge

		



Add
Right	click	on	the	grid	and	select	add	from	the	context	menu	to	add	a
new	correspondence.	A	new	form	will	be	displayed	to	you	where	you
can	add	the	correspondence.

	

Click	to	enlarge

	

Select	the	correspondence	type	from	the	drop	down.	Add	the	subject
and	notes	if	required	and	click	on	save.	The	new	correspondence	will
be	added	to	the	grid.



Scan
Select	scan	to	scan	a	document	into	correspondence.	Click	on	the
link.



Store	File
You	can	store	files	for	a	patient	with	the	help	of	the	store	file	menu.

After	you	click	on	store	file,	you	will	have	to	select	the	file	to	store
from	the	file	browser	which	is	displayed.

	

Double	click	the	file	you	want	to	store.

After	you	have	selected	your	file,	then	enter

1.	a	name	

2.	Subject	type

	3.	Date

	

Click	Ok	button	when	you	are	done.

The	file	will	be	stored	on	the	server.

Ensure	the	GP	Service	is	running.	If	GP	Service	is	not	running	then
you	will	not	be	able	to	store	files.



Editing	a	Correspondence
To	edit	a	correspondence,	right	click	on	the	record	you	want	to	edit.
This	will	display	the	correspondence	form	where	you	can	make
changes.	If	the	record	is	a	file	which	you	have	stored	then	double
clicking	will	open	the	file.



Editing	the	subject	of	a	Correspondence
The	edit	subject	menu	will	be	enabled	only	for	records	which	are	type
of	a	file.



Deleting	a	Correspondence
Select	delete	from	the	context	menu	to	delete	the	correspondence.
The	software	will	ask	for	confirmation	before	deleting	the
correspondence.	If	the	correspondence	is	type	of	a	file	then	the	file
will	be	deleted	from	the	server.		



Write	Letter
On	the	main	menu	Go	to	Resources	>	Letter	writer	or	click	on	Letter
Writer	in	Correspondence.

	

	

Click	to	enlarge

Here	you	can	create	letters	or	create	templates	by	dragging	and
dropping	fields	from	the	Template	field.

To	create	a	letter	template,	select	File>	New	>	Blank	Template

Click	to	enlarge

After	completing	the	template	go	to	File	>	Save	as	Template

A	grid	will	be	displayed	to	you	with	the	list	of	templates	present	in	the
system.

Type	in	a	name	for	your	template	and	click	on	save.
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This	screen	displays	the	list	of	radiology	requests	which	have	been
previously	issued	to	the	patient.	You	cannot	make	any	changes	to	the
previous	radiology	requests.	You	can	print	previous	radiology
requests	from	this	screen.	To	print	a	previous	request,	select	the
record	on	the	grid	and	click	on	the	print	button	at	the	bottom	of	the
clinical	profile	screen.

Click	to	enlarge
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The	radiology	request	screen	helps	doctors	to	issue	radiology
requests.	You	will	need	to	have	a	valid	provider	and	a	prescriber
number	saved	in	your	staff	details	before	you	can	issue	a	radiology
request.	The	radiology	request	screen	is	similar	to	the	pathology
request	screen.

Click	to	enlarge

Radiology	Request



							Steps	to	issue	a	radiology	request
1.	 Select	the	radiology	-		From	the	drop	down	select	the

radiology	you	want	to	issue	the	request	to.	The	default
radiology	will	be	pre-selected.

2.	 Choose	a	favorite	-	If	you	have	saved	your	radiology
favorites,	you	can	select	the	favorite	here	if	you	want.	

3.	 Type	the	notes	-	Please	enter	any	notes	you	want	which	will
be	displayed	in	the	notes	text	box	of	the	radiology	request
form.

4.	 Select	required	tests	-	The	various	requests	or	tests
available	for	you	to	select	will	be	displayed	on	the	requests
available	grid.	You	will	have	to	select	the	required	tests	and
put	them	in	the	selected	requests	grid	on	the	right.	You	can
select	requests	in	two	ways.	You	can	select	the	request	and
click	on	the	'>'	button	to	move	the	request	to	the	right.	You
can	also	drag	and	drop	the	request	from	left	to	right	grid.
Multi	select	of	requests	are	allowed.	

You	can	also	add	your	own	requests	and	they	will	be	added
to	the	list.

5.	 Fill	Copy	Reports	To	-	Select	contacts	from	your	address
book	to	add	to	this	section.

After	you	have	selected	the	needful,	please	click	on	print	to	print
the	radiology	request.	When	you	click	on	print,	the	request	will	be
automatically	saved.	If	you	do	not	want	to	print,	but	want	to	save
the	request	for	later	use,	then	click	on	save.	You	can	view
radiology	history	in	the	clinical	profile	where	the	past	requests	are
saved.

	



How	to	fill	Copy	Reports	To		
Right	click	on	the	grid	and	select	search	from	the	contact	menu.

The	address	book	search	screen	will	be	displayed.	Search	for	the
contact	and	double	click	to	select	the	contact.	You	cannot	add	a
contact	in	radiology	request	where	a	contact	name	is	not	present.

You	can	add	a	new	contact	if	you	like	by	selecting	the	add	new	menu.
A	new	address	book	entry	will	be	created	and	added	in	the	grid.	A
contact	name	will	have	to	be	present	if	you	are	adding	a	contact	from
here.

You	can	also	remove	contacts	already	added	to	the	section	by
selecting	the	remove	menu.
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This	screen	displays	the	list	of	pathology	requests	which	have	been
previously	issued	to	the	patient.	You	cannot	make	any	changes	to	the
previous	pathology	requests.	You	can	print	previous	pathology
requests	from	this	screen.	To	print	a	previous	request,	select	the
record	on	the	grid	and	click	on	the	print	button	at	the	bottom	of	the
clinical	profile	screen.

Click	to	enlarge
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The	list	of	all	pathology	results	assigned	to	the	patient	from	the	Intray
will	be	displayed	in	this	screen.

	

When	you	select	any	record	on	the	grid	above,	the	pitt	data
associated	with	the	result.	if	any,	will	be	displayed	in	the	text	box
below.	You	cannot	modify	the	pitt	data.	When	you	double	click	any
record,	the	pathology	result	form	will	be	displayed.	Please	see	the
pathology	result	section	of	the	intray	for	more	information.	Some	of
the	options	will	will	be	missing	as	this	result	is	already	assigned	to	a
patient.

A	result	marked	with	high	priority	will	be	displayed	in	red	on	the
grid.

	

Viewing	/	Printing	Summarized	Results
You	have	the	option	to	view	and	print	summarized	results.	Use	the
control	and	shift	keys	of	your	keyboard	to	multi	select	the	results	you
want	to	view	and	print	together.	Right	click	on	the	grid	and	select	view
summarized.

A	new	form	will	be	displayed	to	you	where	you	can	print	the	results.

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.

Pathology	Result



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Printing a Pathology Request


	

Click	to	enlarge
	

This	feature	allows	doctors	to	issue	pathology	requests.

a	valid	pathology	laboratory	provider	is	needed

a	valid	doctor	provider	number	is	needed
	

Printing	a	Pathology	Request



Steps	needed	in		printing	a	pathology	request																			
																																																																																																													
						 		
						 Click	to	enlarge

1.	 Select	the	pathology	laboratory	provider	-	Path.	labs	that
have	been	entered	into	the	system	will	be	listed	by	clicking
on	the	down	arrow.	

A	preferred	Pathology	Lab	can	be	set	as	a	default.		This
obviates	the	need	to	select	a	particular	laboratory	each	time
you	need	to	print	a	request.	

					
					 Click	to	enlarge

1.	 Type	the	notes	-	Relevant	clinical	notes	can	be	typed	by
clicking	the	mouse	in	this	box	or	Alt	+	n.

Click	to	enlarge

2.	 Select	required	tests	-	

The	hard	way.

There	are	an	enormous	number	of	tests	stored	in	the	table.
These	tests	can	be	searched	by	either	the	test	code	or	the				
test	description.	Each	test	has	a	code	and	a	lot	of	them	are
not	intuitive.	The	test	description	searches	the	first	few
letters	of	the	test	name.	

Once	a	test(s)	is	selected	it	needs	to	be	placed	in	the



request	box	on	the	right	side	of	the	form	by	either

-	double	clicking
-	checking	the	>	arrow	
-	hitting	the	enter	key	
-	drag	&	drop

The	easy	ways

3.	 You	can	add	your	own	requests	and	they	will	be	added	to
the	list.	

4.	 You	can	choose		pathology	favorites,	then	you	can	select	a
favorite	which	will	then	group	a	collection	of	tests	together.

Select	required	observations	-	Select	the	required
observations	for	the	test	by	ticking	the	observation	records	if
you	want.

5.	 	Copy	Reports	To	-	Select	contacts	from	your	address	book
to	add	to	this	section.

	

After	you	have	created	a	request	then	click	on	print	or	Alt	+	P	to
print	the	pathology	request.	Please	make	sure	you	have	the	right
paper	in	the	printer	before	printing.	When	you	click	on	print,	the
request	will	be	automatically	saved.	If	you	do	not	want	to	print,	but
want	to	save	the	request	for	later	use,	then	click	on	save.	You	can
view	this	request	in	the	pathology	history	in	the	clinical	profile
where	the	past	requests	are	saved	and	re-issue	the	request	again
if	needed.



How	to	send	copies	of	reports	to	other	doctors.
Right	click	on	the	grid	and	select	search	from	the	contact	menu.

The	address	book	search	screen	will	be	displayed.	Search	for	the
contact	and	double	click	to	select	the	contact.	You	cannot	add	a
contact	in	pathology	request	where	a	contact	name	is	not	present.

You	can	add	a	new	contact	if	you	like	by	selecting	the	add	new	menu.
A	new	address	book	entry	will	be	created	and	added	in	the	grid.	A
contact	name	will	have	to	be	present	if	you	are	adding	a	contact	from
here.

You	can	also	remove	contacts	already	added	to	the	section	by
selecting	the	remove	menu.
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Pap	smears	can	be	recorded	for	female	patients	12yrs	or	older.

Previous	records	are	stored	in	the	grid.

New	records	are	added	to	the	Pap	form.

Date	of	the	pap	smear

Pap	smear	result

Check	box	for	Endocervical	cells	&	HPV

Comments	box	to	store	free	text

	

Click	to	enlarge
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Appointment	Prerequisites



Required	Prerequisites:
	
To	create	an	appointment	at	least	one	"undeleted"	doctor	must	be	registered
in	the	system.

	

For	a	doctor	to	be	recognized	by	the	system	they	must	have
a	valid	provider	number.

	

See	Also	

Appointment:	Adding	Appointment	|	Modifying
Appointment	|	Deleting	Appointment	|	Search	Appointment
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	Appointment	Time	interval	can	be	made	specific	to	each	doctor.
	
On	the	main	menu	Click	Staff>	Search	Staff>	(Open	the	Staff
Record).

	
At	the	bottom	left	hand	side	there	is	a	drop	down	box-	“App
Interval”.

	
Select	here	to	change	the	Doctors	preferred	time	interval.
	

Click	to	enlarge
	

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.

Doctor	specific	appointment	time	interval



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Appointment time interval


	
Adjust	the	appointment	time	interval.
	
The	appointment	time	interval	can	be	adjusted	by	clicking
Administration->Settings->Legend.

	
This	is	a	system	wide	setting.
	
The	default	setting	is	10	minutes.
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1/	Click	once	on	a	suitable	time	on	the	appointment	screen.
2/	Type	the	name	of	the	patient	in	the	format	(lastname,	firstname)
or	just	a	few	letters	of	each	of	the	last	name	and	first	name
separated	by	a	comma	-	then	hit	the	enter	key.
	

Hit	"Esc"	to	abort	this	process.	

	
	

Click	to	enlarge
	
	

If	a	matching	patient	is	found	in	the	database,	then	a	list	of	patients
opens	on	the	search	form.	

Select	a	patient	by	:-
	

1/	double	click	the	selected	patient
2/	clicking	once	on	the	selected	patient	and	hit	enter.
3/	scroll	with	the	down	arrow	key	onto	the	selected	patient	and	hit
enter	.	

	
The	appointment	will	be	created	for	the	patient	on	the	appointment
screen.
	

Click	to	enlarge

	

Adding	Appointment



Click	to	enlarge

	

If	the	search	does	not	match	any	patient	in	the	database,	then	the
system	will	prompt	you	to	either	go	ahead	and	register	this	patient
name	as	a	new	patient	or	create	the	appointment	with	a	temporary
patient	name	(a	patient	who	is	not	registered	in	the	system).
	

	

Click	to	enlarge

	

You	can	also	create	a	temporary	patient	appointment	by	clicking	the	“Temp”
button	in	the	Patient	search	screen	if	the	“lastname”	entered	makes	a	match	with
a	patient	already	in	the	database	but	is	not	the	one	you	were	looking	for.

	

Hit	"Esc"	on	the	keyboard	to	cancel	the	addition	of	the	appointment.

	

Adding	an	appointment	is	not	permitted	in	the	Week	View	and	Month
View	mode	of	the	Appointment	Schedule.	For	more	information
please	take	a	look	at	"Appointment	Screen	Features"

	

See	Also	

Appointment:	Modifying	Appointment	|	Deleting	Appointment	|	Search
Appointment
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To	move	an	appointment	-	drag	and	drop	it.	
	

To	increase	the	length	of	an	appointment	-	stretch	it	by	dragging
the	bottom	border.
	
To	change	the	name	of	a	patient,	right	click	on	the	appointment
and	select	from	the	submenu	“Change	Patient”.
	

If	the	appointment	has	been	been	billed	or	receipted	then	it
can't	be	modified	or	moved.	

An	appointment	on	a	previous	date	cannot	be	modified	or	moved.	

	

	

	

Click	to	enlarge

	

	

Context	Menu	Options	in	an	Appointment
	

See	Also	

Appointment:	Adding	Appointment	|	Deleting	Appointment	|	Search
Appointment

	

Modifying	Appointment



	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Deleting


	
Deleting	an	appointment	requires	a	user	to	have
this	permission	which	can	only	be	authorized	by	the	administrator
of	the	system.		
	

	

1/	Click	on	an	appointment	and	hit	the	delete	key.	The	system
will	prompt	you	for	confirmation.
	
2/	R	click	on	an	appointment,	then	select	delete
	
	
	
	

Click	to	enlarge
	
If	you	can't	delete	an	appointment	then	speak	with	the	system
administrator	about	assigning	you	permission	to	do	so.	
	

Appointments	cannot	be	deleted	after	a	certain	amount	of	time
e.g.:	10	minutes.	The	system	administrator	can	change	this	time
interval.	Attempts	to	delete	an	appointment	after	a	set	number	of
minutes	will	be	automatically	given	the	status	“cancelled”
provided	the	appointments	have	not	been	billed	or	receipted.	

This	feature	can	be	turned	off	by	the	system	administrator	if
required.
	

	

Deleting	Appointment



	

For	more	information	about	appointment	delete	setting	see	"System
Preferences".

	

You	cannot	delete	an	appointment	for	a	previous	date.

	

See	Also	

Appointment:	Adding	Appointment	|	Modifying	Appointment	|	Search
Appointment
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Appointment	search	gives	three	options	for	a	patient's	appointment:

all	the	appointments	
just	future	appointments
appointments	within	a	defined	date	range

On	the	main	menu	click	on	appointment	and	then	search.

	

Fill	the	search	form	using	the	options	as	needed	and	the
appointments	will	be	displayed.		
Use	a		wildcard	if	needed.

	

If	your	search	matched	any	records,	then	the	appointments	will	be
displayed	in	the	grid	below.

Click	to	enlarge

	

"Go	to"	the	appointment	by	R	clicking	it	and	selecting	"Go	to".	The
appointment	screen	will	jump	to	the	patients	appointment.

	

See	Also	

Appointment:	Adding	Appointment	|	Modifying
Appointment	|	Deleting	Appointment

	

Search	Appointment
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The	appearance	of	a	waiting	room	on	the	appointment	screen	is
activated	by	a	system	preference.

Administration>	Preferences>	System	Preferences

Click	to	enlarge

The	waiting	room	appears	as	another	column	in	the	appointment	book.

Click	to	enlarge

"Walk	ins"	or	patients	who	come	to	the	practice	without	a	prior
appointment	can	be	added	to	the	waiting	room.

Based	on	the	availability	of	the	doctor	they	are	moved	(Drag	n'	Drop)
from	the	waiting	room	to	the	Doctor’s	column.

The	system	preferences	can	be	set	to	restrain	Doctors	from	moving
patients	from	the	waiting	room.
	

Limitations	of	the	waiting	room.

Patients	can	not	be	billed	from	the	waiting	room

Medicare	Australia	cannot	be	accessed

Patient	Check	cannot	be	performed
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Right	click	a	patient's	Appointment	to	reveal	the	Sub	Context	Menu
	

	

Click	to	enlarge
	

Show	All

Type

Status

RoRoom

	

Detail

Patient	Check	(HIC)

	

Medicare	Australia

	

Private	Bill

Quick	Bill

View	Bill

Change	Patient

Clinical	Profile

Register

Delete

Send	SMS

Appointment	Right	click	Menu	Options
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medical	certificate

Can	Come	Early

See	Also	

Appointment:	Adding	Appointment
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Schedule	Buttons
The	appointment	screen	has	the	following	buttons	related	to	the
schedule:

	

Refresh

Day	View

Week	View

Month	View

Work	Week

Today

	

Doctors	drop	down

You	can	select	a	single	doctor	to	be	viewed	in	the	schedule	from	this
drop	down.

	

Free	time

The	find	button	searches	for	the	free	time	specified	in	the	text	box	in
minutes.	The	search	is	limited	to	2	days	and	takes	place	from	the
current	time	or	the	selected	schedule	region	if	you	want	to	search
from	a	later	time.	If	no	free	time	is	found	by	the	schedule	then	it

Appointment	Screen	Features
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displays	a	message	to	the	user	otherwise	a	region	in	the	schedule	is
highlighted	wherever	the	free	time	slot	is	found.	Free	time	is
dependent	on	the	Staff	Roster	settings.

		

Print
The	print	button	on	the	top	right	hand	corner	of	the	appointment	form
prints	the	default	appointment	schedule	screen.

	

	

	

Calendar

																															
The	calendar	in	the	appointment	screen	points	to	the	date	of	the
schedule.	You	can	select	a	single	date	or	a	number	of	dates	to	view
the	schedule	for	those	dates.	If	you	press	today,	the	calendar	returns
to	the	current	date.		

	

	

Waiting	room

										 												
The	waiting	room	displays	the	list	of	patients	whose	status	is	set	to
"waiting".	
If	you	are	logged	in	as	a	doctor,	the	waiting	room	will	display
only	your	patients	who	are	waiting.	
If	you	are	logged	in	as	an	administrator	or	you	are	not	a	doctor,	then
the	waiting	room	will	display	all	patients	who	are	waiting.	Patients	are
removed	from	the	waiting	room	when	their	appointment	status	is
changed	from	"waiting"	to	some	other	status.

	

The	waiting	room	grid	has	a	context	menu	which	is	identical	to	the



"Appointment	Context	Menu".	

	

Doctors

												
You	can	select	any	combination	of	doctors	you	would	like	to	see	in
your	appointment	screen.	
The	system	will	not	allow	you	to	uncheck	all	the	doctors.	
The	system	will	remember	your	settings	and	will	be	saved	for	then
next	time	you	login	again.	

Details

															
The	details	box	is	only	visible	to	doctors	and	administrators	of	the
system.	It	gives	the	user	the	total	amount	of	bills	and	payments	made
for	yesterday	and	today.		
If	you	are	a	doctor,	these	amounts	only	refer	to	your	bills	and	receipts.
For	administrators,	the	amounts	will	be	the	total	for	all	the	doctors.

	

Inbox

													

The	inbox	is	a	shortcut	to	view	your	messages.	The	number	of
messages	is	updated	dynamically	as	and	when	anyone	sends	you	a
message.	Clicking	on	either	"Total	Messages"	or	"New	Messages"	will
retrieve	your	messages.	

	

See	Also	

Appointment:	Adding	Appointment
	

	



©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: ACIR


	

1.	 R	click	on	the	patient's	appointment	and	select	ACIR
The	Claim	form	then	appears

2.	 Click	the	ADD	button	on	claim	form
The	Vaccine	form	then	appears

3.	 Scroll	down	and	Double	click	on	the	row	for	the	selected
vaccine

4.	 Select	the	Site

5.	 Enter	the	batch	number

6.	 Enter	the	dose	number

7.	 Click	Ok
This	will	close	the	Vaccine	form

8.	 Click	Send	now	on		the	Claim	form

View	screenshots	below

	

	

Click	to	enlarge

	

ACIR



Click	to	enlarge

	

	

					
	

	

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: ACIR1


	

ACIR1



R	click	on	the	patient's	appointment	and	select
ACIR
To	follow	instructions	in	how	to	transmit	claims	to	go	to	ACIR	workflow

	

Click	to	enlarge
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1.	 R	click	the	patient's	name	on	the	appointment	screen	and
select	Bulk	Bill	from	the	drop	down	menu
The	Bulk	Bill	form	will	appear	with	the	cursor	sitting	in	the
Add	Item	field

2.	 Insert	the	item	number	and	hit	Enter
The	Add	Service	form	will	appear

3.	 Hit	Enter	again	
or	check	the	relevant	boxes	for	Not	Normal	After	Care	etc....
The	item	number	is	added	to	the	Bulk	Bill	form	

4.	 Hit	Enter	again	
-	unless	you	want	to	enter	another	item	number

5.	 The	Claim	is	then	Batched	by	default	if	you	hit	Enter	when
the	Add	Item	field	is	BLANK
Batched	Claims	can	be	viewed	and	edited	later	in	All	Stored
Claims	form.

6.	 Clicking	Send	Now	will	immediately	send	the	Claim	to
MedicareAustralia

	

	

Click	to	enlarge

	

Click	to	enlarge
	

	

	

Bulk	Bill
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	Printing	Assignment	reports
	
Turn	Printing	on	or	off
	
Administration	>	Settings	>	User	Preferences
	
Select	Printing	tab
	

Click	to	enlarge
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On	the	main	menu	go	to	Financial	>	ACIR	search
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1.	 R	click	the	patient's	name	on	the	appointment	screen	and
select	DVA	Bill	from	the	drop	down	menu
The	DVA	Bill	form	will	appear	with	the	cursor	sitting	in	the
Add	Item	field

2.	 Insert	the	item	number	and	hit	Enter
The	Add	Service	form	will	appear

3.	 Hit	Enter	again	
or	check	the	relevant	boxes	for	Not	Normal	After	Care	etc....
Treatment	Location	-	Click	the	drop	down	box	if	the	service
is	other	than	normal	consultation	rooms
The	item	number	is	added	to	the	Bulk	Bill	form	

4.	 Hit	Enter	again	
-	unless	you	want	to	enter	another	item	number

5.	 The	Claim	is	then	Batched	by	default	if	you	hit	Enter	when
the	Add	Item	field	is	BLANK
Batched	Claims	can	be	viewed	and	edited	later	in	All	Stored
Claims	form.

6.	 Clicking	Send	Now	will	immediately	send	the	Claim	to
MedicareAustralia

	

	

	

Click	to	enlarge

	

	

	

DVA
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Click	on	assignment	report

	

Click	to	enlarge

	

Click	to	enlarge
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An	Interactive	Claim	cannot	deleted	once	it	has	been	transmitted.
	
A	stored	claim	can	be	deleted.
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Patient	Claim	Interactive	workflow

	

Click	the	Payment	Details	button.	The	Payment	Details	Form	comes
into	view.
	
	

	
Select	Mode	of	payment.

Cheque

EFT

If	EFT	then	insert	the	Bank	Account	Details.

	

Bank	Accounts	Details	are	stored	in	encrypted	format	in	the
database	for	future	use.
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Private	Bill



R	click	the	appointment	to	select	Private	Bill	or	Quick	Bill.
		

1.	Private	Bill.

This	list	displays	the	10	most	frequent	services	used	by	each
individual	doctor	and	continues	to	update	itself.
	

-										Note:	The	menu	shows	the	nicknames	of	the	top	10
services.	The	nickname	can	be	changed	by	going	to
Items	>	Service	>Search	Service	(Open	the	record
and	enter	the	nickname)

	
	

2.	Quick	Bill.
The	Quick	Bill	autocompletes	the	bill	with	service	item	number	23.					

	The	invoice	number	for	the	bill	is	generated	after	the	bill	has	been
created.



		

Troubleshooting
	The	service	item	number	can	be	changed	after	it	has	been	added	to
the	grid.

If	that	item	number	you	have	newly	edited	is	not	present	in	the	table
then	the	system	will	message	you	that	the	item	does	not	exist	and	the
record	colour	will	become	red.

You	cannot	save	the	bill	if	the	service	item	is	erroneous.	You	can
either	delete	that	service	item	from	the	grid,	or	alter	the	service	code
to	a	code	which	is	present	in	the	system.

See	Also	

Bill:	Modifying	a	Bill	|	Deleting	a	Bill	|	Searching	a	Bill
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Simultaneous	payment	of	a	bill



Payment	while	Billing
A	bill	can	be	immediately	paid	once	it	has	been	created	by	clicking	on
pay.

To	understand	how	to	make	a	payment	please	take	a	look	at
payments.

Click	to	enlarge
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Add	more	item	numbers	to	the	bill



Add	new	item	numbers
The	grid	displayed	in	the	bill	form	is	one	where	you	can	add	bill	item
numbers.	
For	more	information	on	grids	see	working	with	grids	section.

	

To	add	item	numbers	to	the	bill,	click	on	the	first	row	and	first	column
on	the	grid	under	the	name	service	code.

Once	you	enter	an	item	number	the	system	will	automatically	insert
the	default	costs	(	and	the	GST	if	this	is	appropriate).

You	can	change	the	price	by	

clicking	on	the	price	column	and	inserting	your	own	fee

selecting	a	price	from	the	drop	down	list		

			

	

If	you	do	not	remember	or	know	the	item	number	the	system	has
been	designed	to	assist	you	to	search	for	the	correct	number.

To	include	GST	in	an	item,	tick	the	GST	checkbox.

You	can	manually	set	the	total	value	of	the	bill	to	a	lesser	amount
than	the	price	of	the	bill.	This	effectively	discounts	the	bill	and	this	will
be	noted	on	the	receipt.

You	can't	change	the	description	associated	with	the	item	number.
This	can	only	be	done	by	going	back	to	service	search	and
then	updating	the	service	details.	

To	delete	an	item	number	which	was	accidentally	inserted,	click	on
the	row	header	of	the	item	and	hit	delete.		

When	all	the	item	numbers	have	been	added	to	the	bill	you	then	have
the	option	to

save	the	bill	



save	and	print	the	bill

receive	payment	for	the	bill
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Ctrl	+	L



Adding	item	numbers	with	Ctrl	+	L
Hitting	Ctrl	+	L	will	display	the	Service	Lookup	form	and	by	using	the
Nick	Name	the	software	will	assist	you	to	find	the	correct	item
number.

Each	Item	number	displays	the	item	number	by	default	in	the	Nick
Name	box	but	this	can	be	replaced	with	an	easily	remembered	name.
eg	ECG,	BCC,	Spiro	etc	

e.g.	If	you	can't	remember	the	item	number	for	removal	of	a	corneal
foreign	body	then	the	system	can	be	customized	to	easily	search	for
the	correct	item	number	and	also	add	it	to	the	bill.

Enter	the	letters	"fb"	for	the	Nick	Name.		

Click	to	enlarge

	
Just	select	the	correct	item	number	from	the	matches	offered	by	the
Nick	Name.

	

Click	to	enlarge

	

The	bill	form	is	disabled	while	the	Service	Lookup	form	remains	open
and	is	re-enabled	once	the	Lookup	form	is	closed.	
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Ctrl	+	N



Create	a	new	Service	code	while	in	the	bill
form.
This	is	not	often	used	but	a	practice	might	wish	to	add	a	new	service
code	to	a	bill	which	does	not	already	exist	in	the	service	code	table.

Hitting	Ctrl	+	N	will	display	the	Service	form	and	the	new	service	can
be	added	to	the	Service	code	table	and	at	the	same	time	added	to	the
bill.
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Bill	to:-			
	

1.	 Individual

2.	 Family		

3.	 Agency		

	

								
							

	

The	bill	can	come	from	either	the	doctor	or	the	practice.

	

								

	

When	billing	to	an	agency

select	the	Agency	Code	from	the	drop	down	list.	
Select	the	Fee	Type	from	the	drop	down	list.	
Insert	a	Claim	number	if	this	is	applicable.
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Change	the	bill	date	or	the	bill	doctor	by	clicking	the	'?'	sign.
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On	the	main	menu	click	on	billing	then	search	bill.

	

	

A	search	form	will	be	displayed	to	you.	You	can	make	the	use	of
wildcard	characters	when	searching.

Click	to	enlarge

Searching	a	Bill



Search	Options
Show	All

Patient	Name

Invoice	No.

Agency

Doctor	Code

Date	From

Date	To

Total	From

Condition

Total	To

Outstanding	Bills
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Results
Click	on	search	button	when	you	have	input	any	search	criteria.	If	any
record	matches	your	search	condition,	the	bills	will	be	displayed	in
the	grid	below.	To	view	any	bill	double	click	on	the	record	or	hit	enter
in	the	grid	after	selecting	the	bill.	A	context	menu	is	also	available	for
the	displayed	records.

View	Bill

View	Patient	Details

Make	Payment

See	Also	

Bill:	Private	Bill	|	Modifying	a	Bill	|	Deleting	a	Bill
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Attach	a	MESSAGE	to	the	bill.

	

This	MESSAGE	is	printed	in	red	and	seen	by	anyone	opening	the	bill
(but	it	is	not	printed	on	the	bill).
	

Attach	a	COMMENT	to	the	bill.

	

This	COMMENT	is	printed	onto	the	bill.
	

Click	to	enlarge

	

	

	

	

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.

Message	&	Comment	attached	to	a	Bill



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Modifying a Bill


	

You	can	only	update	or	modify	a	bill	if	you	are	an	administrator	of	the
system	or	you	were	the	person	that	created	the	bill.		If	you	are	not	an
administrator	of	the	system	then	the	bills	created	by	other	users	will
not	be	available	to	you	for	modification.

	

Go	to	billing	and	payments	>	update	bill	on	the	main	menu.							

This	will	display	an	update	bill	form	where	you	will	have	to	search	the
bill	you	want	to	update.	After	you	have	searched	the	bill,	double	click
on	the	record	or	hit	enter	on	the	grid.	The	bill	will	be	displayed	on	a
separate	form.	

	

Click	the	update	button	on	top	of	the	grid.	The	bill	items	will	be
displayed	in	a	separate	form	where	you	can	update	the	service	items
or	add	a	new	service	item.

	

Click	on	update	and	a	new	form	will	appear	where	the	previous	item
number	can	be	replaced	or	an	additional	item	number	can	be	added.

You	can	also	cancel	or	write	off	a	bill.	For	more	details	see	deleting	a
bill.

See	Also	

Bill:	Private	Bill	|	Deleting	a	Bill	|	Searching	a	Bill
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A	bill	can't	ever	really	be	deleted	from	the	system.	It	can	only	be
cancelled	or	written	off.

	

Cancelling	a	Bill
On	the	main	menu,	search	for	the	bill	by	going	to	Billing	and
Payments	>Update	Bill.	

	

	

The	patient's	name	appears	in	the	grid.

	

You	have	two	options-	Double	click	or	R	click	the	bill.

	

1/	Double	click	the	patient's	bill.	

	

The	bill	will	be	displayed	on	a	separate	form.	

	

Click	the	update	button	on	top	of	the	grid.	The	bill	items	will	be
displayed	in	a	separate	form	where	you	can	update	the	service	items.
You	can	either	change	the	item	number	or	cancel	the	item	number.	

To	cancel	the	bill,	change	the	item	number	to	'000'.

	

	

2/	R	click	the	patient's	bill.

Deleting	a	Bill



	

A	submenu	will	appear.	

	

	

	

	

View	Bill

	

View	Patient	Details

	

Make	Payment

	

Edit	Bill

	

Cancel	Bill

	

Write-Off	Bill
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Bill	Write	Off
	

To	write	off	a	bill,	select	"Write-Off	Bill"	from	the	context	menu.	When
you	write	off	a	bill,	a	payment	will	have	to	be	generated	which	the
practice	will	have	to	bear.	The	bill	will	be	marked	as	written	off.

	

Click	to	enlarge	

See	Also	

Bill:	Private	Bill	|	Modifying	a	Bill	|	Searching	a	Bill
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A	payment	can	be	made	only	for	an	existing	bill.	Payment	form	can
be	opened	from	the	bill	form	if	you	click	on	the	pay	button.	To	directly
make	a	payment	while	creating	a	bill	you	can	click	on	the	pay	button
on	the	bill	form	instead	of	saving	it.	The	pay	button	when	clicked	will
automatically	save	your	bill	first	and	then	proceed	on	to	payment.

	

Otherwise,	payments	can	be	made	after	searching	the	patient,
searching	a	family	or	searching	an	agency.

	

Making	a	Payment



			Making	a	Payment	by	Searching	a	Patient
To	make	a	payment	by	searching	a	patient	select	billing	and
payments	from	the	main	menu	and	then	select	'Individual	Payment'.
The	patient	search	form	will	be	displayed.	Search	for	the	patients	you
want	to	make	payment	for.	If	your	search	has	matched	any	records,
then	the	patients	will	be	displayed	below	in	the	grid.	Double	click	on
the	grid	or	hit	enter	on	any	patient	record	to	display	the	payment	form
with	the	outstanding	bills	for	the	patient.	If	there	are	no	outstanding
bills	for	the	patient,	the	software	will	message	you.	



			Making	a	Payment	by	Searching	a	Family	
To	make	a	payment	by	searching	a	family	select	billing	and	payments
from	the	main	menu	and	then	select	'Family	Payment'.	The	family
search	form	will	be	displayed.	Search	for	the	family	you	want	to	make
payment	for.	If	your	search	has	matched	any	records,	then
the	families	will	be	displayed	below	in	the	grid.	Double	click	on	the
grid	or	hit	enter	on	any	family	record	to	display	the	payment	form	with
the	outstanding	bills	for	all	patients	in	the	family.	If	there	are	no
outstanding	bills	for	the	patients	in	the	family,	the	software	will
message	you.	



			Making	a	Payment	by	Searching	an	Agency
To	make	a	payment	by	searching	an	agency	select	billing	and
payments	from	the	main	menu	and	then	select	'Agency	Payment'.
The	agency	search	form	will	be	displayed.	Search	for	the	agency	you
want	to	make	payment	for.	If	your	search	has	matched	any	records,
then	the	agencies	will	be	displayed	below	in	the	grid.	Double	click	on
the	grid	or	hit	enter	on	any	agency	record	to	display	the	payment	form
with	the	outstanding	bills	for	that	agency.	If	there	are	no	outstanding
bills	for	the	selected	agency,	the	software	will	message	you.		



			Making	a	Payment	Directly	while	Billing
When	you	are	billing	a	patient,	you	can	directly	go	to	the	payment
form	by	clicking	the	pay	button	on	the	bill	form.	Clicking	the	pay
button	will	first	save	the	bill,	if	the	bill	has	no	errors,	then	display	the
payment	form	for	the	bill.



		Payment	Form
	Payment	of	a	bill	can	be	made	in	3	different	ways:

1.	 Lump	Sum

2.	 By	Bill

3.	 By	Item

	

			Payment	By	Lump	Sum
Click	to	enlarge

	
	
Select	this	method	if	you	want	a	lump	sum	payment	to	be	made
against	the	bill.	If	there	are	more	than	1	service	items	in	the	bill,	the
lump	sum	amount	will	automatically	be	adjusted	against	the	items.
You	cannot	put	in	an	amount	which	is	greater	than	the	bill	amount.
The	payment	amount	will	have	to	less	than	or	equal	to	the	bill
amount.	It	might	happen	that	one	of	the	service	items	have	been	fully
paid	while	the	other	is	partially	paid.	This	bill	will	then	be	available	for
payment	later.	If	a	bill	has	been	fully	paid,	that	is,	all	the	service	items
have	been	paid	totally,	then	no	more	payment	can	be	made	against
the	bill.
	

		Payment	By	Bill
	
If	you	opt	for	the	payment	by	bill	method,	then	you	have	to	insert	the
payment	against	each	bill	in	the	grid.	The	bill	is	the	parent	row	in	the
grid,while	the	service	items	are	the	child	rows.	When	you	type	in	an
amount	for	the	bill	and	hit	enter,	the	amount	in	the	service	items	will
be	automatically	adjusted.

		Payment	By	Item



	
If	you	opt	for	the	payment	by	item	method,	then	you	have	to	insert	the
payment	against	each	service	items	in	a	bill	in	the	grid.	Type	in	the
payment	amount	for	the	service	item	and	hit	enter.
	
Whenever	any	amount	is	adjusted	in	the	grid,	the	payment	summary
will	also	be	adjusted.	The	payment	summary	gives	you	a	summarized
version	of	the	payment	taking	place.

	

	



		Setting	the	Payment	Allocation
The	payment	is	not	ready	to	be	saved	unless	and	until	proper	payment
allocation	is	completed.	There	are	a	number	of	options	available	to	you
for	payment	allocations	the	most	simple	being	the	cash.	Other	allocations
currently	include	eftpos,	credit	card,	3	different	cheques,	online	banking
and	others.

	

The	sum	of	the	allocations	will	have	to	match	the	sum	of	total
payment.

When	you	select	cheque	to	allocate	a	payment,	you	have	to	enter	the
cheque	number	in	the	details	column	of	the	allocation	grid.

		Simple	allocation	for	single	bill
The	allocation	of	payment	is	quite	simple	when	you	are	making	a
payment	against	a	single	bill.

	

	

Select	the	type	of	allocation	you	want	from	the	drop	down	in	the	first
column	of	the	allocation	grid	and	type	in	the	required	amount.	The	sum	of
your	allocations	is	displayed	below	which	should	match	the	total	of	the
payment	before	you	save	the	payment.		

		Complex	allocation	for	multiple	bills
It	may	often	happen	that	you	are	required	to	make	the	payment	for
multiple	bills	at	a	single	time.	For	example,	when	you	are	making	a
payment	by	agency	search,	then	all	the	outstanding	bills	for	the	agency
are	displayed	in	the	payment	form.	In	such	a	situation,	the	payment
allocation	takes	place	in	a	separate	form.



	

	

The	payment	allocation	grid	is	absent	in	the	payment	form.	After	you
enter	the	amount	for	payment	and	click	on	save,	the	payment	breakup
form	is	displayed.

	

Here	you	have	two	options:

1.	 Set	a	single	allocation	method	for	all	the	bills.	For
example,	you	can	select	cash	from	the	drop	down
which	means	that	both	the	bills	in	the	above
diagram	have	been	paid	by	cash.

2.	 If	the	bills	are	paid	differently,	you	have	no	option	but	to
manually	insert	the	payment	allocations	in	each	of	the
bills.

	

After	you	have	finished	allocating	the	payment,	click	on	save.	

See	Also	

Payment:	Modifying	a	Payment	|	Deleting	a	Payment	|	Payment	Search
Patient:	Patient	Search	|	Family	Search
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You	can	update	a	payment	if	you	are	an	administrator	of	the	system
or	you	are	given	the	privilege	to	do	so	by	an	administrator.	Before	you
can	update	a	payment,	you	have	to	search	for	if	first.	To	search	for
the	payment,	open	payment	search.

	

The	payment	form	will	be	displayed	when	you	select	update	from	the
context	menu	of	the	payment	search	grid.

	

Notice	that	a	new	column	called	"Corrected	$"	will	be	present	in	the
grid.	Enter	the	corrected	amount	for	the	service	item,	match	the	same
in	payment	allocation	grid	and	click	save.	The	balance	will
automatically	be	calculated	and	saved.

See	Also	

Payment:	Making	a	Payment	|	Deleting	a	Payment	|	Payment	Search
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You	can	delete	a	payment	if	you	are	an	administrator	of	the	system	or
you	are	given	the	privilege	to	do	so	by	an	administrator.	Before	you
can	delete	a	payment,	you	have	to	search	for	if	first.	To	search	for	the
payment,	open	payment	search.

	

The	payment	form	will	be	displayed	when	you	select	update	from	the
context	menu	of	the	payment	search	grid.

	

Hit	the	delete	button	to	delete	the	payment.	The	software	will	prompt
for	confirmation	before	deleting	the	payment.	Once	the	payment	is
deleted,	the	bill	for	which	the	payment	was	originally	for,	will	become
unpaid.

See	Also	

Payment:	Making	a	Payment	|	Modifying	a	Payment	|	Payment
Search

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.

Deleting	a	Payment



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Payment Search


	

On	the	main	menu	click	on	billing	and	payments	and	then	search
payment.

	

	

A	search	form	will	be	displayed	to	you.	You	can	make	the	use	of
wildcard	characters	when	searching.

Click	to	enlarge

	

Payment	Search



		Search	Options
Show	All

Hide	All

Patient	Name

Receipt	No.

Received	By

Bill	To

Date	From

Date	To

Total	From

Condition

Total	To

	

javascript:HSShowAllCSections();
javascript:HSHideAllCSections();
javascript:HSToggleSection('{92F4AA7D-D36B-47F0-BC5D-16C8D00FAC52}')
javascript:HSToggleSection('{7AF10E85-872A-4B56-B037-D4D5EAA42832}')
javascript:HSToggleSection('{0BE096F1-93BA-4689-961D-EAE39880D750}')
javascript:HSToggleSection('{5566F07E-FCA1-4A21-BDC9-AE8E5FA34CA2}')
javascript:HSToggleSection('{D31ED5BD-30E5-4FA1-BE34-2B931C8F6051}')
javascript:HSToggleSection('{CC29F749-9AE8-4DB9-AC07-D3C463E85824}')
javascript:HSToggleSection('{D3030677-934C-4BFC-BED2-1D33AD8B4134}')
javascript:HSToggleSection('{6E058763-3951-4ECA-8522-A05C32140D35}')
javascript:HSToggleSection('{37DB57F0-161B-4318-AA81-BDC66BC33606}')


			Results	
Click	on	search	button	when	you	have	input	any	search	criteria.	If	any
record	matches	your	search	condition,	the	payments	will	be	displayed
in	the	grid	below.	To	view	any	payment	double	click	on	the	record	or
hit	enter	in	the	grid	after	selecting	the	payment.	A	context	menu	is
also	available	for	the	displayed	records.

View

Update					

	

The	update	context	menu	might	not	be	visible	to	you	if	your	login
does	not	have	the	appropriate	privilege

See	Also	

Payment:	Making	a	Payment	|	Modifying	a	Payment	|	Deleting	a
Payment
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Remember	one	Bank	Code	can	be	shared	by	multiple	staff
members	but	a	staff	member	can	have	only	have	one	Bank
Code.

	

	

A	Banking	process	discreetly	logs	all	payments	as	they	are
received	by	the	practice	from	all	the	different	sources.

When	a	payment	is	received	for	a	bill,	the	drawer	of	the	bill	i.e.	the
Doctor’s	bank	code	is	used,	to	either	initiate	or	append	to	a
banking	process.

Banking	Records	can	be	reconciled	partly	or	fully	as	the	policy	of
the	Practice	may	require.

Every	Bank	Code	will	start	an	individual	banking	process	for	itself
however	multiple	Banking	processes	can	be	closed	together.

Once	a	Banking	Process	is	closed,	payments	included	in	the	report
can	no	longer	be	edited	but	in	case	an	error	is	identified	after	a
banking	process	has	been	closed	then	only	the	administrator	has
the	ability	to	re-open	and	make	a	correction	by	‘reversing	the
banking’.
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All	staff	members	that	provide	billings	for	the	practice	require	a
provider	number.		(Registered	Nurses	can	be	assigned	the	common
provider	number	i.e.	1111).	

These	staff	members	providing	billings	for	the	practice	can	then	be
assigned	a	bank	code.	Setup	the	bank	codes	by	entering	a		specific
code	for	a	nominated	account.	This	bank	code	has	no	relationship	to
a	staff	code	though	for	convenience	a	practice	might	want	to	match
the	codes.	After	entering	a	bank	code	then	enter	the	Bank	Account
details	i.e.	BSB,	Account	No,	Account	name,	Bank	name.
	

	

Once	the	banking	codes	have	been	setup	then	each	staff	member
generating	receipts	can	then	be	associated	to	a	bank	code	through
their	staff	details.	Go	to	Staff>	Search	Staff	on	the	main	menu.

Click	on	the	Question	mark	in	the	box	next	to	banking	code	and	this
will	bring	the	Bank	Code	form	into	focus	so	that	one	of	the	bank
accounts	can	be	selected.

	

One	doctor	can	have	only	one	bank	account	BUT	one	bank	account
can	have	many	doctors.

	

Click	to	enlarge

	

	

An	employee	or	locum	doctor	will	often	not	have	their	own	bank	code
because	their	receipts	are	deposited	with	the	Practice	or
Principle	doctor.

Setup	Bank	Codes



The	grid	at	the	top	of	the	page	shows	an	example	of	five	staff	placing
deposits	into	only	one	account.	(Dr	Adam	Brown)	

The	codes	listed	on	the	right	indicate	which	staff	are	associated	with
the	bank	account	highlighted.
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MedicareAustralia



Go	to	www.medicareaustralia.com.au
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MedicareAustralia	Settings
	
	

Click	to	enlarge

	

Setup
1.	 Cryptostore	Path

This	is	the	path	to	the	PSI	certificate.	Click	find	to	browse	to
the	certificate.	By	default	it	will	be	pointing	to	the	test	file	PSI
certificate.

2.	 Passphrase
This	is	the	password	to	the	PSI	certificate.	This	password
should	be	stored	in	a	secure	location	by	the	practice.	If	it	is
lost	then	a	new	passphrase	will	need	to	be	obtained	from
MedicareAustralia.

3.	 Location	ID
This	value	will	be	provided	to	you	by	the	software	vendor.	(
eg.	HES*****	)	

4.	 Set	Live	Values
Click	on	set	live	values

5.	 JRE	(Java	Runtime	Environment)
Insert	this	path	-		C:\Program
Files\Java\jre1.5.0\bin\client\jvm.dll
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Click	on	Financial	>	All	Stored	Claims

	

The	Stored	Claims	Form	contains	to	adjacent	windows

Pending	Vouchers
Batched	Vouchers

	

Clicking	on	the	arrows	<	and	>	>>	can	move	the	claims	back	and
forth	between	these	two	windows

Only	claims	in	Pending	vouchers	can	be	edited

	

Double	click	any	claim	in	Pending	vouchers	if	the	claim	requires
adding	or	deleting	of	item	numbers.

Pending	Vouchers-	Editable

Batched	Vouchers-	Not	Editable

	

Click	to	enlarge
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Pending	Vouchers

	

Batched	Vouchers	window	you	have	the	option	to

1.	 send	all	the	claims

2.	 send	a	selected	claim

3.	 Unbatch	the	claim	by	returning	it	to	the	Pending	Vouchers
window	where	it	can	be	edited

	

	

Click	to	enlarge
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Click	to	enlarge
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There	are	two	kinds	of	rejections.
	

1/	Failure	at	the	point	of	submission.
	

There	are	255	reasons	at	present	why	a	claim	might	be
rejected.		Some	examples	might	be	a	Token	Key
Failure,	the	location	certificate	has	expired	or	perhaps
even	corruption	of	data	during	transmission.
	

In	this	case	there	is	no	report	at	all	because	the	claim
did	not	reach	Medicare	Australia	or	was	not
recognized	by	Medicare	Australia.
	

2/	Failure	inside	the	processing	report.
	

If	the	claim	is	accepted	for	processing	then	there	are
three	outcomes.

Accepted	totally
Rejected	totally
Rejected	partially

	

Understanding	rejections



The	processing	report	from	Medicare	should	explain
the	reason	for	rejection.	
e.g.	expired	Provider	#,	patient	not	recognized,
incompatibility	of	service	codes	etc.
	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: User Must Do


	

CompletePractice
Must	Do	for	the	New	Users

	

	

Straight	after	installation	of	GPCompletethe	following	things	needs	to
be	done:

	

1.	Manage	Cryptostore	file.
	

a/	Existing	users	to	Medicare	Australia.

If	migrating	from	an	existing	Product	which	was	transmitting	to
Medicare	Australia	then	you	will	already	have	this	file.	This	file	needs
to	be	located.

	

This	file	can	be	seached	your	computer	with	*.psi

	

b/	New	users	to	Medicare	Australia.

Refer	to	help	menu	in	CompletePractice.

Navigate	to	Medicare	Australia>Quick	Reference	Guide.

	

	

	

2.	Manage	Medicare	Australia	Connection.

User	Must	Do



3.	Loading	Health	Funds
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Additional	fields	are	required	for	specialist	referrals.

See	the	Explanatory	fields	below.

		

	

Explanatory	fields
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Reports



On	the	main	menu
	

Click	on	Reports
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Report	Wizard



The	Report	Wizard
	

The	Administrator	can	use	the	Report	Wizard	to
generate	virtually	any	customizable	report.
	
The	features	of	these	reports	are	that	they

allows	definition	of	content	and	presentation
permits	sharing	of	the	reports	with	other	users
enables	periodic	Emailing	of	the	reports	to
nominated	users.

	

The	steps	in	creating	a	report	from	the	Report	Wizard.
	

a.	Go	to	Administration>Reports>Report	Wizard

b.	 Click	on	the	Add	button	at	the	bottom	left

Click	to	enlarge

Type	a	description	for	your	report	in	the	Report
Name	Box
For	the	auto-emailing	client	select	a	frequency
for	the	reports



Insert	the	email	ID	in	the	next	box	and	separate
recipients	with	a	semicolon.

c.	You	can	make	a	Financial	Report,	a	Practice
Summary,	or	a	combination	of	both.	



The	steps	involved	in	the	creation	of	a
financial	report.	

				Define	a	Report	by	checking	on	the	options	in	the	tree

a.	On	the	tree	define	what	constitutes	a	bill
i.e.	do	you	want	to	see	only	new	bills,
(New	Bills),	account	for	Medicare
rejections	and	re-submissions,	adjust	for
management	fees	etc.

b.	On	the	tree	define	what	constitutes	a
payment	in	your	report.	Ideally	you	will
want	to	see	all	payments	for	a	given	date
range.	However	in	certain	instances	you
may	want	to	see	payments	only	for	the
given	bills.

c.	Under	Reporting	Sections	select	the
sections	you	want	to	see	in	your	report.
Clicking	on	any	section	will	bring	up	a
brief	explanation	on	the	right	hand	side

d.	Give	the	report	a	name.	Report	names
have	to	be	unique

e.	 Set	up	an	email	schedule.	You	may	want
to	see	the	Bill	Summary	every	week,	or
the	complete	financial	summary	at	the



end	of	every	month.	Set	this	up	and	you
will	receive	the	reports	in	your	inbox	on
the	designated	days.	Note:	for	this	to
work	the	Administrator	has	to	set	up
Auto-Reporting	Schedule	along	with
emailing	details	in	Administration	-
>Settings	->Preferences	->	System
Preferences

f.	 If	you	want	to	share	it	with	non-admin
users	of	the	system,	check	on	Share	All.
Note:	Users	with	admin	rights	will	be
able	to	see/edit	your	report	even	if	you
have	decided	to	not	share	with	anyone

g.	 Click	on	Save.	
Your	reports	will	then	be	seen	listed	in
My	Reports	under	the	Report	Wizard
Icon.	
You	can	then	activate	this	report	by
clicking	on	the	report	icon	that	you	have
saved.

	
Repeat	these	same	steps	for	creating	a	Practice
Summary	Report	(options	available	in	the	other	tab	on



the	tree).	
A	combination	of	both	types	of	reports	can	be	included
in	a	single	file.
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Wizard	for	financial	analysis



Report	Wizard	for	a	Financial	analysis
	
	
	
	
		

Click	to	enlarge																																										 Click	to
enlarge																																									 Click	to	enlarge
	

Click	to	enlarge
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Wizard	for	Practice	Summary



Report	Wizard	for	a	Practice	Summary
	
	
							

Click	to	enlarge																																																 Click
to	enlarge
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-										Export	data	from	advanced	searching	into	Excel,	Lotus	and
other	spreadsheets.	Data	can	be	exported	in	the	universal
CSV	format.	Currently	only	the	first	level	in	the
hierarchy	can	be	exported.
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A	list	of	actively	pregnant	patients	in	the	practice	can	be	generated	by
this	report.		Click	on	obstetric	patients.

Click	Reports>Obstetric	Search		

Double	click	on	any	patient	in	the	grid	to	display	the	patient's	clinical
profile.

	

Click	to	enlarge

	

	

	

The	patient's	clinical	profile	will	be	displayed	if	you	double	click	on
the	name	in	the	list.
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The	system	can	search	for	all	patients	that	have	a	specified	drug
listed	in	their	Current	Rx.

Click	on	reports	from	the	main	menu	and	then	select	patient	by	drug.

A	search	screen	for	drugs	will	be	displays.	Type	in	the	first	few	letters
of	some	drug	and	click	on	search	button.	The	list	of	drugs	available
will	be	displayed	in	the	grid.

	

											

	

Double	click	on	any	record	on	the	grid	or	hit	enter	to	view	the	list	of
patients	who	have	been	prescribed	the	drug	either	currently	or	in	the
past.
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Go	to	the	Recall	Manager	to	process	the	recalls

	

The	Recall	report	will	list	the	patients	by	either	the

	

Creation	date	of	the	recall
or

Due	date	of	the	recall
	

Filters	can	be	selected	to	display

	

Show	only	incomplete	recalls

Show	only	urgent	recalls
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Agency	Statement



Display	an	agency	statement
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Bills	held	are	those	PRIVATE	bills	which	are	
not	yet	printed

not	paid

not	cancelled

not	written	off

For	instance	a	person	having	a	?	BCC	excised	on	their	face	might	be
billed	as	a	#31265	but	this	bill	cannot	be	released	to	the	patient	until
the	histopathology	report	confirms	the	diagnosis.	This	bill
might	remain	in	the	system	for	several	days	and	could	be	forgotten!

Searching	"held	bills"	provides	a	way	of	going	back	though	the
system	and	finding	these	kinds	of	bills.

To	view	the	bills	held	report	please	select	reports	from	the	main	menu
and	then	select	bills	held.

The	bills	held	form	will	be	displayed	to	you.

	

	

If	you	are	an	administrator	of	the	system,	you	will	be	able	to	view	the
bills	held	report	for	all	doctors	or	whichever	doctor	you	select	from	the
drop	down.

System	permissions	set	by	the	Administrator	determines	to	what
extent	you	can	view	these	reports.	

You	have	two	options	to	view	the	bills	held	report.	You	can	either	set
the	date	range	for	the	report	or	you	can	view	the	report	by	the	last	'x'
number	of	days.	If	you	do	not	set	any	dates	in	the	date	range,	by
default,	the	current	date	is	chosen.

Click	on	the	show	button	to	display	the	report.	A	new	form	will	be
displayed	with	the	records	searched.

Bills	Held



Click	to	enlarge

This	report	will	not	display	the	bill	item	numbers,	but	the
item	numbers	can	be	seen	in	the	original	bill	which	comes	into	view
when	you	double	click	on	any	record	in	the	grid.	

The		'+'	and	'-'	signs	on	the	top	right	hand	corner	of	the	form	are	not
used	in	the	bills	held	report.	You	can	sort	the	records	by	clicking	on
any	column	header.	You	can	also	remove	columns	which	you	do	not
want	to	print.		

	

To	remove	a	column	right	click	on	the	column	header	and	select	hide
column.	The	column	will	be	removed	and	will	not	be	printed.	Once
removed	the	column	cannot	be	brought	back	from	this	screen.	You
will	have	to	go	back	to	the	bills	held	screen	and	re-generate	the	report
if	you	wish	to	view	the	column.
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Advanced	Search



	
On	the	main	menu	go	to	Reports	>	Advanced	Search
		
The	advanced	search	form	will	be	displayed.
	
	

Click	to	enlarge



Steps	to	create	a	query	in	the	advanced	search
	

1.	 Select	an	item	from	the	drop	down	list	on	top	which	will
give	you	a	list	of	attributes	of	the	selected	item	along	with
the	sub-items	if	any.

Click	to	enlarge
2.	 Now	select	the	attributes	you	want	to	display	by	either

double	clicking	with	the	mouse	or	drag	and	drop	them	in
the	top	right	grid.

3.	 Repeat	step	2	for	all	items	you	want	to	include	in	your
search.

4.	 If	you	select	an	attribute,	but	then	change	your	mind	and
want	to	delete	it,	then	hit	the	delete	key.	

5.	 If	you	want	sub-items,	for	example	all	bills	for	a	patient
then	from	the	patient’s	attributes	double	click	bill	for	and
you	will	see	the	list	of	attributes	of	the	bill.	You	can	drag
the	items	of	the	sub-item	for	them	to	be	displayed	in	the
query	result.

Click	to	enlarge

In	this	example	the	query	executed	will	find	all	patients	in
the	database	with	a	home	phone	number	ending	in	the
string	12345.
All	patients	in	the	database	could	be	listed	if	a	similar
query	was	entered	for	a	particular	street	name.	

6.	 In	the	top	right	grid	there	are	5	columns	viz.	name,	d,	c,
operator,	and	condition.	The	name	column	displays	the



name	of	the	selected	attribute.	The	‘d’	column	specifies
whether	the	attribute	will	be	displayed	in	the	result,	the	‘c’
column	specifies	whether	you	want	a	filter	condition
using	that	attribute.		For	example,	you	can	select	only
those	patients	whose	last	name	starts	with	“A”.		
To	do	that,	drag	the	patient	(or	double	click)	–	last	name
attribute	into	the	grid	and	check	the	“c”	column	and	in	the
operator	select	“Like”	and	in	the	condition	type	“A%”
The	“%”	character	acts	as	a	wildcard.

-										
Operators	added	to	advanced	search	
i.e.	LIKE,	IN,	IS	NULL,	IS	NOT	NULL,
NOT	IN.	
This	will	help	the	user	in	developing	several
interesting	queries	
e.g.	list	patients	who	don’t	have	any	allergies
recorded,	all	patients	with	no	medicare	number.

7.	 To	display	the	search	result	click	on	execute.	



Using	functions	in	query
You	can	use	functions	like	sum,	max,	min	etc.	with	query.	For
using	these	functions	execute	a	query	and	select	a	cell	of
numeric	type	like	“Bill	Amount”	and	then	select	a	function	from
function	list	and	click	“Apply	Fx”	button.	



Saving	Queries
Users	can	save	a	search	and	use	it	later	again.	To	save	a	query
first	create	and	execute	a	query	and	then	click	on	the	save
button.	The	properties	window	of	the	query	will	be	displayed
where	you	can	enter	a	name	and	description	for	the	query.	The
query	name	is	mandatory	for	saving	a	query.
	
If	you	want	you	can	also	share	the	query	with	other	logins.
Sharing	the	query	with	other	users	will	allow	them	to	use	the
query	but	they	will	not	be	able	to	make	changes	to	the	query.
However,	other	users	can	make	changes	and	save	it	again	as	a
different	query	using	“Save	As”	button.	
	

	



Loading,	Deleting	or	Changing	the	sharing	of	a
saved	query

	
To	delete	a	saved	query	click	on	“My	Qry”.	The	queries
available	to	you	will	be	displayed	as	above.	The	queries	which
have	been	created	by	you	will	appear	in	a	light	blue	background
color.	You	can	only	delete	queries	created	by	you,	you	cannot
delete	queries	created	by	others	and	shared	with	you.
	

If	you	are	the	administrator	of	the	system,	you	will	be	able	to
delete	all	the	queries	in	the	system,	however	you	will	not	be
able	to	change	the	sharing	of	queries	created	by	others.
	
Right	click	on	the	query	you	want	to	delete	and	select	the	delete
option	from	the	context	menu.	Double	clicking	on	any	row	will
load	the	query.	You	can	also	select	the	load	option	from	the
context	menu	to	load	the	query.	If	the	query	was	created	by	you,
then	the	change	sharing	option	will	be	available	to	you	to
update	the	query	properties.
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Printing	Orientation	defaults	to	Landscape	in	order	to	display
results	in	a	larger	font	size
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Results



On	the	main	menu
Select	Reports	>	Results

	

Results

Intray

Download	Results
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Click	Reports	>	Results	>	Download	results

	

The	Intray	lists	results	delivered	in	HL7	and	Pitt	format	delivered	from

1.	 pathology	labs

2.	 radiology	clinics

3.	 hospital	discharge	summaries

	

When	a	result	is	reviewed	by	a	doctor	the	system	allows	two	courses
of	action	with	that	particular	result.

1/	If	the	result	is	checked	"marked	seen"	then	the	result	is	delivered
straight	to	the	patients	file	in	the	database	and	it	will	leave	the	Intray
once	the	Intray	form	is	closed.

2/	If	the	result	is	instead,	marked	either	"Discuss"	or	"Recall"	then	the
result	is	also	delivered	straight	to	the	patients	file	in	the	database	but
the	result	is	also	copied	to	the	Follow-up	Tray.		This	allows	these
particular	results	to	be	put	to	one	side	so	that	they	can	be	reviewed
later.

A	staffcode	must	be	entered	to	authorize	handling	of	results	in	the
pathology	intray.	This	way	the	system	can	determine	which	doctor
authorized	the	clearance	of	the	result	from	the	Intray.

	

	When	the	results	are	being	parsed,	the	patient	names	are	then
checked	against	all	the	patient	names	in	the	database.

If	a	precise	match	is	found,	then	the	result	is	coloured	in	black.	
If	a	close	match	is	found,	then	the	result	is	coloured	in	blue.	
If	no	match	is	found	then	the	result	is	coloured	in	red.

A	pathology	result	which	has	not	matched	a	patient	in	the

Intray



database	cannot	be	marked	as	seen.

	

To	view	the	details	of	the	pathology	result,	double	click	the	result.	
Results	which	have	not	yet	been	viewed	are	displayed	in	bold	on	the
grid.

The	system	allows	a	user	to	mark	a	result	as	seen	and	then	close	the
Intray	without	actually	viewing	the	result,	but	this	is	not	advised.

The	system	requires	a	staffkey	to	be	entered	to	determine	which
doctor	has	assessed	the	results.		This	allows	for	later	audits	if
necessary.	

A	result	cannot	be	"marked	seen"	unless	the	patient	is	in	the
database.	The	patient	can	be	added	to	the	system	as	a	new	patient	at
this	stage	if	the	patient	has	not	yet	visited	the	practice.

The	following	results	form	is	displayed	once	you	double	click	on	any
result	from	the	Intray.	At	this	stage	the	Intray	form	will	remain	disabled
till	you	close	the	results	form.

	

	

If	a	blood	group	value	is	found	in	the	pathology	result,	then	the
update	button	is	shown	to	the	user.

You	can	click	the	update	button	to	store	the	blood	group	value	on	the
clinical	profile	form	of	the	patient.	The	system	will	not	allow	manual
entry	of	a	patient's	blood	group.		A	blood	group	can	only	be	stored
from	a	pathology	result	from	a	valid	pathology	provider.

Rh	negative	blood	groups	are	stored	in	a	green	colour	on	the	clinical
profile	screen.	This	is	to	assist	with	antenatal	care.

The	result	item	where	the	blood	group	is	found	is	highlighted	in	the
grid.

	
You	can	double	click	any	result	to	view	it	in	a	separate	form.
The	form	displays	the	result	details,	the	request	name,	doctor	details



and	the	patient	name.	
The	grid	displays	the	list	of	results.	

	

If	any	of	the	results	are	abnormal	because	they	fall	outside	the	reference
range	then	the	status	is	flagged	in	red	on	top	as	shown	in	the	image
above.

The	abnormal	result	is	also	marked	in	red	in	the	result	grid.



Options	in	Pathology	Result:

			Scrolling	through	the	results
You	can	scroll	through	the	pathology	results	by	using	the	up	and
down	buttons.

			Viewing	Clinical	Profile
The	clinical	profile	of	any	patient	can	be	opened	by	clicking	the	open
clinical	profile	button	on	the	pathology	form.	From	here,	once	the	clinical
profile	has	been	opened,	then	further	actions	can	be	taken	straight	away
concerning	the	pathology	result.

For	example:

prescribe	a	drug

order	another	test

create	a	recall

enter	encounter	notes

			Mark	the	result	as	seen

			My	Notes

			Change	Patient
If	you	want	to	change	the	system	patient	associated	with	the	download,
you	can	do	so	by	clicking	the	change	patient	button.

			Discuss
Clicking	the	discuss	button	will	change	the	status	of	the	result	to	discuss.
Again,	a	system	patient	has	to	be	associated	with	the	result.	If	no	system
patient	is	associated	with	the	result	then	the	patient	search	screen	will	be
displayed.	
If	the	discuss	button	is	checked	then	the	result	is	copied	to	the	Followup



tray.

		Recall
Clicking	the	recall	button	will	allow	you	to	save	a	recall	for	the	patient.
Recalls	are	discussed	in	detail	in	the	clinical	profile	section.	If	no	system
patient	is	associated	with	the	result	and	you	click	the	recall	button,	then
the	patient	search	screen	will	be	displayed.
If	the	recall	button	is	checked	then	the	result	is	copied	to	the	Followup
tray.

	

All	pathology	results	which	are	marked	as	seen	and	saved,	will	be
removed	from	the	intray.		Those	results	are	then	found	in
the	patient's	clinical	profile	in	the	pathology	results	section.		There	is
no	way	to	remove	a	result	back	to	the	Intray	from	the	patient's	clinical
profile.	Results	marked	DICUSS	or	RECALL	are	moved	to	the	Follow-
up	Tray.

See	Also	

Pathology:	Download	Results
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Click	Administration	>	Document	Intray

	

The	Document	Intray	logically	accepts,	assigns	and	distributes	all
incoming	documentation	to	the	practice.

	

A	document	can	be

titled,	categorized	and	dated

	

A	document	can	be

associated	to	a	patient	AND	associated	to	a	doctor

associated	to	a	patient	AND	NOT	associated	to	a	doctor

NOT	associated	to	a	patient	AND	NOT	associated	to	a
doctor	

	

A	document	can	not	be

NOT	associated	to	patient	AND	associated	to	a	doctor

	

Right	Click	the	Document	in	the	InTray	to	select	an	option	in	the	sub-
menu

	

	

	

	

	

	

Document	Intray
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First	Double	click	on	the	document	row	in	the	InTray	and	a	form
shows	with	the	details	of	the	document.

	

Click	on	the	Open	button	to	display	the	document.

	

A	check	appears	in	the	Read	box	once	the	document	is	viewed	and
then	closed	.	(see	red	circle)

	

	

	

The	document	is	then	removed	from	the	InTray	once	the	Close	button
is	clicked	.

	

A	record	is	then	entered	into	the	patient's	encounter	notes.

It	records	

The	Doctor	that	viewed	the	document

The	Date

The	Time

	

Click	to	enlarge

	

	

	

	

Viewing	a	document	in	the	InTray
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Recall	Manager



How	to	use	the	Recall	Manager	in	GPComplete
From	the	main	menu	select	Administration>	Recall	Manager	and	click
on	Select	Patients	in	the	Recall	Manager	Form	window	which	will
then	open	the	Recall	Selection	Form.

Click	to	enlarge

	

The	Recall	Selection	Form	will	allow	to	you	to	select	different	criteria
for	your	search

which	type	of	recalls

which	doctors

which	date	ranges

option	to	include	either	overdue	recalls,	already	recalled	or
both

option	to	include	inactive	patients

option	to	include	deleted	recalls

After	you	have	selected	the	criteria	click	OK	and	a	list	of	patients	will
then	displayed.

	

The	displayed	list	then	gives	you	the	option	to

Delete	patients	from	the	list

Delete	the	recall	for	a	patient	in	the	list

Send	Mail	to	all	patients	in	the	list	("Mail	Merge")

	

See	also	Recall	Report
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Send	Mail	for	Recalls



Creating	Recall	letters
Select	one	of	the	options	from	the	drop	down	window.	

The	letter	writer	then	opens	offering	the	option	to	select	the
appropriate	template	for	the	recall.	

The	system	allows	the	letters	to	be	printed	directly	or	saved	in	one	file
or	saved	in	separate	files	for	each	patient	inside	one	directory.

	
	

	

After	the	Recall	letter	has	been	generated	the	system	will	then
record	in	the	Notes	that	a	recall	letter	has	been	generated.
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Task	Manager



The	Task	Manager	houses	the	two	different	types	of	tasks
General	Tasks

Tasks	list

Inbox

Pathology	Tasks
Tasks	list

Inbox

	

The	Task	Managers	have	a	Task	List	and	an	Inbox
The	Tasks	List	displays	your	list	of	tasks	-	you	are	the	owner	of
these	tasks

The	Inbox	displays	the	list	of	Tasks	sent	to	you	by	some	one	else
(or	even	yourself)

	

	

Admin	users	see	all	users	Tasks	in	their	Task	List
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General	Tasks



General	Task	Features
	

Adding	an	action

	

Open	the	Task	Manager,	R	click	then	select	Add	Task

		

Click	to	enlarge																																															

	

Click	to	enlarge

	

Give	your	Task	a	name	

Set	a	priority-	if	required

Change	the	Status	-	if	required	but	this	is	usually	set	by	the	person
accepting	the	task

You	can	send	the	task	to	a	person	or	a	group	(eg	Receptionists,
Nurses,	Doctors,	Administrators)

The	Task	will	arrive	in	their	Inbox

You	can	add	attachments	by	selecting	files	within	the	system

Enter	a	note	to	the	person	you	are	sending	the	Task.

	

Actions	are	added	by	the	recipient	of	the	Task
If	you	add	an	action	to	your	Task	then	you	have	accepted	the	Task
and	it	will	appear	in	your	Inbox.

Therefore	don't	add	actions	to	your	tasks	-	unless	you	want	to
"Accept"	the	task



Any	person	adding	an	action	automatically	"Accepts"the	task.

The	Owner	of	the	Task	can	view	who	has	accepted	the	task	as	it
is	displayed	in	the	row.	

	

If	the	Task	is	sent	to	a	Group,	then	the	first	member	of	that	group	to
add	an	action	to	the	Task	then	"Accepts"	the	Task

The	system	will	then	automatically	remove	the	Task	from	the	rest	of
the	members	in	the	group.

	

	

Click	the	plus	sign	on	the	left	to	display	all	actions	taken	in	relation
to	a	Tasks
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Pathology	Tasks



Pathology	Task	Features

	

Click	to	enlarge

	

The	subject	name	of	the	Task	is	by	default	the	name	of	the	pathology
test

Set	a	priority-	if	required

The	Status	of	the	task	can	be	set	by	the	person	accepting	the	task

Send	the	task	to	one	person	or	to	a	group	(eg	Receptionists,	Nurses,
Doctors,	Administrators)

The	Task	will	arrive	in	their	Inbox

Add	attachments	by	selecting	files	within	the	system

Add	a	note	for	the	person	receiving	the	task	to	view

	

Actions	are	added	by	the	recipient	of	the	Task

If	you	add	an	action	to	your	Task	then	you	have	accepted	the	Task
and	it	will	appear	in	your	Inbox.

Therefore	don't	add	actions	to	your	tasks	-	unless	you	want	to
"Accept"	the	task

Any	person	adding	an	action	automatically	"Accepts"the	task.

The	Owner	of	the	Task	can	view	who	has	accepted	the	task	as	it
is	displayed	in	the	row.	

	

If	the	Task	is	sent	to	a	Group,	then	the	first	member	of	that	group	to
add	an	action	to	the	Task	then	"Accepts"	the	Task

The	system	will	then	automatically	remove	the	Task	from	the	rest	of



the	members	in	the	group.

	

Open	the	Task	Manager,	R	click	then	select	Add	Task
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Message



GPComplete	provides	an	internal	messaging	system.
You	can	send	a	message	to

all	users
an	individual

a	selected	group	of	users.

attach	a	Patient	File	to	the	message
	

A	message	can	be	sent	from	either	the	Main	Menu	or	from	the
Appointment	screen.

	

Sending	a	message	from	the	Main	Menu	click	on	Message	>	Send	select
message	from	the	main	menu	and	then	click	send.

	

	

Send	a	message	from	the	Appointment	Screen	by	clicking	on	total
messages	or	new	messages.	This	opens	the	messaging	screen.

	

		

	

	

Click	to	enlarge

									

Tick	the	"Send	to	all"	checkbox	to	send	the	message	to	everyone.

Hold	down	the	control	key	and	select	a	group	of	users	on	the	grid.



Click	on	Attach	Patient	to	attach	the	patients	clinical	file	with	the	message.

Check	the	urgent	button	to	initiate	a	popup	box	as	soon	as	the	message	is
delivered.

Only	one	instance	of	the	send	message	form	can	be	opened	at	a	given
time.	When	the	send	form	is	loaded	by	the	application,	the	main	menu
of	messages	->	send	will	be	disabled.	The	menu	will	enable	itself	when
you	close	the	send	message	form.	

	

See	Also	

Appointment:	Appointment	Screen	Features
Message:	Retrieve	Message
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You	can	retrieve	the	messages	other	users	have	sent	to	you	and	also
reply	to	them.	To	retrieve	your	messages	select	message	from	the
main	menu	and	then	click	retrieve.

	

You	can	also	retrieve	your	messages	when	you	click	on	total
messages	or	new	messages	from	the	appointment	screen	inbox.
When	you	retrieve	your	messages	from	the	main	menu,	by	default	all
messages	are	selected.

	

Messages	are	categorized	as	all	messages,	new	messages,	archived
and	sent.	All	messages	include	the	messages	you	have	received	but
not	the	archived	messages.	New	messages	are	the	messages	you
have	received	which	are	not	marked	as	read	and	not	archived.
Archived	messages	are	messages	which	you	have	archived
irrespective	of	whether	the	message	is	read	or	unread.	Sent
messages	are	the	messages	you	have	sent.	Sent	messages	will
include	the	messages	which	you	have	sent	to	yourself.

Click	to	enlarge

	
The	urgent	messages	are	marked	in	red.	The	messages	which	are
received	from	"SYSTEM"	cannot	be	replied	to.	These	messages	are
automatically	sent	to	the	administrators	of	the	system	when	an
inventory	has	been	used	which	has	fallen	below	the	reorder	level.
	
If	someone	has	replied	to	a	message	which	you	had	sent	earlier,	you
can	see	the	original	message	by	clicking	"View	Original	Msg".	For
more	information	on	how	to	reply	to	messages	please	see
"Replying	Messages".

Retrieve	Message



	

	

Once	you	delete	a	message,	there	is	no	way	to	undelete	it.

	

See	Also	

Appointment:	Appointment	Screen	Features
Message:	Message	|	Replying	Messages
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You	can	reply	to	messages	that	have	been	sent	to	you	by	clicking	on
the	reply	button	in	the	retrieve	message	form.	
The	reply	form	will	be	displayed.

Click	to	enlarge

	

You	can	either	reply	to	the	user	who	sent	the	original	message	or
reply	to	all	the	recipients	of	the	message.	You	cannot	individually
select	the	recipients	you	wish	as	you	could	while	sending
messages.	To	reply	to	all	the	recipients	of	the	message	please	tick
the	checkbox	"Reply	to	all".

	

The	message	system	also	includes	a	feature	"view	original	message"
which	is	useful	if	someone	replies	to	your	message	with	a	brief	response,
but	you	are	unsure	of	the	original	context	of	the	message	that	you	sent	in
the	first	place.	Clicking	on	this	box	will	display	your	original	message	to
that	person.	

Click	to	enlarge

See	Also	

Message:	Message	|	Retrieve	Message
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SMS



Send	an	SMS

The	interface	lets	you	send	an	SMS	to	any
number.
	
You	have	the	option	of	using
	
the	predefined	SMS-template
or
any	user-defined	content
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SMS	Template



Creating	SMS	templates
You	can	create	data-aware	intelligent	templates	for	SMS.	
Making	templates	is	very	easy.	
You	get	the	familiar	letter	writer	interface	to	mix	in	data	fields	with
your	content.	
The	data	field	will	get	filled	up	at	the	time	of	sending	the	SMS.	
Once	the	template	is	saved,	it	can	be	used	by	all	users	of	the	system

From	the	main	menu	select	Message>	SMS	>	SMS	Templates

Click	on	Add

	

	

	

From	the	Template	form

Give	the	new	Template	a	Name

In	the	message	field	create	the	body	of	the	text	you	wish	to
send

Select	from	the	Data	fields	information	you	wish	to	include	in
each	SMS

This	way	the	same	SMS	template	becomes	individualized
for	every	patient	so	they	receive	information	specific	for
themselves
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SMS	Configuration



SMS	Settings

This	is	the	control	centre	for	SMS	Communication
Most	of	the	information	in	here	is	provided	by	GPC	Support	and	is
required	once	off	only
The	only	area	of	interest	here	is	checking	of	credits
The	current	balance	can	be	downloaded	by	clicking	on	“Chk	Cr”
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SMS	Message	Centre



The	SMS	Message	Centre

	

It	is	a	store	for	all	SMS’s	sent	or	about	to	be	sent,
by	GPC.

	

There	is	the	Inbox	which	shows	the	SMS’s	that
are	due	to	be	sent	shortly	(SMS’s	go	out	once
every	3	minutes).	You	can	also	delete	unsent
SMS’s	from	here,	in	case	a	mistake	has	been
made.

	

Then	there	is	the	Search	Tab	which	lets	you
search	for	previously	sent	SMS.	
You	can	view	against	every	SMS	their	delivery
report,	along	with	how	many	credits	were	charged
for	sending	it.	
Usually	a	SMS	costs	only	1	credit.	However	if	you
send	off	a	SMS	with	much	more	content,	it	needs
to	be	split	in	smaller	packets.	More	credit	will	be
charged	then.	
As	a	safety	net,	at	no	time	can	a	single	message
cost	more	than	3	credits.
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Set	the	System	Preferences

resolution

Colour	(B&W,	Grayscale,	RGB)	

File	type	(PNG,	BMP,	TIF,	PDF)

	

Select	the	scanner	from	the	drop	down	list	

Click	on	Start	Scan	to	begin	scanning	a	document
	

	

The	scanner	component	supports	scanning	of	multiple	pages	for	a
single	patient.

It	also	supports	multiple	sets	of	patient	data	in	one	feed	to	the
ADF	(Automatic	Document	Feeder)

This	is	done	by	separating	the	different	patient	files	with	a	blank
page.

The	blank	page	must	account	for	the	difference	in	the	quality	of
paper,	scanner	resolution	etc,	so	the	tolerance	of	the

system	can	be	changed.
Higher	tolerance	makes	it	easier	for	the	system	to	recognize	the
blank	page.

Lower	tolerance	means	a	paper	with	minimal	information	on	it
will	still	be	considered	a	data	page	and	not	a	blank	page.

	
Scanning	preferences	are	set	by	the	administrator	and	applied	to
all	users.	A	user	may	change	the	scanning	options	for	a

given	session	but	the	values	will	revert	to	what	has	been	set	by	the

Scanning



administrator	when	a	new	sessions	starts.	This	will
help	in	ensuring	that	files	are	not	scanned	in	at	very	high
resolutions	and	thereby	reduce	clogging	up	of	disk	space.

	

	

	

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Initate scanning


Scanning	can	be	initiated	in	three	locations

Document	InTray

Correspondence	node	in	Clinical	Profile

GPC	Library

	

To	initiate	scanning	R	click	for	the	sub-menu
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Letter	Writer



The	Letter	Writer
	

Click	to	enlarge

To	open	the	Letter	Writer

1.	 go	to	Resources>LETTER	WRITER

2.	 Open	Clinical	Profile	Window	>Correspondence>LETTER
WRITER

3.	 Templates	can	be	immediately	accessed	thru	the	drop	down
box	in	Correspondence.	

	

Click	to	enlarge

	

The	Letter	Writer	is	a	word	processor.

Use	it	to

create	new	templates

edit	current	templates

import	templates



Options
	

1.	 Open	the	templates.

2.	 Start	the	letter	writer	program.

	



Pre-existing	templates
Select	a	template	from	the	drop	down	box	in	Correspondence	and
click	on		

	



Start	the	Letter	Writer	program
	

Click	on			
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Create	a	new	template



Start	the	Letter	Writer	program
	

Click	on			 	and	the	program	will	open

Click	File>New

	
	

Click	to	enlarge
	
Click	on	Blank	Template.

	
	

Click	to	enlarge
	

	

The	cursor	will	be	sitting	on	a	new	line	in	the	body	of	a	blank	form	ready
for	a	new	template	to	be	designed.

Double	click	a	datapoint	in	the	fields	to	insert	it	to	the	blank	template.

	

	

	

	

Then	once	a	template	is	designed
	

click	File>Save	as	Template



	

	

	

Name	the	template	by	entering	on	the	title	in	the	Template	Name
field.	Then	click	OK.
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Import	a	template



Start	the	Letter	Writer	program
	

Click	on			 	and	the	program	will	open

	
	

Click	to	enlarge
	
Click	File>New
	

Click	to	enlarge
	

Click	on	Blank	Template.

The	Letter	Writer	will	open	with	the	cursor	sitting	on	a	new	line	in	the
body	of	the	form.	The	imported	template	will	be	inserted	at	the	cursor
position.

	
Click	File>Import	and	select	the	directory	and	then	the	file	to	be
imported	from	the	Look	in:	drop	down	inside	the	Open	form.
	

Click	to	enlarge
	
e.g	Select	Mercy	Hospital	for	Women	Referral.	This	will	insert	the
template	into	the	blank	form	at	the	cursor	point.
	

Click	to	enlarge
	
Select	File>Save
	
Type	a	name	in	the	Template	name	box	for	the	imported	template	and
click	OK.



This	new	named	template	can	then	be	seen	in	Correspondence	by
clicking	on	the	drop	down	box.
	

Click	to	enlarge
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You	can	store	a	list	of	predefined	shortcuts	in	the	Auto	Template
manager.	

The	shortcuts	automatically	expand	to	the	full	description	when
the	enter	key	or	the	space	bar	is	hit.		

The	Auto	Templates	are	specific	to	each	individual	user	but	can	be
shared	with	other	users.

Auto	Templates	of	one	user	are	not	visible	to	any	other	user	unless
they	are	shared.

From	the	main	menu	click	on	Resources>	Auto	Templates	to	display
the	Auto	Template	Grid.

	

Click	to	enlarge

	

You	can	add,	edit	or	delete	a	Template	but	you	can't	edit	Shortcut
values.

You	cannot	have	two	shortcuts	that	are	the	same.	

Delete	a	template	by	selecting	the	row	and	clicking	delete.	

Click	on	Add	to	add	a	Template

Click	to	enlarge

	

Create	a	template,	give	it	a	shortcut	name	then	save	it.	It	will	then	be
recorded	in	the	first	row	of	the	grid.

Make	sure	you	save	your	changes	before	closing	the	form.	For	more
information	on	grids	please	see	working	with	grids.

A	document	containing	datafield	entries	can	be	stored	as	a	template

Create	an	Auto	Template



but	only	if	it	is	saved	in	RTF.

	

The	template	will	automatically	display	when	the	shortcut	is	typed	into
the	notes	and	the	spacebar	or	enter	key	is	hit.
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introduction	to	GPC	Library



GPC	Library
	
Click	on	Resources>GPC	Library
	

GPC	Library	is	a	resource	utility	provided	for	the	medical
practice	to	store	all	varieties	of	folders	and	documents	in	an
organized	way.		These	folders	and	documents	are	then
accessible	to	all	users.

Patient	information	sheets
Consent	forms
Practice	policy	manuals

Introductory	information	for	new	staff	members.				
	
See	the	following	example:-	
R	click	to	add	a	new	file,	a	new	folder	or	an	existing	folder

	

	
	

	

Features	of	the	GPC	Library	are:-
		

1.	Structure
												Complete	file-folder	structure	for	easy	navigation	and
storage.



	

2.	Icons
								Original	shell	icons	extracted	from	the	OS.	It	lets	you	spot
the	type	of		file	without	a	single	click.

								Opening	or	closing	of	the	folder	is	reflected	by	change	in
the	icon

3.	View
	

Provides	4	options

								List

								Detail

								Small	Icon

								Large	icon

	

‘Detail’	option	will	list	the	file	owner,	created	date,	modified	date
along	with	file	type

	

4.	Sharing	of	Files	across	users
								Simple	option	to	share	or	un-share	file/folder	with
other	users.

								All	subfolders	and	files	can	be	shared	with	a	single-
click

								Ability	to	change	the	sharing	at	any	point	of	time

	



5.	Basic	operations
													Renaming	of	file/folder,	common	shortcuts,	document
properties	are	all	supported

6.	Block	Copying
													An	entire	folder	structure	with	all	its	content	can	be
copied	with	a	single	click	from	the	file	system	into	GPC
	

7.	Security
													Permissions	are	internally	evaluated	before	allowing	any
operation
	

													Ex:

								Changes	to	a	folder	can	only	be	made	by	the
administrator	or	the	owner	(user	who	created	it)

								Any	changes	by	a	non-administrator	to	a	folder	of
which	he	is	the	owner	will	be	disallowed	if	the	folder
contains	information	added	by	other	users
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Backing	up!!
	

gpc.fdb	is	the	GPComplete	database	file.

	

gpc.fdb	will	reside	in	the	folder	C:\gpcdata	unless	determined
otherwise	during	the	installation	process.

	
Click	to	enlarge

DB
this	is	the	path	to	the	database.	e.g.	C:\gpcdata\gpc.fdb

to	set	the	path,	click	on	change	and	browse	to	that	folder.
This	path	must	be	on	the	local	machine.	Network	paths	are	not	valid.

	

Prefix
This	can	be	any	name	to	help	identify	the	backup	file.

e.g	MyPractice.

This	will	append	the	name	in	front	of	the	file.	eg.
MyPractice12102007.zip		

12102007	represents	the	format	ddmmyyyy

	

Dest
This	is	the	destination	folder	where	the	backup	will	be	copied.

Click	change	to	browse	to	this	folder.
	

Select	Daily,	Weekly	or	Monthly.

GPC	Backup



	

Time
This	sets	the	time	of	the	backup	process.	Preferably	set	this	time
when	it	is	unlikely	that	the	system	is	being	used.	e.g.	late	in	the
evening	or	in	the	early	hours	of	the	morning.

	

Account	info
Account	name	is	the	Windows	username	of	the	machine.

Password	is	the	Windows	password	for	the	machine.

	

FB	Service
This	should	be	autopopulated	in	most	instances.	If	it	is	not	then
please	contact	us.

There	might	be	another	instance	of	firebird	installed	on	this	machine.	
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The	GPCbackup	only	backs	up	the	gpc.fdb	file.

Stored	documents	found	in	correspondence	and	the	GPC	Library	are
saved	on	a	separate	file	system	on	the	server	machine.

The	Installation	sets	the	path	to	these	document	files	to	C:\Program
Files\GPComplete\Service\HWS_FILES

Please	ensure	these	files	are	saved	by	the	third	party	System
Backup	device	used	on	the	Server	machine.
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For	further	questions	or	clarification	please	contact	The	Practice
Management	Software	Company.
	
www.pmsc.com.au
	

Phone:	1300	794471
	

Administrative	Issues:
admin@pmsc.com.au
	

Support:
support@pmsc.com.au
	
Sales:
sales@pmsc.com.au
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The	software	has	the	ability	to	set	up	hot	keys	for	specific	functions.

There	are	two	types	of	Hotkeys	in	GPComplete.

	

1.	Global	Hotkeys

2.	Form	Specific	Hotkeys

	

	

There	are	four	global	Hotkeys	which	are	fixed	and	can't	be	changed.

	

1.	 View	Appointment	-	F2

2.	 Patient	Search	-	F3

3.	 Message	Retrieve	-	F4

4.	 Log	Off	-	F5

	

The	global	Hotkeys	are	displayed	in	the	panel	at	the	bottom	of	the
screen.

	

	

These	hot	keys	will	be	displayed	on	the	bottom	of	the	screen
automatically	if	there	are	no	forms	open	in	the	main	window.

If	any	form	is	opened,	then	the	specific	user	hot	keys	for	that	form
that	have	been	set	up	by	an	individual	user	are	then	displayed	in	the
panel.

The	F8	key	is	used	to	toggle	between	the	global	hot	keys	and	the

HotKeys



active	form	hot	keys.		For	this	reason	the	F8	key	can't	be	used	for
assigning	hot	keys	to	any	new	form.	(F1	and	F10	are	also	excluded
from	use	in	setting	hotkeys.)

Form	specific	Hotkeys	can	be	varied	by	every	user	in	the	system.

	

To	set	up	user	specific	hot	keys	for	a	form,	you	will	be	required	to
open	the	form	first.

Next	click	on	the	 	icon	which	is	found	in	the	bottom	left	hand
corner	of	the	screen	to	display	the	list	of	available	hot	keys.

	

If	the	form	allows	hot	keys	to	be	set	up	for	it,	then	the	hot	key	setup
form	will	be	displayed	on	the	screen.

	

Click	to	enlarge

With	the	help	of	the	mouse,	select	the	action	you	want	to	set	the	hot	key
for,	and	then	type	in	any	hot	key	or	a	combination	of	keys	(Ctrl-Shift-R)
you	want	to	set	for	the	action.	Two	actions	in	a	form	cannot	have	the
same	hot	key	assigned.	The	function	keys	F1,	F8	and	F10	cannot	be
used	to	specify	hot	keys.	If	you	want	to	delete	any	hot	key,	select	the	row
for	the	action	whose	hot	key	you	want	to	delete	and	hit	delete	from	the
keyboard.	The	hot	key	will	revert	to	'None'.

	

After	you	have	assigned	your	hot	keys	to	the	form	click	on	the	save
button.	The	hot	keys	for	the	form	will	now	be	displayed	on	the	bottom
panel	whenever	the	form	is	in	focus.	To	go	back	and	forth	between	the
system	hot	keys	and	the	form	hot	keys	please	use	the	F8	key.

Hotkeys	are	not	a	global	setting	and	therefore	will	need	to	be	setup	for
every	computer	that	you	are	using.

	



You	will	not	be	able	to	use	F1,	F8	and	F10	for	setting	hot	keys.
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Working	with	Grids



Grids	are	prevalent	right	throughout	the	system.	
Whenever	you	search	for	information	within	the	system	it's	likely	that
a	grid	will	display	the	data.			



			1.	Grid	to	display	records:

Click	to	enlarge

	

Here	the	grid	displays	the	list	of	records	from	the	search	request.

The	functionality	of	this	type	of	grid	is	limited	to	only	the	display	of
records.

You	are	not	allowed	to	enter	information	into	the	grid.		



			2.	Grid	to	enter	records:
In	a	few	situations	information	can	be	entered	into	a	grid.

e.g	creating	a	bill

Click	to	enlarge

	

e.g	adding	data	to	the	dictionary

Click	to	enlarge

	

e.g	setting	"away	dates"	for	the	Staff

Click	to	enlarge

	



Grids	can	Sort,	Group	and	Hide	the	columns	of
information.
	

1.	Sort
Sort	the	information	in	a	grid	by	clicking	on	the	header	of	the	column.

More	than	one	column	can	be	sorted	if	the	Control	Key	is	held	while
extra	columns	are	selected.	This	will	sort	subsequent	columns	inside
the	previous	column	selected.

2.	Group
Drag	a	column	title	to	the	header	bar	to	group	information.

3.	Hide
Hide	a	column	by	R	clicking	the	column	title.
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Wildcards



Wildcard	characters	can	be	used	when	conducting	a
search.
	

The	Wildcard	in	GPComplete	is	the	asterisk	character		*	.
In	advanced	search	the	Wildcard	character	is		%	.

	



The	Wildcard	when	used	in	conjunction	with	other
characters	will	match	all	patterns.
Example:	
If	you	input	'12*'	against	the	patient	medicare	in	a	patient	search	form,
the	search	result	will	include	all	patients	whose	medicare	number
starts	with	'12'

Example:

If	you	input	'1*2'	against	the	patient	medicare	in	a	patient	search	form,
the	search	result	will	include	all	patients	whose	medicare	number
starts	with	'1'	and	ends	with	'2'

Example:

If	you	input	'*12'	against	the	patient	medicare	in	a	patient	search	form,
the	search	result	will	include	all	patients	whose	medicare	number
ends	with	'12'

Example:

If	you	input	'*'	into	the	patient	search	form,	the	search	will	include	all
patients	in	the	system.

This	is	why	it	will	prompt	with	the	warning:
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Frequently	asked	questions



	Frequently	Asked	Questions	
	

	

1.	 What	is	Patient	Claim	?	

Medicare	benefits	are	payable	to	Australian	residents	and
eligible	overseas	visitors.	Foreign	diplomats	and	their
families	are	not	covered	unless	they	are	from	countries,
other	than	New	Zealand	,	which	have	a	reciprocal	health
care	agreement	(RHCA)	with	Australia	.	Australian	residents
must	be	enrolled	in	Medicare	before	benefits	can	be	paid.
Enrolment	application	forms	are	available	at	Medicare
offices	in	all	states	and	from	HIC’s	web	site	at	www.Medicare
Australia.gov.au	

	Back	to	Top

2.	 What	is	BulkBill	Claim	?	

	
If	a	practitioner	agrees	to	the	bulk	billing	method,	patients	assign
their	right	to	a	benefit	to	the	practitioner	as	full	payment	for	the
medical	service.	The	practitioner	(or	any	other	person	or	company)
cannot	make	any	additional	charge	for	the	service.	This	means	that
if	the	doctor	bulk	bills,	the	patient	cannot	be	charged	a	booking	fee,
administration	fee,	a	charge	for	bandages	or	record	keeping	or	a
charge	by	the	doctor’s	service	company.	It	is	a	legal	requirement
that	the	assignment	of	benefit	form	be	signed	by	the	patient	only
after	the	service	has	been	provided	and	the	form	completed.	A
copy	of	the	completed	assignment	form	must	be	given	to	the
patient.



	Back	to	Top

3.	 What	is	DVA	Claim	?

The	health	program	provides	eligible	members	of	the
veteran	community	with	access	to	health	care	services
through	arrangements	with	registered	health	care
practitioners	and	public	and	private	hospitals.	In	general
terms,	health	care	is	only	provided	to	those	resident	in
Australia.

Eligible	veterans	and	dependants	are	issued	with	cards
that	reflect	their	level	of	health	care	coverage.	

	Back	to	Top

4.	 What	is	ACIR	Claim	?

	
The	Australian	Childhood	Immunisation	Register	(the
Immunisation	Register)	was	established	in	1996	in	response
to	a	decline	in	childhood	immunisation	in	Australia	and	the
increase	in	preventable	childhood	diseases.
	

The	Australian	Childhood	Immunisation	Register
(Immunisation	Register)	was	developed	in	response	to	a
decline	in	childhood	immunisation	in	Australia	and	the
alarming	increase	in	preventable	childhood	diseases.	The
Immunisation	Register	records	details	of	vaccinations
given	to	children	under	the	age	of	seven	who	live	in



Australia,	helping	Australian	parents	to	ensure	that	their
children	grow	up	healthy	and	are	fully	immunised.	Health
professionals	also	use	the	Immunisation	Register	to
monitor	immunisation	coverage	levels,	service	delivery
and	disease	outbreaks.

	Back	to	Top
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Using	the	Recall	Manager



How	to	use	the	Recall	Manager	in	GPComplete
From	the	main	menu	select	Administration>	Recall	Manager	and	click
on	Select	Patients	in	the	Recall	Manager	Form	window	which	will
then	open	the	Recall	Selection	Form.

Click	to	enlarge

	

The	Recall	Selection	Form	will	allow	to	you	to	select	different	criteria
for	your	search

which	type	of	recalls

which	doctors

which	date	ranges

option	to	include	either	overdue	recalls,	already	recalled	or
both

option	to	include	inactive	patients

option	to	include	deleted	recalls

After	you	have	selected	the	criteria	click	OK	and	a	list	of	patients	will
then	displayed.

	

The	displayed	list	then	gives	you	the	option	to

Delete	patients	from	the	list

Delete	the	recall	for	a	patient	in	the	list

Send	Mail	to	all	patients	in	the	list	("Mail	Merge")
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Click	Administration	>	Document	Intray

	

The	Document	Intray	logically	accepts,	assigns	and	distributes	all
incoming	documentation	to	the	practice.

	

A	document	can	be

titled,	categorized	and	dated

	

A	document	can	be

associated	to	a	patient	AND	associated	to	a	doctor

associated	to	a	patient	AND	NOT	associated	to	a	doctor

NOT	associated	to	a	patient	AND	NOT	associated	to	a
doctor	

	

A	document	can	not	be

NOT	associated	to	patient	AND	associated	to	a	doctor

	

Right	Click	the	Document	in	the	InTray	to	select	an	option	in	the	sub-
menu

	

	

	

	

	

	

Overview	of	Document	Intray
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1.	 R	click	the	patient's	name	on	the	appointment	screen	and
select	Bulk	Bill	from	the	drop	down	menu
The	Bulk	Bill	form	will	appear	with	the	cursor	sitting	in	the
Add	Item	field

2.	 Insert	the	item	number	and	hit	Enter
The	Add	Service	form	will	appear

3.	 Hit	Enter	again	
or	check	the	relevant	boxes	for	Not	Normal	After	Care	etc....
The	item	number	is	added	to	the	Bulk	Bill	form	

4.	 Hit	Enter	again	
-	unless	you	want	to	enter	another	item	number

5.	 The	Claim	is	then	Batched	by	default	if	you	hit	Enter	when
the	Add	Item	field	is	BLANK
Batched	Claims	can	be	viewed	and	edited	later	in	All	Stored
Claims	form.

6.	 Clicking	Send	Now	will	immediately	send	the	Claim	to
MedicareAustralia

	

	

Click	to	enlarge

	

Click	to	enlarge
	

	

	

Bulk	Billing	Overview
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1.	 R	click	the	patient's	name	on	the	appointment	screen	and
select	DVA	Bill	from	the	drop	down	menu
The	DVA	Bill	form	will	appear	with	the	cursor	sitting	in	the
Add	Item	field

2.	 Insert	the	item	number	and	hit	Enter
The	Add	Service	form	will	appear

3.	 Hit	Enter	again	
or	check	the	relevant	boxes	for	Not	Normal	After	Care	etc....
Treatment	Location	-	Click	the	drop	down	box	if	the	service
is	other	than	normal	consultation	rooms
The	item	number	is	added	to	the	Bulk	Bill	form	

4.	 Hit	Enter	again	
-	unless	you	want	to	enter	another	item	number

5.	 The	Claim	is	then	Batched	by	default	if	you	hit	Enter	when
the	Add	Item	field	is	BLANK
Batched	Claims	can	be	viewed	and	edited	later	in	All	Stored
Claims	form.

6.	 Clicking	Send	Now	will	immediately	send	the	Claim	to
MedicareAustralia

	

	

	

Click	to	enlarge

	

	

	

DVA	Overview
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Set	the	System	Preferences

resolution

Colour	(B&W,	Grayscale,	RGB)	

File	type	(PNG,	BMP,	TIF,	PDF)

	

Select	the	scanner	from	the	drop	down	list	

Click	on	Start	Scan	to	begin	scanning	a	document
	

	

The	scanner	component	supports	scanning	of	multiple	pages	for	a
single	patient.

It	also	supports	multiple	sets	of	patient	data	in	one	feed	to	the
ADF	(Automatic	Document	Feeder)

This	is	done	by	separating	the	different	patient	files	with	a	blank
page.

The	blank	page	must	account	for	the	difference	in	the	quality	of
paper,	scanner	resolution	etc,	so	the	tolerance	of	the

system	can	be	changed.
Higher	tolerance	makes	it	easier	for	the	system	to	recognize	the
blank	page.

Lower	tolerance	means	a	paper	with	minimal	information	on	it
will	still	be	considered	a	data	page	and	not	a	blank	page.

	
Scanning	preferences	are	set	by	the	administrator	and	applied	to
all	users.	A	user	may	change	the	scanning	options	for	a

given	session	but	the	values	will	revert	to	what	has	been	set	by	the

Scan	options



administrator	when	a	new	sessions	starts.	This	will
help	in	ensuring	that	files	are	not	scanned	in	at	very	high
resolutions	and	thereby	reduce	clogging	up	of	disk	space.
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Send	Message



GPComplete	provides	an	internal	messaging	system.
You	can	send	a	message	to

all	users
an	individual

a	selected	group	of	users.

attach	a	Patient	File	to	the	message
	

A	message	can	be	sent	from	either	the	Main	Menu	or	from	the
Appointment	screen.

	

Sending	a	message	from	the	Main	Menu	click	on	Message	>	Send	select
message	from	the	main	menu	and	then	click	send.

	

	

Send	a	message	from	the	Appointment	Screen	by	clicking	on	total
messages	or	new	messages.	This	opens	the	messaging	screen.

	

		

	

	

Click	to	enlarge

									

Tick	the	"Send	to	all"	checkbox	to	send	the	message	to	everyone.

Hold	down	the	control	key	and	select	a	group	of	users	on	the	grid.



Click	on	Attach	Patient	to	attach	the	patients	clinical	file	with	the	message.

Check	the	urgent	button	to	initiate	a	popup	box	as	soon	as	the	message	is
delivered.

Only	one	instance	of	the	send	message	form	can	be	opened	at	a	given
time.	When	the	send	form	is	loaded	by	the	application,	the	main	menu
of	messages	->	send	will	be	disabled.	The	menu	will	enable	itself	when
you	close	the	send	message	form.	

	

See	Also	

Appointment:	Appointment	Screen	Features
Message:	Retrieve	Message
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Adding	a	Staff



How	to	Add	a	new	Staff	member:
	

Click	on	the	main	menu	Staff>Add	Staff.	The	Staff	Register	form	will
become	active.

	

	

Complete	the	required	fields	on	the	Staff	Register	from.	

Note	the	Privileges	entry	in	the	bottom	right	corner	of	this	form.
A	drop-down	list	of	different	templates	can	be	selected.
Templates	provide	a	shortcut	in	assigning	permissions	to	a	new	staff
member.	

	

Click	to	enlarge
	
	

You	can	also	open	the	staff	register	screen	from	staff	search	by
selecting	the	"Add	New"	button.

	 Show	All

	 Hide	All

	

	

javascript:HSShowAllCSections();
javascript:HSHideAllCSections();


Mandatory	Fields	in	Staff	Registration
	

Code

Name

	

Phone

	

Date	of	Birth

	

Username

	

Password

	

Privilege

		

GIVE	CAREFUL	THOUGHT	BEFORE	ASSIGNING	"ADMIN"
PRIVILEGES	TO	A	NEW	USER	OF	THE	SYSTEM.	

javascript:HSToggleSection('{738D7E89-AF00-4BB0-8E2F-67E484646697}')
javascript:HSToggleSection('{2318D0F6-1901-4554-A2DA-4F91FFF2E5E8}')
javascript:HSToggleSection('{E40AEC95-CC6C-43D4-BC46-FD8DCF9A467F}')
javascript:HSToggleSection('{FD528E99-A55F-4BAA-893D-00EBA35C9716}')
javascript:HSToggleSection('{C0918904-14A7-4B62-A790-D2796506F65D}')
javascript:HSToggleSection('{579F0C0A-2ADA-46C5-8582-6C450EFE35E1}')
javascript:HSToggleSection('{505A739A-43A9-477D-A2D8-2CB9A0E7228C}')


Other	Fields	in	Staff	Registration	
	

Provider	No.

Prescriber	No.

	

Billing	Preference

	

Post	code,	Suburb	and	State

	

Locum

	

Duplicate	Staff	Prompt

	

See	Also	

Staff:	Modifying	a	Staff	|	Deleting	a	Staff	|	Staff	Search
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You	can	search	for	the	request	by	typing	in	the	name	or	code	or	both
and	then	modify	the	request	details	if	required.

You	can	use	(*)		wildcard	characters	when	searching.

	

Click	to	enlarge

	

The	pathology	requests	present	in	the	system	by	default	will	not
be	available	to	you	for	any	modification.	The	default	pathology
requests	will	not	be	displayed	on	the	search	results	as	well.

See	Also	

Pathology:	Add	Pathology	test	to	request	table	|	Search	or	Modify
Pathology	Request
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Password	and	Staff	Key



	

See	Also	

Administration:	Adding	a	Login	|	Modifying	a	Login	|	Deleting	a
Login

Staff:	Staff
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©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.

Other	Details



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: Problem list
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Before	completing	an	IMC	claim	review	Health	Funds

	

	

©	The	Practice	Management	Software	Company	Pty	Ltd.	All	Rights
Reserved.

IMC	workflow



GPCHelp Send	comments	on	this	topic.

mailto:nkemp@pmsc.com.au?subject=Documentation Feedback: The ACIR workflow


	

1.	 R	click	on	the	patient's	appointment	and	select	ACIR
The	Claim	form	then	appears

2.	 Click	the	ADD	button	on	claim	form
The	Vaccine	form	then	appears

3.	 Scroll	down	and	Double	click	on	the	row	for	the	selected
vaccine

4.	 Select	the	Site

5.	 Enter	the	batch	number

6.	 Enter	the	dose	number

7.	 Click	Ok
This	will	close	the	Vaccine	form

8.	 Click	Send	now	on		the	Claim	form

View	screenshots	below

	

	

Click	to	enlarge

	

The	ACIR	workflow



Click	to	enlarge
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Click	Manage	Medicare	Australia	Connection	to	open	the	form.

	

	

	

	

	
	

Configuration	Details		
	

Configuration
Fields	

Description

Cryptostore
File		Path

This	is	the	path	of	a	new	PSI	Store	containing	all
necessary	keys	and	certificates	for	use	with	Medicare
Australia	Online	in	the	specified	location.	You	can	browse
for	the	PSI	file	pressing	the	browse	button.

Location	ID The	identifier	allocated	to	the	location.

Will	Be	Provided	By	Our	HELPDESK

Pass	Phrase For	Creating	the	PSI	file	this	file	is	required.

	

										

Proxy	Details
	

Manage	Medicare	Australia	connection



Main	Fields	 Description
Proxy	Name	 This	is	name	of	the	proxy	Server.
Proxy	Port This	indicates	the	port	of	the	Proxy.
Proxy	User Default	UserID	to	be	used	for	authentication	at	any	proxy	where

no	specific	value	has	been	set.
Proxy
Password Password	to	be	used	for	authentication	at	the	proxy.

	

Connection	Testing:

	

Go	to	the	Medicare	Australia	configuration

Fill	up	the	fields

Select	the	Transmission	Type	as	Test

Press	the	Test	to	test	Connection.

If	the	connection	is	successful	then	press	OK.	
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Click	on	Load	Health	funds

	

	

Click	to	enlarge
	
Click	on	HIC	refresh.		The	progress	bar	will	appear	as	they	are
loaded.
	

Click	to	enlarge
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